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Foreword



Who would guess that a book titled Design for CNC is actually a how-to about thriving in the new economy and, at a broader level, changing society to be more democratic and sustainable?


Computer numerical control (CNC) turns a design on a computer into instructions that are sent to an automated tool. If you have ever clicked the Print button on your computer and sent a document to a laser printer, you know what it’s like to see a picture on your screen turn into a physical object in the world. A CNC router is like a laser printer, but it can make the parts for a chair, or a table, or a bookshelf, out of a plain sheet of plywood. And if you have ever assembled IKEA furniture, you understand how a flat box filled with pieces of particleboard can be magically turned into three-dimensional furniture. (Admittedly, those bookshelves are probably missing a couple of screws, and may not withstand the move to your next apartment.) With smart design, a few 4′ x 8′ sheets of plywood can be turned into a house full of stylish and sturdy furniture.


Design for CNC describes a new world of possibilities enabled by low-cost CNC tools coupled with designs shared, refined, and customized globally over the internet. The book makes its case using something we all use every day: furniture. Furniture design and production was traditionally based near the sources of raw materials, which is why Grand Rapids, Michigan, is home to Herman Miller, Steelcase, and other designers. Today, furniture is a global industry. IKEA’s design may be Scandinavian, but its supply chain stretches around the world.


When you think about it, IKEA does not sell furniture—it sells standardized, precut materials, and a set of instructions, screws, and Allen wrenches to assemble them. The designs are ingenious, but suffer the flaws of mass production. IKEA’s products are standardized to be made in bulk in distant factories, and if the local outlet does not have what you want, you’re out of luck.


Design for CNC poses a crucial question: why ship one-size-fits-all particleboard furniture around the world when a CNC machine empowers us to locally fabricate designs made anywhere, using whatever local materials we choose? Ship information, not stuff! Just-in-time production at a local fab facility can be both customized and modest in cost.


CNC tools have gotten extremely precise and remarkably cheap. You don’t need to be a major corporation to have a CNC router; in fact, some of your neighbors might even have ShopBots in their basements. (And if they don’t, you can find one at 100kGarages.com.)


The implications of the new generation of CNC tools are revolutionary. Where the second industrial revolution centralized manufacturing in giant factories for mass production, CNC allows “mass customization.” It is perhaps the best path for a return to local manufacturing and the skilled jobs that it creates, and it opens up a new terrain for entrepreneurship in both design and production.


For most of the 20th century, design and production were typically housed within the same organization. A Model T was designed and manufactured by Ford; Chuck Taylor sneakers were designed and manufactured by Converse. Over the past generation, however, industry has been “Nikefied,” so that design and production are often done by different organizations. Nike sneakers, Apple iPhones, Purina Cat Chow, Vizio televisions: all of them are designed in-house but their production is done by outside contractors. This raises an intriguing possibility: if the instructions for creating a product can be conveyed through electronic files, then why not just sell the designs and leave the fabrication to the consumer? For a smartphone, this might be impractical, but for furniture—why not? Some customers might want to hire a local fabricator to implement the design out of materials that they choose; others might be happy with a generic implementation; while others might prefer to make it themselves at a local makerspace. CNC has the prospect of radically changing how we design and make goods.


Of course, design for CNC is slightly more complicated than using a laser printer, and requires a bit of background and practice. Both designers and fabricators need to share a common understanding of the basic tools of CNC and their implications for the design process.


Design for CNC provides an indispensable guide to understanding CNC in the context of furniture. For several years, Anne and Gary have been creating and sharing robust designs for very cool furniture through AtFAB, their online platform. They are in the vanguard of a movement for “cosmopolitan locavore” production, and this book guides readers through the steps to understanding CNC, implementing simple designs, customizing for their own applications, and ultimately designing on their own. Designers, fabricators, and entrepreneurs will all benefit from this clearly written guide.


Makers of the world: get to it!



Jerry Davis, Wilbur K. Pierpont Collegiate Professor of Management at the University of Michigan’s Ross School of Business, and author of The Vanishing American Corporation: Navigating the Hazards of a New Economy



Preface



Five years ago, we designed and shared a line of CNC-fabricated furniture with the intention of encouraging people to become digital makers. Since then, over 10,000 downloads later, hundreds of makers from around the world have locally fabricated their own versions. We believe design for CNC can be more than just a new way of making things. It’s a new paradigm for manufacturing that has positive impacts for local economies and the environment. Whether you’re a designer, a fabricator, or a complete novice, we wrote this book to give everyone the power to design for CNC.


This book teaches design and fabrication fundamentals through the making of useful, meaningful, modern pieces of furniture. We introduce practical techniques of working with—and designing for—CNC tools within the context of making furniture. Every project in this book offers a unique lesson and yields a different furniture piece. By completing the entire collection of projects in this book, you’ll be able to furnish almost any space, from a small apartment to a house, classroom, workshop, or even a tech startup office.


Understanding the scarcity of both classroom and leisure time, the book begins with projects that are achievable within a weekend. In later chapters, you’ll find more challenging multi-weekend projects to make as you expand your knowledge, technique, and confidence in digital fabrication.


	What Is AtFAB?

	
AtFAB is a line of customizable furniture, designed to be downloaded as a digital file, and then “FABricated At” any location by anyone. AtFAB consists of a collection of chairs, tables, shelving, beds, and other pieces. Every piece is comprised entirely of flat, interlocking parts, which are cut with a CNC tool. The collection shares a common language of precise, digital joinery, structural assemblies, and overall volumetric, proportioned shapes.






The concepts behind AtFAB are rooted in our early ambition to design everyday objects for a networked, digital manufacturing process. We sought to design furniture that a distant fabricator could produce with readily available sheet materials and intuitively assemble with nothing more than off-the-shelf hardware.


AtFAB’s underlying ideas are also rooted in our deep aspiration to connect and share through design and making. Ever since inviting a few dozen friends to download our earliest furniture files, we’ve been delighted to connect with an ever-growing, global network of designers, makers, and fabricators. As so many have downloaded, customized, and locally fabricated AtFAB in makerspaces, fab labs, classrooms, and garages around the world, they have demonstrated a powerful manufacturing model.


For us, this book is an opportunity to expand the circle further, by sharing the knowledge that we developed in designing and making AtFAB.  We hope to expand this creative, industrious community into a potent force that has the potential to reshape an industry.


For all makers, we believe AtFAB demonstrates an approach to design that anyone can adapt to their own projects. This book will walk you through the making of eight AtFAB furniture pieces, showing how design unlocks digital fabrication’s full potential. As you make each project, you’ll discover how AtFAB designs are source code for infinite furniture possibilities. You’ll find opportunities for customizing, hacking, and even recombining elements into new designs to make and to share.


	What Is CNC?

	
At its most basic, a computer-numerically controlled (CNC) machine moves a cutting, etching, or deposition tool on the end of its computer-controlled arm. The computer reads a digital file containing 2D or 3D coordinates, and tells the machine where to move the tool to perform subtractive functions like cutting, carving, or etching, or additive ones like 3D printing.






The principles are essentially the same on a CNC router that cuts and etches sheets of plywood, or on a sophisticated, infinite-axis CNC robotic arm that cuts and fuses complex aerospace parts. In both cases, the computer is following the coordinates and driving the end of a tool in space to manipulate a physical material.


A Manual for Modern Design

When Gary Rohrbacher began his first job in a small architecture practice, the office had a set of 19th-century leather-bound woodworking handbooks. The architects in the office adapted and translated the construction details in the books to whatever projects were being designed at the time. These details became the consistent thread that linked all the projects of the firm together.


Our goal is for this book to serve a similar function as those antique woodworking manuals. We wrote it as an essential resource for anyone designing for CNC. First by illustrating simple steps toward successful outcomes in your CNC projects, and then by providing basic principles for you to adapt and translate into your own designs.




	What Is Digital Fabrication?

	
Digital fabrication is the act of designing on a computer with the intent of fabricating that design on a specific computer-controlled machine. While digital fabrication is the process of joining digital design with computer-controlled tools, the practice of digital fabrication feels more like an iterative dance between software and hardware with design as the choreographer. The process typically involves creating a digitally designed model, simulating its fabrication in software, and then physically fabricating that model with a CNC machine.






This agility to move between the virtual and the physical allows the practice of digital fabrication to be an iterative cycle through concept to prototype. CNC machines and software allow you to analyze and evaluate your initial prototype, improve the digital model, fabricate the next iteration, and repeat the process, until the object has all of the necessary functions and characteristics. Modeling, simulation, iteration, and prototyping naturally invite design into the process of making things with digital tools.








Who Is this book for?


This book is for those who learn best by doing projects: makers of all skill levels who want to explore digital fabrication. It’s also for those who are seeking a self-sufficient, affordable, greener alternative to buying imported furnishings from a big box retailer.


When makers around the world began downloading AtFAB furniture files, we were intrigued by how diverse a cross-section of people they were: designers, software developers, makers, teachers, students, professional fabricators, woodworkers, and many more. We want to encourage everyone from this broad, curious audience to jump in and make something big.










Designers


If you’re comfortable with digital design basics and want to move beyond what’s on the screen but are completely new to fabrication, this book will give you a basic foundation in CNC machining and provide guidance on how to design for fabrication.

















Fabricators


If you’re quite familiar with building physical objects, but you’re eager to bring your own ideas to life, this book will help you to think like a designer. You’ll gain insight into the inclusive, comprehensive thinking of a designer, and the practical integration of design and fabrication.

















Teachers


While this book intentionally serves a wide audience, we tailored the projects and material to serve particular educational contexts and objectives. This book is structured to serve the STEAM (Science, Technology, Electronics, Art, Math) classroom and provides a curriculum of projects and fundamentals for teachers and instructors to follow. Beginner students can dive directly into projects that focus on applied design and CNC fundamentals, while advanced students can employ different methods of design modifications and experiment with more complex techniques. This book enables instructors to teach the design thinking, applied engineering, and math skills required to support innovation and entrepreneurship through advanced manufacturing.

















Entrepreneurs


This book is also for advanced makers, designers, or professionals with ideas about things they want to make, and an understanding of the power that is at their fingertips. We know many accomplished designers and woodworkers who want to expand their knowledge of digital fabrication. We have also met established digital fabricators who would like to explore design more intensively. With a CNC router and internet access, anyone can have manufacturing capabilities and a global presence. This has the power to transform local economies, connect people over great distances through shared making, and radically change the way we make, buy, and sell goods.

















What Can You Do?


Collectively, the projects featured in this book present the fundamentals of the digital-to-physical workflow, an applied context for design thinking, and the methods for mastering essential CNC fabrication techniques. After successfully completing several projects in this book, you will have a solid understanding of CNC fundamentals. Through these projects, we also present AtFAB’s underlying logic, in an effort to reveal the considerations that factored into our decision-making process as we developed our designs. We want this combination of fundamentals and process to give you an understanding of how to propose, prototype, fabricate, and share your own designs.


Laser Cutters Versus Routers

If you don’t have access to a CNC router that’s capable of cutting full 4′ x 8′ sheets, don’t despair—this book is still for you! If you have a laser cutter or small format CNC, it is entirely possible to work through all of the projects and exercises in this book.


Each project in this book can be easily scaled down to a smaller size, and produced on a desktop machine. As discussed in “Scale Prototypes”, it’s common to make scale models of projects before building them at full size from more expensive materials. This chapter also provides step-by-step instructions on how to scale design files for cutting prototypes. You’ll also find that each project in this book covers scale prototyping particulars relative to each specific design.


























How This Book Is Organized


While this is a project-focused book, we also introduce design principle and delve into essential concepts for using software, hardware, and physical materials. The book begins with an overview of CNC joinery concepts, techniques, and software exercises, enabling you to acquire essential knowledge even if you don’t have immediate access to a full-size CNC router. A series of eight AtFAB furniture projects follow, starting small and simple and advancing in technique, scale, and complexity.










Designing for Fabrication


Part I begins with an explanation of the larger implications of design for CNC, and how it can scale to offer an efficient, environmentally sound, and economically democratic model for manufacturing. It introduces the broad concepts of designing for CNC through the explanation of AtFAB’s development from a joinery detail into a line of furniture. This part culminates with two CAD exercises: the first exercise (Chapter 3) introduces software techniques for working in three and two dimensions in order to properly set up a digital fabrication workflow. The second (Chapter 4) takes you through the process of designing a three-dimensional piece of furniture made of flat parts.

















Virtual Meets Physical


Part II offers essential knowledge for achieving digital craftsmanship, as you transition from the virtual CAD model to an actual physical object. It starts with an introduction on materials and techniques for reconciling the perfection of a digital model with the inherent variability of natural materials. It follows with Chapter 6, which offers details about the CNC router itself and the principles of proper machining.


Chapter 7 walks you through an exercise that begins with setting up a digital file for CNC fabrication and leads into two introductory CNC projects. All exercises up to this point can be accomplished without access to a CNC router.


The AtFAB Stool and Coffee Table projects are modest, simple projects that take you through the CNC fabrication process from start to finish. Each goes in depth about the steps, as well as the things that could possibly go wrong during each stage. These projects serve as a reference to consult as you pursue projects later in the book, and later on your own.

















Projects


Six furniture projects follow, with each project building on the previous one and introducing new techniques and knowledge. Organized into three parts, the projects center around common themes.


Part III covers intermediate fabrication techniques, as well as several methods for modifying a design in CAD software. The 5- to 30-Minute Chair (Chapter 10) and the 90-Minute Lounge Chair (Chapter 11) projects each walk you through tailoring a design by making either small, two-dimensional detail adjustments, or much more significant three-dimensional alterations.


Part IV introduces the principles of parametric transformations and the incredible power of being able to customize the size and shape of a design. After an overview of parametric design (Chapter 12), we’ll move on to the One-to-Several Table (Chapter 13) and Open Storage Cabinet (Chapter 14) projects, which are larger in scale and demand a more complex mix of techniques. They are also both accompanied by a downloadable customization applet where you can tailor the dimensions of a design to your own specs.


Part V focuses on moving parts and large structures. The Poke Credenza project (Chapter 15) shows how to make complex joinery that produces integral sliding doors. The book concludes with the Cellular Screen project (Chapter 16), which introduces the techniques required for handling multi-sheet projects. Perhaps this would be a jumping-off point for a maker-pro.

















Resources


Once you have gained confidence in the skills, techniques, and knowledge offered throughout, the book concludes with a convenient reference guide for your future projects.

















What We Left Out


This book is an introduction to the fundamentals and techniques for designing in two and three dimensions, with the aim of fabricating furniture projects with large format CNC routers. This book also serves as a jumping-off point for further explorations in CNC machining, design, materials, and software workflows.


As a comprehensive introduction, this book is not an exhaustive or exclusive resource on CAD or CAM software, CNC routers, CNC machining, CNC joinery, or woodworking techniques. Notably absent topics are 2.5D and 3D machining. All of the projects in this book are constructed from flat parts that are cut using 2D machining methods. 3D machining is significantly more complex than 2D, typically requiring a different workflow and often a separate CAM program and more advanced modeling software. Because 3D contouring is a much larger territory for exploration, we chose to focus on CNC fundamentals and perfecting digital craft through 2D machining.


In addition, this book teaches practical design thinking and digital fabrication concepts. It’s by no means a substitute for an intensive design education, but seeks to introduce design through this applied context.


This book does not provide comprehensive software tutorials. Designing for CNC can be done in many different software packages, with menus and controls that can change radically with each upgrade. In this book, we provide a process and general guidelines, and link to external resources when appropiate.
























How to Use This Book


The files for every exercise and project in this book are available from the book’s website.


	3D Design Files

	
The AtFAB furniture collection was designed in SketchUp and the 3D files are provided in SketchUp’s .skp format. Each 3D file contains a three-dimensional model, as well as 2D part profiles that are ready for CAM import and CNC fabrication setup.






Chapter 3 explains the process of producing a similar file, walking you through the steps of flattening a 3D model and laying it out in preparation for CNC fabrication.


	2D Cut Files

	
If you are not using SketchUp, we provide two-dimensional CNC cut layouts in DXF file formats. That way, whatever your CNC software toolchain, you’ll avoid messy file conversion issues.






	SketchUp

	
You’ll need to download and install SketchUp if you want to complete the design exercises in this book exactly as depicted. At the time of this writing, SketchUp Pro is available for a month-long trial period and SketchUp Make is available for free.






This book doesn’t provide an introduction to SketchUp basics; it only covers features and controls relevant to the design exercises. We feel that SketchUp is very easy to learn, but to avoid frustration, it’s best to get acquainted with it first. If SketchUp is new to you, we highly recommend reviewing the SketchUp website’s learning section before starting this book’s design exercises.


SketchUp files are only backward compatible to the version used to create the file. This book’s project files were created in SketchUp 2015, so you’ll need SketchUp 2015 or greater to open them.


	VCarve Pro

	
This book uses Vectric’s VCarve Pro v8 to set up files for CNC fabrication. You can download a trial version at http://www.vectric.com/products/vcarve.htm.






VCarve Pro smoothly imports SketchUp files and easily exports toolpaths to a ShopBot CNC router. While VCarve Pro has CAD features, we prefer using SketchUp for all CAD operations. The exercises in this book walk you through VCarve’s key steps in setting up a file for fabrication. We recommend that you also review VCarve’s learning resources at http://support.vectric.com/training-material.

















Conventions Used in This Book


Example P-1. 


Italic
Indicates new terms, URLs, email addresses, filenames, and file extensions.



This element indicates a warning or caution.




This element provides a tip.




This element signifies a suggestion, or general note.




	Units of Measure

	
Units are expressed in feet and inches with metric units in parentheses.



	Software and Hardware

	
We reference CAD software, CAM software, and CNC tools that we actually used to test and produce the projects presented in this book. We used SketchUp Pro 2015 for Mac to model the furniture and VCarve Pro to generate the G-Code. We fabricated all projects with a ShopBot PRS Alpha CNC Router that runs ShopBot v3. The renders that precede each section are produced by the Maxwell Render plug-in for SketchUp. We have worked with a variety of software and machines over the years. We chose these particular platforms and tools for this book because they are generally the most accessible, offer the best quality for cost, and enable the most streamlined workflow at this moment.






We’ll discuss many CAD and CAM options in Chapter 6 and try to outline their strengths and weaknesses. Throughout the book, we put most of the focus on major functions and principles that should be recognizable, regardless of your chosen platform or tools. While the field of digital fabrication is vast, we focus on CNC routers, furniture design, and plywood sheet material.

















Using Digital Design Files


	File Downloads

	
All of the 3D models, test pieces, parametric applets, and cut files for the projects in this book are available for download and modification at this book’s website.






This book is here to help you learn and grow as a designer and digital fabricator. In general, you may use the cut files, drawings, and linked downloadable digital furniture files from this book in your own designs and documentation. You do not need to contact us for permission unless you’re reproducing the design for commercial purposes. For example, designing a chair for personal use based on examples from this book does not require permission. Selling or distributing the designs or design files does require permission. Answering a question by citing this book and quoting the text does not require permission. Incorporating a significant amount of content from this book into your product’s documentation does require permission.


We appreciate, but do not require, attribution. An attribution usually includes the title, author, publisher, and ISBN. For example: “Design for CNC: Furniture Projects and Fabrication Technique by Anne Filson, Gary Rohrbacher, and Anna Kaziunas France (Make). Copyright 2017, 978-1-457-18742-1.”


If you feel your use of design files falls outside fair use or the permission given here, feel free to contact us at bookpermissions@makermedia.com.


	Commercial Licensing

	
All AtFAB designs are by Filson and Rohrbacher, and the AtFAB name is a registered trademark. Use of both the designs and the mark is permitted for non-commercial use. Contact authors Filson and Rohrbacher for permission if you would like to use any of the designs (or variations of them) or use the AtFAB name in a commercial context.





















How to Contact Us


Please address comments and questions concerning this book to the publisher:


		Make:

		1700 Montgomery St., Suite 240

		San Francisco, CA 94111

		877-306-6253 (in the United States or Canada)

		707-639-1355 (international or local)




Make: unites, inspires, informs, and entertains a growing community of resourceful people who undertake amazing projects in their backyards, basements, and garages. Make: celebrates your right to tweak, hack, and bend any technology to your will. The Make: audience continues to be a growing culture and community that believes in bettering ourselves, our environment, our educational system—our entire world. This is much more than an audience, it’s a worldwide movement that Make: is leading—we call it the Maker Movement.


For more information about Make:, visit us online:


		Make: magazine: http://makezine.com/magazine/

		Maker Faire: http://makerfaire.com

		Makezine.com: http://makezine.com

		Maker Shed: http://makershed.com/




We have a web page for this book, where we list errata, examples, and any additional information. You can access this page at http://designforcnc.com.


To comment or ask technical questions about this book, send email to bookquestions@oreilly.com.












Part I. Designing For Fabrication



The following chapters offer an introduction to the principles, opportunities, and key concepts of design for CNC. They feature design fundamentals, software techniques, and pre-fabrication planning that are essential to making CNC projects.





Chapter 1. A Modern Way of Making



Until recently, manufacturing was the exclusive realm of remote, centralized factories with specialized machinery, the mass production of identical parts, and labor-saving optimizations. Digital fabrication now affords mass customization, local just-in-time manufacturing, and quality, digital craftsmanship. Designing for CNC presents an opportunity to not only join the third industrial revolution but to also advance this modern way of making.








The Geography of Distributed Making


The affordable furniture we buy at local big box retailers has been through a long, redundant, energy-intensive global journey. It starts as raw materials that are extracted in diverse, often remote locations, and then is transported and processed into timber, plastic, and hardware components. The components are again transported to a centralized factory, where they are made into finished goods and shipped from factory to logistics centers, sometimes a hemisphere away. Goods then find their way to us through national, local, and regional distribution channels, until they finally land in our shopping basket and get taken home.


Most of us are keenly aware that the low retail price of these goods can come at a high environmental, social, and cultural cost. We’re all too familiar with furniture designed for extended transit rather than longevity, and rarely reflect upon the effort that went into producing it in a far away factory. Like “fast food” or “fast fashion,” such goods often have little authenticity or meaning to us when they are new, and they are quickly discarded after their shortly useful lives are over.


For many makers, DIY is the obvious, self-sufficient alternative to this big box dilemma. Basic design and CNC knowledge will empower you to make functional, delightful DIY projects for everyday use. Designing for CNC, however, can also make a positive impact far beyond your own project and self-sufficiency. You can share your digitally fabricated designs with a network of remote makers and fabricators, and in the process, support a new manufacturing paradigm (Figure 1-1). When we choose to ship information, not stuff, we are collectively advancing a manufacturing method that has positive consequences for the environment, local communities, and for democratic economies.



[image: dcnc 0101]
Figure 1-1. Example of a d⁠i⁠s⁠t⁠r⁠i⁠b⁠u⁠t⁠e⁠d manufacturing ecosystem



















Why Do CNC Projects Look the Way They Do?


Total design is nothing more or less than a process of relating everything to everything.”

George Nelson




This often-cited quote by mid-century architect and designer George Nelson is a fitting explanation of why many CNC designs share a unique “look.” Good design will inevitably transcend style and aesthetics, when designers relate everything to everything. For centuries, furniture design has been optimized around tools, material, technique, function, and aesthetics. Hardwood furniture was built with integral structural joinery, which was often expressed to celebrate the quality, integrity, and craftsmanship of the object. This can be seen in the dovetailed corners on an antique cabinet, or the teak mortise and tenon joint in the arm of a mid-century Danish chair.


The labor-intensive process required to manufacture affordable designs was gradually abandoned, when the mass-furniture industry narrowed its optimization around lower costs, manufacturing efficiencies, and lifestyle marketing. In the process, style was separated from construction, and any “look”—from Mission to Shaker to Modern—could be appliquéd onto lightweight particleboard parts. The inherently fragile connections between these parts are prone to failure. Structural loads and forces easily weaken the points where hardware meets particleboard. If you’ve ever moved from one residence to another with particleboard furniture, and had it rendered useless as the hardware ripped out, you’ve experienced the consequences of limited optimization.


Why I founded 100kGarages

I started as a ShopBot customer in the very early days, when the only CNC tools were expensive industrial tools costing $100k+. ShopBot founder Ted Hall saw their potential and envisioned a way to make these amazing industrial tools available to everyone, democratizing the production of our everyday things. We imagined a future where everyone would have a CNC machine in their home and that we’d all make our own chairs, tables, boats—whatever we needed—in new and interesting ways. If we needed a new chair or table we would step into our garage (or shed or spare bedroom) and fabricate exactly what we wanted.


Later, we came to the realization that not everyone needed to own a CNC machine. Most people simply needed easy access to the output of these amazing tools, so we started looking at ways to make that access universal and 100kGarages was born.


100kGarages is a free resource that’s part matchmaking service and part “job shop” facilitator, with a little bit of digital marketplace tossed in to help people find interesting designs (like AtFAB). The core function is to connect two types of people: a “maker” who needs to have a thing made that benefits from manufacturing by a digital tool of some kind, and a “fabber” who has those tools. The maker may be a mom who has a pencil drawing on a napkin of a sign for her child’s door, a college student who wants an AtFAB chair and has downloaded the digital files, or an entrepreneur who needs 100 widgets made for a new product and already has computer files of every detail.


The fabber could have a CNC machine or any number of other tools—a laser cutter, 3D printer, or even a CNC quilting machine. They could just be a cutting service, but might also be a full-service fabrication shop that can carry a project from design through finishing and assembly. The fabber  might own those tools, but they could also be an entrepreneur working out of a makerspace, fab lab, or other shared working space. The only requirement is that they are a legal business and that they respect the intellectual property rights of the original designer.



Bill Young




Design for CNC has the potential to re-establish the quality and integrity that has gone missing in mass manufactured goods. The streamlined production of intricate joinery, designed to complement the structural capacity of modern materials, can empower industry to once again manufacture affordable, well-crafted, durable furniture. Design for CNC also places this industrial capability in the hands of the individual maker. The craftsmanship once achieved only by the patience, labor, and skill of a master woodworker is now in the hands of many.


Like most innovations that are invariably different from what came before, design that is optimized around this new technology will bear a “CNC look.” AtFAB’s story explains how its appearance was not a style, but rather a balancing act between the requirements of the machine, material, labor, function, and aesthetics. Its details, joinery, and structures form the simplicity that characterize AtFAB’s overall appearance, not the other way around.


Another factor that influences the appearance of CNC furniture, especially digital designs that may be shared, is the use of shapes and techniques that simplify the fabrication process. Contoured surfaces, many small parts, complicated shapes, and double-sided parts demand more machine time for milling, additional coding of multiple passes, or complex stops and starts for end mill changes and flip-milling (more on these concepts in Chapter 6). Reliance on profile cutting ensures that furniture parts require nothing more than a light sanding as they come off the machine. Elemental shapes with simple joinery also facilitate quick, intuitive assembly, so that machine effort is maximized and manual labor is minimized.


Material and efficiency also factor into a design’s appearance. AtFAB’s rotationally symmetrical structures, like the Cat in Bag Table or Rotational Stools, nest parts of all sizes onto a cut sheet, while maintaining a consistent grain direction and a high material yield. Such material efficiency has obvious economic advantages in the manufacturing context, as well as for personal making, when you can make a dining set from three sheets of plywood. It’s worth noting that one need not get carried away by material efficiency alone, at the cost of compromising function or other considerations.


Incorporating a wide array of criteria endows things with a logic, integrity, and inherent beauty that couldn’t otherwise be achieved. As you design for CNC, don’t try to make something look like something. Try to make something that fulfills George Nelson’s maxim: that design is the process of connecting everything to everything. You’ll find that making these interconnections is what produces an object that is functional, unique, and beautiful.

















A Very Brief History of CNC Furniture


A small community of designers and makers has taken to creating furniture for CNC fabrication for just over a decade. Because each takes a unique approach to designing for the machine and material, we’ll now briefly introduce influential CNC furniture designers. We only cover a few designers here, but encourage you to explore them further.


Ronen Kadushen, a very early pioneer of designing CNC furniture, published a collection of shared, digital furniture designs in 2005, alongside an Open Design Manifesto.



[image: dcnc 0102]
Figure 1-2. Ronen Kardushan’s Italic Shelf




In 2011, Greg Saul and Tiago Rorke of Diatom Studio, launched SketchChair (Figure 1-3), a chair design accompanied by software that allows anyone to customize, download, and fabricate their own modification. At around this time, Droog, the renowned Dutch design collective supported a team of designers in the development of Design for Download. Droog launched this commercial line of furniture, which was accompanied with interactive platforms that brought users into the design process.



[image: dcnc 0103]
Figure 1-3. Diatom Studio’s SketchChair Antler chair




Jens Dyvik developed the customizable Layer Chair, shown in Figure 1-5, that can be customized for very specific ergonomic requirements or aesthetic preferences. Developed with Rhino and its parametric plug-in Grasshopper, Dyvik shared his files so others could not only replicate his design, but also improve upon it. Numerous, diverse Layer Chairs from a chair functionally tailored for a cellist to an alpine mountain formal dining set have emerged.



[image: dcnc 0104]
Figure 1-4. Joni and David S⁠t⁠e⁠i⁠n⁠e⁠r⁠'⁠s Edie Set




In 2013, Joni and David Steiner collaborated with Nick Ierodiaconou to design several pieces that later supported the launch of their OpenDesk platform (Figure 1-4). Their contemporary designs have been enthusiastically embraced by both the DIY and design community, while also showing sustained commercial success. The collection of open designs by diverse designers continues to grow on OpenDesk’s curated platform.



[image: dcnc 0105]
Figure 1-5. Jens Dyvik’s Layer Chair, Amsterdam and Cello editions



















Join the Revolution


The CNC machine is more than the tool itself. It’s part of the social network of designers, fabricators, makers, entrepreneurs, and consumers who use them. Today, there is a digital fabrication ecosystem. If you have a desire to share your designs or digital fabrication know-how, it’s now easier than ever.


	Share and Download Furniture

	
If you want to share a perfected joinery detail or table design or are just looking for furniture files to download, several platforms enable you to distribute your work to a larger community. 100kGarages is a grass roots network of designers, fabricators, makers, and consumers, which enables any member to post CNC designs for sharing. Similarly, OpenDesk is a crowdsource-curated global platform for open making that provides an online showroom for designers of popular, tested, and validated furniture designs to feature their work. You can also follow our example, and develop your own site for sharing design files.



	Advertise Your Shop

	
If you’re an expert CNC fabricator, both FabHub and 100kGarages can connect you with entrepreneurs, designers, and local customers. Each site allows you to post a profile with your location, machine, and material capabilities, and examples of your work. OpenDesk has also taken significant steps in distributed manufacturing, organizing a network of fabricators who are licensed to manufacture OpenDesk furniture designs for local customers.



	Get Your Idea Made

	
What if you’d like to employ a local digital fabricator to make a product to your specifications? If you have an idea or a digital file ready, you can use FabHub to connect directly with local workshops to bid the job. 100kGarages works in a similar way, and also has a job posting board for multiple bids. OpenDesk’s distributed manufacturing network offers customers the ability to have an OpenDesk design made locally by a licensed fabricator.
















Chapter 2. End Mill to Furniture Collection



Quite a few years ago, a colleague of ours took a moonlighting job designing and building a CNC-fabricated wall of shelving for a client. He returned exhausted after a weekend of pounding his bookshelf parts together with a sledgehammer. Brute force was the only way to get the slots in his horizontal shelves to fit completely into the slots of his vertical dividers. Our friend’s frustrations stemmed from overlooking the role of the rotational cutter in subtractive machining.








Subtractive Machining


Routers and milling machines (see Chapter 6) use extremely sharp, round, spinning tools, or rotational cutters, called end mills, to make cuts in a workpiece, or the material being cut. Subtraction works like a stonecutter chiseling away material to produce a form—once the material is removed, it’s gone for good. The shavings produced during machining are called chips.










End Mills


Also called cutters, tools, tooling, or router bits, end mills are specialized tools that cut while spinning. They come in a wide variety of geometries, each engineered to create different cut types and finishes in specific material types.

















Drilling


You’ve probably used a hand drill, or are at least familiar with the concept of drilling. The most common type of drill bit, a twist drill, is designed to cut axially, with a pointed tip that plunges directly into the material. As the drill rotates a cutter around a central axis, the bit’s sharp tip bores into the material and the chips are spiraled upward through the helical flutes, or grooves, that wrap around the tool, shown in Figure 2-1.


Drills (and their bits) are tools with a singular purpose: to create holes. The side flutes on a drill bit are dull; only the tip has cutting surfaces, one on each side of its center axis.

















Cutting Laterally


Like drill bits, the flutes of most end mills also have sharp bottom edges that allow them to plunge, but end mills can do many things that a drill bit cannot. In addition to plunging, end mills also have the ability to cut side to side, or laterally. That’s because the helical flutes on the sides of an end mill have teeth, or sharp cutting edges.



[image: dcnc 0201]
Figure 2-1. Twist drill plunging axially, end mill cutting laterally




Unlike a twist drill, the end mill’s sharp bottom edges don’t end in a single, protruding central point. When an end mill can plunge (most can), it is said to be center-cutting, or end cutting, because its flutes have sharp edges that extend around the bottom of the tool, meeting at an indented point in the center (as shown in Figure 2-1), so the end mill can cut laterally.

















The Inside Corner Problem


As Figure 2-3 illustrates, a rotational cutter can never completely carve out an interior angle. The rounded corners left behind match the tool’s radius.


When cutting out parts that have both “inside” and “outside” 90-degree corners, as shown in Figure 2-2, the outside corners are cut cleanly, with their sharp right angles intact—but the inside corners are radiused—and excess material is left behind. As the end mill’s diameter increases, so does the amount of material left behind in the corners.


This is why our friend’s slotted bookcase parts didn’t fit together as intended; the excess corner material in both the horizontal and vertical slots made a flush fit impossible.



[image: dcnc 0202]
Figure 2-2. The inside corner has a sharp, 90-degree angle
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Figure 2-3. A round tool cannot fill an inside corner




When a 90-degree inside angle is used to create joinery intended to slot together tightly—the leftover inside corner material prevents the cross-pieces from fitting together snugly—both the top and bottom parts stick out (Figure 2-4).


When we began to design our first CNC furniture pieces, our friend’s sledgehammer incident was fresh in our minds. We sketched different shapes that would create a flush, 90-degree fit between two parts. Illustrated in Figure 2-5, these sketches resulted in the sniglet, a corner detail design that pulls the tool deep into the inside angle, removing the radiused corner.



Figure 2-4. This crosspiece does not fit together properly—the radiused inside corner material prevents a flush fit
[image: Alt Text]



Figure 2-5. Using a sniglet fillet pulls the tool deep into the inside angle, resulting in flush-fitting joinery
[image: Alt Text]




























Fillets


The sniglet is a type of fillet. A fillet is a design feature that rounds off a corner. Although fillets can be added to both outside and inside corners (and can even refer to adding material to a corner via welds), when it comes to cutting flat parts, it’s imperative to add fillets to the interior corners if you want your joinery to fit properly.


If you come from a woodworking background, you may have had to resort to extensive hand labor to remove the residual inside corner material your manual router left behind. When working with a CNC, it’s far easier, efficient, and elegant to add fillets to your files and let the machine do the work.
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Figure 2-6. Machined fillet types




In addition to the sniglet introduced earlier, there are two other commonly used fillet solutions: dogbones and t-bones, shown in Figure 2-6. These fillet types are named for their appearance. When a dogbone fillet is added to both sides of a slot, the slot takes on a cartoonish, dogbone- or t-bone-like shape. 










Tool Diameter Matters


Regardless of type, fillets are tool diameter dependent; their size and shape are determined by the diameter of the end mill used to cut the parts. For context, the projects in this book use both ¼″ (6mm) and 1⁄8″ (3mm) diameter tools.


Because you’re hardcoding the tool size into your design, it’s a good practice to draw fillets slightly bigger than necessary—110% larger than the actual tool diameter works well. This ensures that if the drawing needs to be scaled down slightly, the end mill will still fit onto the inside corners. Scaling is covered in detail in “Scale Your CAD File”.

















Exercise: How to Draw Fillets


The best way to understand how fillets work and why they look the way they do is by drawing them yourself. Plus, it’s great practice for creating or adapting your own designs. Fire up your favorite vector graphics–capable program (something like SketchUp, Inkscape, Illustrator, VCarve Pro, or AutoCAD) and follow along.


This design exercise is software agnostic, but we recommend using SketchUp because you’ll be using for the design exercises throughout this book.












Dogbones and T-Bones


Dogbone and T-bone fillets are very similar; the core difference is where the “circle” that will accommodate the tool diameter is placed (relative to the inside corner you’re trying to eliminate).



Choose your tool diameter, or Ø. A ¼″ diameter tool is most commonly used for large, but detailed CNC projects. It’s strong enough to withstand the cutting forces and long enough to pass through ¾″ sheet materials without breaking.



Create a circle that is 110% larger than the tool’s diameter. For example, if you were using a ¼″ diameter tool, you’d draw a 0.275″ (7 mm) diameter circle with a 0.1375” (3.5 mm) radius.
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Figure 2-7. How to draw a dogbone fillet
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Figure 2-8. How to create a T-bone fillet





Place the circle over the inside corner. This is where dogbones and T-bones differ. The dogbone fillet rounds out the corner, while the T-bone pulls the circle out to the side of the vertex.


	Dogbone fillet

	
Intersect the circle’s radius, R, with the inside angle’s vertex and its diameter, Ø, with the part edges, as shown in Figure 2-7.






	T-bone fillet

	
Align the circle’s diameter, Ø, with the inside angle’s vertex along one side of the part, as shown in Figure 2-8.







Integrate the circle into the part lines. As shown in Figure 2-7 and Figure 2-8, draw a stroke, create a line, or use a Boolean operation to assimilate the circle into the overall part. Ensure that the lines are connected.


If you use a different size end mill, you’ll need to adjust your fillet size to match.



















Sketching Sniglets


A sniglet is created using two adjacent circles. Like dogbones and T-bones, the diameter of each circle is 110% of the tool diameter. One core difference—other than the use of two circles to guide the sniglet creation lines—is that they are placed on the outside edge of the interior corner.



Draw two adjacent circles, each circle’s diameter is 110% of the tool diameter. Align the circles to the top right of the corner vertex.



Incorporate one circle into the part. The circle directly above the corner vertex will become the fillet, while the second circle is merely a guide. Using Figure 2-9 for reference, integrate the first circle into the overall part.



[image: dcnc 0209]
Figure 2-9. How to sketch a sniglet































Toolpaths


Before taking a deeper dive into joinery, we’d like to introduce a few basic CNC terms and concepts.


CNC is an abbreviation for computer-numerically controlled. A CNC machine creates physical things from digital design files. Depending on its particular capability, a CNC machine deposits, fuses, cuts, or carves materials to produce physical things. Designers develop parts or objects in a computer-aided design (CAD) software program and then export the design file into computer-aided manufacturing (CAM) software. CAM converts the design geometries into toolpaths, a combination of 3D coordinates and physical settings, that drive the physical movements of the CNC machine.


The movements of a 3D printer, robotic arm, and CNC router are all computer numerically controlled. However, the term “CNC” has become synonymous with subtractive machines. In the context of this book, CNC refers to the computer-controlled routers and milling machines that use rotational cutters.


End mills follow toolpaths, or a series of three-dimensional coordinates and codes, telling them exactly how and where to move and cut to move and cut. That may sound complicated, but it’s actually quite straightforward. Toolpaths trace the lines of a design file.


Just like a saw, the computer-controlled end mill removes material as it traces a toolpath, forming a gap called a kerf, shown in Figure 2-10. A kerf is the total width of the material removed by an end mill as it cuts, roughly equal to the diameter of the tool.


The most basic toolpath types are profile, pocket, and drill. While all three cut to user-specified depths, there are core differences.
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Figure 2-10. An end mill traveling along a profile toolpath creates a kerf as it cuts












Profile Toolpaths


A profile toolpath follows a line of an individual part. It’s the digital equivalent of cutting a pattern by hand. Profile toolpaths, or profiles, cut around a closed shape to a specified depth. While there is only one type of profile cut, there are three different ways to make the cut: you can choose to cut on the line, outside the line, or inside the line. No matter which side of the line you cut, this is the toolpath to use when you want to completely cut out a part.


We’ve already established that end mills have a physical diameter that removes material when cutting, creating a kerf as the material is removed. Figure 2-11 shows how the kerf is positioned for each type of profile toolpath.
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Figure 2-11. Profile toolpaths can cut on, outside, or inside a line, which changes the position of the kerf and the dimensions of the part




The “on cut” view in Figure 2-11 shows the tool cutting directly on the line. This type of toolpath works well for decorative details, but is not used for machining accurately sized parts.


When the tool cuts on the line, it creates a kerf (slit) approximately equal to its diameter—but half of the kerf (equal to the radius of the tool) is positioned inside the part.


If you’re using a ¼″ tool, the total kerf is ¼″. But—because the tool is cutting on the line, you’re actually cutting into the part—removing an eighth of an inch! If your parts are designed to scale, then you need to cut outside or inside the part lines.

















Outside Profile


This is the most commonly used toolpath type because it creates a true part outline. As you can see from Figure 2-11, outside profiles only remove the material outside the part line, maintaining dimensional accuracy. As end mills have a physical diameter that creates an equally large cut and kerf, cutting outside profiles feels similar to outlining a thick pattern block with a very thick marker tip.

















Inside Profile


This type of toolpath cuts inside the part line. Because it only removes material inside the part line, it is often used to make through cuts for features that occur inside a part, like a slot.

















Pocket Toolpath


A pocket toolpath cuts on the inside of a closed line or shape, removing all the material within the pocket (the recessed, cleared area) to a user-specified depth. Pocket cuts have vertical sides and a flat bottom. They’re used for anything from joinery to decorative details and many applications in between. It’s also commonly referred to as clearing a pocket and pocketing.
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Figure 2-12. A pocket cut






















Drill Toolpath


Drill toolpaths cause the CNC to operate like a drill press, plunging the end mill vertically into the material. Drilling creates a hole that corresponds to the diameter of the tool, which means it’s not a good choice for creating dimensionally accurate fastener holes—use inside profiles instead. Peck drilling is when the tool drills to a specified depth, then raises up to clear the chips, and then plunges again, repeating the sequence until the hole is cut.
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Figure 2-13. CNC drilling






















Drawing Smooth Motion


As we worked the sniglet into our first few furniture designs, we began to see our virtual CAD lines not as mere outlines of a furniture part, but as the movement of the end mill itself. This may seem like a subtle distinction, but it’s a key concept in designing for CNC. Profiles are not just shapes, they are machine toolpaths.


Figure 2-14 shows four versions of a slot with different fillet solutions: a plain corner and the dogbone, T-bone, and sniglet shapes that effectively clear the slot’s inside corners.


The sniglet’s continuous, radiused toolpath allows the CNC tool to preserve its momentum as it turns each corner, giving it an advantage over dogbone and T-bone fillets. As you can see in Figure 2-14, the dogbone and T-bone fillet toolpaths double back on themselves, causing the machine to halt at the edge of the fillet and make sharp moves to return to the part, disrupting the smooth motion and speed of the cut.



[image: dcnc 0214]
Figure 2-14. Different fillets transform the same slot




Sniglets also reduce any possible disturbance to the part during abrupt 90-degree turns of the tool, while preserving the cut speed. By smoothly incorporating corner removal into the toolpath, the simple sniglet ends up saving time and increasing efficiency, while ultimately expressing the movement of the end mill in every joinery detail.


A successful CNC design is a direct result of understanding that the lines in your CAD program are as much about the path of the mill as they are about the edge of the part. It’s not a coincidence that the expression of a tool’s role in the fabrication of a thing should also yield efficiencies for the tool itself. The sniglet became the basic element that underpinned the entire range of AtFAB furniture. The sniglet aggregates into joinery, joinery forms assemblies, and assemblies create structures, which ultimately combine to accommodate functions. It is the little that leads to much.
























Eight Basic CNC Joint Conditions


An online search for “CNC joints” returns a seemingly infinite number of joinery styles. There are endless solutions for connecting wood-to-wood at every conceivable angle, each employing varying degrees of complexity. While it’s easy to get excited by the ingenuity in all these choices, it’s important to consider the relationship between the parts and the whole of a design, and the role of joinery to clarify or participate in that relationship.










Flat Parts From Sheet Materials


The projects in this book use profiles and pockets to make flat parts from sheet materials, as shown in Figure 2-15. Just as it sounds, sheet materials are manufactured materials that have been formed into flat sheets. Also known as sheet goods, stock, or stock material, they come in a wide range of materials and are produced to nominal (or standard) dimensions. Most projects in this book use ¾″ (19mm) low-cost plywood sheets that you can easily find at home improvement stores and lumber yards. For simplicity and clarity, a ShopBot PRS Alpha, capable of cutting standard 4′ × 8′ sheets of plywood, serves, as this book’s “example machine.”
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Figure 2-15. ShopBot CNC router with machined and partially assembled parts




Traditional woodworking joinery techniques evolved around a craftsperson working with hand tools in solid hardwoods with access to all sides of the workpiece. CNC joinery made with flat, plywood parts that must account for the three-axis machine, which can only cut from one side at a time.


In this section, we focus on joinery that creates large furniture objects from flat parts. Narrowing our scope allows us to categorize the majority of joints out there into eight basic joint conditions. Understanding that there are basic, elemental conditions for connecting parts to a whole will lead to better design—and provide insight into why choosing one joint detail over another is suited to a particular application in your own design.


The projects in this book utilize most of these eight basic conditions in order to get the most out of flat parts cut from sheet materials. They are summarized here to provide an overview of basic CNC joinery and construction, so that you can ultimately incorporate and evolve them in your own designs.

















Overlap


Overlapping joints involve connecting two or more parts lengthwise, often to achieve a longer dimension than standard material sizes (a process traditionally known as scarfing). In its simplest iteration, the ends of each part are pocketed to overlap one another for a specific length. Adhesives or mechanical fasteners join the two parts. Woodworkers also call this connection a simple half lap, a splice lap, or half lap scarf.


A more precise fit can be achieved by using a key. A keyed overlap joint is created by pocketing a positive shape on one part, which fits into a negatively carved counterpart on the connecting part. There are many examples of hybrid overlap connections that use pocketed keys that create varying degrees of structural performance based on the shape and connection between parts.
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Figure 2-16. Keyed and standard overlapping joints






















Edge to Edge


Edge-to-edge connections happen at the angled intersection of two edges. Finger and dovetail joints are common examples of edge-to-edge joints. Dovetails give added structural capacity to an edge-to-edge connection by keying the fingers. Adapting dovetail joints to CNC projects involves profile cutting on one hand, and sloped contour cuts on the other.


Finger (or box) joints are well suited for CNC, as long as fillets are used to ensure a positive connection between “fingers” on each “hand.”


AtFAB designs keep the edge-to-edge connections simple by using lazy fingers that keep the number of interlocking fingers to a minimum. They provide maximum structural integrity of the finger joint while not distracting from the piece as a whole.
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Figure 2-17. Dovetails, complex finger joints, and lazy fingers






















Edge-to-Edge-to-Edge


These connections occur at the intersection of three edges, most commonly at the corner of a box. The principles of edge-to-edge-to-edge connections are largely the same as edge-to-edge, but the introduction of a third component (perpendicular to the corner), substantially increases the complexity. The direction and sequence of assembly factors are a consideration in these connections, as are structural integrity and aggregation into larger assemblies.


When creating this type of connection, finger joints are far simpler to work with than dovetails, which are directional. Plus, as mentioned in “Edge to Edge”, dovetail joints require more complex fabrication techniques.
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Figure 2-18. Corners are formed by where the three edges meet in an edge-to-edge-to-edge connection






















End-to-Face


An end-to-face connection occurs when the end of one member intersects the face of another. A through mortise and tenon joint is a traditional example of this connection. When sheet materials are used, this connection resembles a slot and tab.


For CNC slot and tab connections, the slot would typically be cut as an inside profile, while the tab would be an outside profile cut. Closely calibrating the tool diameter with the material thickness for each of these cuts will create a perfect fit.
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Figure 2-19. A tab and slot formed by an end-to-face connection






















End to Face to Edge


An end-to-face-to-edge connection occurs when a third part sits atop an end-to-face connection, creating a tremendously strong, integrated joint. A combination of the end-to-face and edge-to-edge, this connection could also be called a compound finger or compound slot and tab connection.


Using an end-to-face-to-edge connection requires some extra design and planning to ensure that it has a flush alignment, is structurally viable, and can be physically assembled. Close attention must be paid to the respective lengths of fingers, slots, and tabs.
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Figure 2-20. An end-to-face-to-edge connection, or “compound finger”






















Through


A through connection (also known as a cross-lap) aligns intersecting slots on x and y cross-pieces, so that each appears as if it’s passing through the other. The slots in each piece are ideally the same depth at the midpoint, which preserves a maximum effective load carrying area.


The real power of these connections comes when they are used serially to produce a frame or two-way structure. With larger assemblies, you will get added structural performance by placing upward-facing slots on the short-span members. This way the short-span members are effectively “carrying” the longer spanning components. When locating slots on framing members, be sure to avoid “weaving,” which would make the structure physically impossible to assemble.
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Figure 2-21. These crosspieces are an example of a through connection






















Three-Way


Three-way connections occur by integrating a third plane atop a through connection (or series of through connections). The tabs on the crosspieces intersect a slot in the top plane. This yields a diaphragm structure that is strong, rigid, and lightweight. Edge-to-edge-to-edge connections and end-to-face-to-edge connections are similar to three-way connections in that all are made up of composite aggregations of fingers, slots, and tabs.


In structural engineering, a diaphragm is a basic element that distributes the horizontal load across the other parts of a structure.





[image: dcnc 0222]
Figure 2-22. An exploded view of a tabletop is an example of a three way connection






















Four-Way


A three-way connection becomes a four-way connection when a fourth plane is added below the through connection. This creates a torsion box where each plane is braced in all directions (see “Structures”), and loads and forces are distributed into the top and bottom planes. This produces an extremely strong and stable assembly.



[image: dcnc 0223]
Figure 2-23. This exploded diagram of a nesting pedestal demonstrates a four-way connection





























Assemblies


Joinery is beautiful on its own, but when it serves a purpose and is intelligently aggregated, joinery brings order to the larger object. AtFAB’s offerings evolved from a single piece of furniture into several distinctly different pieces, and we faced an array of questions in the design process: How should a leg meet the ground or connect with a tabletop? How should we turn a corner or terminate an edge? How should we incorporate a shelf or introduce an arm into a chair design?


There were infinite options for combining the sniglet into joinery, and we could have easily invented a new design solution to solve each discrete connection challenge that arose. This would have been a complicated process, and it ultimately would have produced a set of equally complicated, and unrelated, furniture designs. Instead, we decided to work with an overall framework that would guide our design decisions with greater consistency.


This framework began as the basic S/Z joint and then grew into several distinct joinery assemblies.










S/Z Joint


In isolation, a sniglet may seem like nothing more than a clever detail, but it underpins a complex system of furniture. Combine a sniglet and tab into a single toolpath, and you have a basic joinery element. Cutting two flat parts with this toolpath yields components that interlock to form a strong orthogonal, or right angle, connection. By multiplying, rotating, mirroring, or aggregating this basic joinery toolpath, you can combine flat parts into volumetric corners, structural frames, continuous surfaces, and more.


AtFAB uses a version of this fundamental joinery element by incorporating a sniglet and a tab, or lazy finger. When selectively combined, multiple S/Z joints form a finite number of basic joinery connections, which are in turn aggregated into larger assemblies that shape an entire line of furniture.
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Figure 2-24. The AtFAB S/Z joint interlocks two identical tabs (left) and is the basis for the tab, corner, foot and hanger assemblies



















Tab Assembly


A tab assembly locks one or more tabs into a perpendicular face, using an end-to-face joint or three-way joints to enable one-way and two-way framing. The Cat in Bag ii Table uses multiple tab assemblies to lock the tabletop into the four members underneath it. In a similar fashion, the One to Several Table uses tab assemblies that are shaped like crosshairs. Tab assemblies work on vertical surfaces, too. The sides of the Poke Credenza use tab assemblies to lock a shelf into place. The Cellular Screen uses tab assemblies to lock the front and back faces onto the vertical frame.
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Figure 2-25. The tab assembly






















Hanger Assembly


Hangers are beams that transfer horizontal tributary loads to vertical members. A hanger assembly is similar to a tab assembly in that it employs a three-way joint or an end-to-face-to-edge joint to lock three parts together. However, it differs because it uses these tabs to support a beam. The One to Several Table has hangers along its perimeter, where its frame (which supports the tabletop) locks in and is supported by the table’s sides. The Open Cabinet also has a hanger assembly at the bottom of each side, where a beam that carries the load of the shelves locks in and is supported by those sides.
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Figure 2-26. The hanger assembly






















Corner Assembly


A corner assembly brings three orthogonal faces together, forming a three-dimensional enclosure. Corners employ edge-to-edge-to-edge joints to enclose cabinetry pieces, like the top of the Poke Credenza and Open Cabinet. Corner assemblies give many AtFAB pieces a volumetric quality that transcends the idea these pieces are made of flat parts. While the One to Several Table and 90-Minute Lounge Chair and even the screen are comprised entirely of 2D parts, corner assemblies give them a three-dimensional character that suggests otherwise.
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Figure 2-27. The corner assembly






















Foot Assembly


A foot assembly, which is used on most AtFAB pieces, laterally secures the flat parts that form legs. When an excessive load or a lateral force is applied to a piece of furniture, the feet resist that thrust and keep the legs from splaying out. Feet also distribute the weight at the base of the leg, so the edges of the two adjacent sides don’t split over time. A foot assembly is the upside-down complement to the corner assembly, in that it uses a similar edge-to-edge-to-edge connection, and also adds to the three-dimensional quality of a furniture piece.
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Figure 2-28. The foot assembly





























Structures


In the same way that the elemental S/Z joint aggregates to form basic joinery, and the joinery combines to form assemblies, assemblies aggregate to create four basic structures.


The basic types of structures are: Shear, Torsion, Vierendeel, and Rotational.


When used individually or in combination in each AtFAB furniture piece, these four structures efficiently utilize flat material to resist vertical, gravity loads and sideways, lateral forces.
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Shear


Diagonal distribution of loads at the corner legs. Shear structures resist lateral forces that are applied to the side of a piece of furniture and also prevent downward gravity loads from forcing legs to splay outward. The shape of the tapered legs in the 5-30 Minute Chair and the One to Several Table, among other AtFAB pieces, resist the shear forces that come from being moved around and from downward weight.
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Figure 2-29. Shear






















Torsion


A two-way, thin, lightweight frame with a top and bottom skin. A torsion frame allows for a long span, while the skin acts as a diaphragm that keeps the frame rigid. The One to Several Table’s tabletop utilizes a torsion structure (modified, as it has only one skin rather than two). The tabletop serves as a top skin that keeps the frame beneath square and rigid. Combined, the skin and frame afford a large expansive table that is both lightweight and stable.



[image: dcnc 0230]
Figure 2-30. Torsion






















Vierendeel


An orthogonal frame with vertical, parallel members that are fixed at the top and bottom. A Vierendeel structure offers a lightweight rigid frame with rectangular space between members, which can handle a very long span. The Open Cabinet is formed by a Vierendeel frame, with shelves that are actually secondary elements. The Open Cabinet’s dividers and outer cabinet form the lightweight Vierendeel structure that can carry significant weight and handle a long span.
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Figure 2-31. Vierendeel






















Rotational


A frame with four rotationally configured legs and beams, which rotationally interlock at the center of the structure. The central, interlocking structure offsets the leg alignment, so legs are orthogonally arranged, but none are in plane with each other.


In a rotational structure, each of the four independently adjustable legs counterbalances the opposing leg. In Figure 2-37, this lightens the structure’s appearance and allows the legs to be easily set back from the table edge. The Cat in Bag ii Table uses a rotational structure. Several other AtFAB pieces (see Figure 2-43 and Figure 2-44) use this combination of counterbalance and centrally fixed rotational frame to form floating, cantilevered corners, which usually give furniture a lighter appearance.
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Figure 2-32. Rotational





























Programs


A program is a set of basic requirements, functions, or accommodations that a design must reconcile. A program gives a clear purpose to a combination of joinery, assemblies, and structures.
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Figure 2-33. Program types: Sit, Work, Screen, Store




“Program” is a term drawn from architecture, where it refers to functional requirements of a building, like the quantities, sizes, and types of spaces. A program frequently includes site conditions, construction budgets, energy efficiency, detailed needs of occupants, and so on. Though seemingly less complex than an architectural program, furniture still has functional needs to address.


For AtFAB, we found that defining a program helped further organize and aggregate the structures to serve a wide range of activities. We developed four basic programs to provide adequate diversity in the collection. Beyond this chapter, you’ll learn how adaptations, ergonomic adjustments, and parametric customizations serve an array of standard programs, as well as unanticipated needs.


	Sit

	
A seating program accommodates seating of one or more individuals for a variety of durations.



	Work

	
A work program consists of a horizontal surface that accommodates working, meeting, dining, socializing, and so forth, for an individual or group.



	Screen

	
A screen program is a self-supporting vertical surface that separates two spaces.



	Store

	
This program accommodates variably sized objects within, for display or storage.





















The 5-30 Minute Chair


A clear language and system of assemblies, structures, and programs provided a starting point for the design of the 5-30 Minute Chair. A chair is a deceptively difficult thing to design. There are countless considerations for what a chair is likely to encounter throughout its use (or misuse). Comfort, durability, and aesthetics all play a role.
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Figure 2-34. Side elevation of the 5-30 Minute Chair




The AtFAB 5-30 Minute Chair (Figure 2-34) aims to be a durable, dignified, reasonably comfortable chair that anyone could make anywhere, with half a sheet of material and a large format CNC router. And, depending on how you choose to customize or finish your chair, it can be as utilitarian, extravagant, or eccentric as desired.


The 5-30 Minute Chair was also meant to be networked, but not in the sense that it be wired as a part of the internet of things. We saw the chair more as a thing of the internet: open hardware meant to be downloaded, hacked, transformed, and then shared with others. In this context, we saw the chair we designed as a simple organism that would evolve over generations of customization by makers who were downloading it. In this open context, we see a designer’s role as offering up an elemental, well-functioning object, which is embedded with an invitation for others to make it their own, and then to keep sharing.


But before any of this was possible, there were some very basic and fundamental design challenges presented by the chair. How could flat sheet material components comfort the human body in the same way that contoured or upholstered chairs do? How would flat parts angled for posture be joined to adjacent parts? How does the chair handle the intensive lateral forces caused by sitting down and standing up? What is the thinnest profile that will still preserve structural integrity? How are successful outcomes and “quality control” ensured, when the chair is downloaded and made half a world away? How does a designer propose something that invites others to evolve it?


We knew the chair couldn’t be made comfortable by adding upholstery or by molding or contouring parts, so we tried to understand how comfortable it could be with the flat materials and CNC profile toolpaths we were using. An important rule for a designer is to be honest with the materials and tools at hand, to understand what’s possible, and to work with it directly. We estimate that this chair will remain comfortable for 5 to 30 minutes of sitting. Since some portion of comfort is related to balance and distribution of weight in a sitting body, its proportions are drawn from basic ergonomic rules, which determine the optimal angle for the chair’s seat and back. The chair poses the sitter’s  center of gravity at the center of its structure. This leads most people who sit in it to remark that it is more comfortable than it looks!


Structurally, the chair’s interlocking joints distribute loads and forces from the seat and seatback into the sides, and from the four legs into the feet. (see “Structures”) While the 5-30 Minute Chair uses fasteners as secondary elements that hold individual parts together, the slots and tabs do all of the serious structural work, distributing the loads and forces into adjacent pieces.


Integrated Joinery Versus Moment Connections

Furniture made with integrated plywood joinery is furniture that will last. The many distributed interlocking slots and tabs that connect each furniture part are inherently strong and will remain intact despite pressure, force, and even abuse. Such structural integrity ensures that a piece of furniture can remain sturdy and functional, even as it endures years or even decades of intensive use. In contrast, most flatpack chairs and furniture have moment-frames, where loads and forces are concentrated at mechanical connections in the corners and edges of the furniture. Such connections will not endure use and abuse over time, making the furniture that relies on them less durable and sustainable.
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Figure 2-35. The slot in the seat is slightly wider than the thickness of the material, in order to accommodate the angled intersection with the tab.




Some of the most recognizable attributes of the chair emerged from unique functional and structural challenges. For instance, our system of assemblies, structures, and programs did not offer an obvious solution for introducing a sloped seat and back into a fabrication system optimized for flat, orthogonally1 arranged parts. We resolved the challenge by altogether avoiding the intersection of these two non-orthogonal parts and leaving a gap between the seat and the seat back. For us, sometimes selectively avoiding an issue like this can be a design strategy in and of itself. We fixed the seat in place laterally with a tab that slots through its front edge (Figure 2-35), and secured the seat vertically with three-sided slots in each side part to hold the back corners of the seat. The seat back, the back legs, and back edge of the seat serve as spacers to keep the chair sides apart. The stoutly tapered legs, formed by the sides, front, and back parts resist the diagonal shear forces that come from the everyday use of a chair.


As we designed the chair, we looked to the system to help us solve design problems. When the system didn’t offer an obvious solution to unique conditions, we’d let our interests guide us. Balancing the systemic and the specific is an example of what designers confront throughout the design process. At such moments, our interests were purely functional, while at other times, they were compositional or even whimsical. The important thing is to tap into whatever drives your curiosity and incites you to want to make things.










Iteration and Design Frameworks


This system of joinery, assemblies, structures, and programs, around which AtFAB is organized, is an example of a design framework. Frameworks can take many forms and are helpful tools in making decisions when designing furniture or almost anything else.


Inventing a framework doesn’t have to be a rigid, linear, or top-down process. Designing a second or third furniture piece often provoked us to rethink an elemental detail or assembly used in an earlier piece. Such rethinking is an opportunity to refine (or altogether reconsider) how a particular assembly can work in multiple instances instead of just one. For example, the AtFAB foot assembly originated for the 5-30 Minute Chair but evolved as it was incorporated into several subsequent furniture pieces. The hanger assembly was designed by working back and forth between several pieces that required structural beams. Similarly, the corner assembly and rotational structure emerged as we simultaneously designed several pieces that shared common requirements. This cycle of testing, rethinking, and improving is an example of iteration, and is an essential part of the design process. As we iterated upon our framework through the process of designing ever more pieces, AtFAB coalesced into a coherent collection with its now recognizable details and volumetric form.


Your own design framework might consist of common details, proportions, fabrication techniques, or anything that makes sense to your project or preoccupations. However it’s organized, you will find frameworks especially useful in streamlining the decision-making process. When your design task grows in scale or complexity, you will inevitably face numerous decisions about connecting parts and joinery. Rather than inventing a new detail or assembly to solve every new problem, a clear, useful framework will guide you toward consistent solutions. In aggregate, these solutions are what will help you achieve a coherence in anything you design.
























Evolution From the Chair to AtFAB


The 5-30 Minute Chair was followed by other designs, with each new piece initiating the iterative refinement for AtFAB’s overall language and system of joinery, assemblies, and structures. Through this process, AtFAB became both a furniture collection and a library of CNC details and techniques.










Rotational Stools


The Rotational Stools in Chapter 8 are the smallest, simplest furniture objects in the collection and in this book. Each version of the stool has two part types: a seat part and leg part. Four identical legs are organized into a rotational structure, which interlocks into the seat. The stools have a substantial amount of joinery while using a relatively modest amount of material, which makes them ideal for this book’s first project and introducing basic CNC workflow.
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Figure 2-36. Rotational Stools






















Cat in Bag ii Table


Like the Rotational Stools, the Cat in Bag ii Table in Chapter 9 is a rotational structure with four similar leg parts that lock into the table top with three-way joints. As a project, this larger furniture piece introduces new workflow steps, as well as basic concepts of digital technique. The project also provides ample opportunity to experiment with materials and finishes.



[image: dcnc 0237]
Figure 2-37. Cat In Bag ii Table






















90-Minute Lounge Chair


The 90-Minute Lounge Chair in Chapter 11 embodies all of the challenges presented by the 5-30 Minute Chair, with greater intensity. The Lounge Chair requires the intersection of multiple sloping parts and introduces parts that govern relationships between other parts. The chair’s “arm” piece connects and poses virtually all of the other components of the chair into their final positions. The Lounge Chair project also introduces how to use a jig to streamline assembly. This project also involves pocket cutting into the sides of the chair and machining four keys that fit into the pockets.
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Figure 2-38. 90-Minute Lounge Chair






















One to Several Table


The One to Several Table in Chapter 13 is formed by a partial torsion box structure that is deep enough to hold computers and monitors, and shallow enough to work ergonomically with the myriad of task chairs. The table introduces joinery that connects three surfaces, both in the middle of the table and along its edges. This table file is accompanied by an optional parametric customization app, which enables you to transform its overall dimensions, fine-tune material thickness and sniglet size. A link to the Processing files and instructions on how to install and use them can be found in Chapter 12.
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Figure 2-39. One to Several Table






















Open Storage Cabinet


The Open Storage Cabinet in Chapter 14 combines all techniques presented in earlier chapters. From pocket cuts to managing multiple sheets to integrating multiple material thicknesses to working with an expanded parametric app, the Open Storage Cabinet offers a chance to put nearly every concept together in one project.
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Figure 2-40. Open Storage Cabinet






















Poke Credenza


The Poke Credenza in Chapter 15 is a volumetric storage cabinet with a modest span and a set of sliding doors that move smoothly without hardware. It was AtFAB’s first entirely CNC-fabricated piece with moving parts. The doors are made of a thinner sheet material, which provides the challenge of coordinating fabrication details and offers an opportunity to explore CNC patterns.
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Figure 2-41. Poke Credenza






















Cellular Screen


The Cellular Screen in Chapter 16 is a partition that demonstrates how using multiple interlocking assemblies can overcome the size limitations of standard plywood and CNC dimensions. It’s a short step from this partition to small structures. The screen’s parts aggregate to form a lightweight structure that can handle a long span and vertical rigidity. Fabricating the Cellular Screen is straightforward. It has simple toolpaths, parts, and assemblies like the projects that precede it. The screen introduces the concept of working on a large project, and the necessary planning and managing of a project with many parts.



[image: dcnc 0242]
Figure 2-42. Cellular Screen





























AtFAB Furniture Collection


Figure 2-43. The entire AtFAB furniture collection, Part I
[image: Alt Text]




Figure 2-44. The entire AtFAB furniture collection, Part II
[image: Alt Text]




Figure 2-45. CNC tool making a down cut













1 Orthogonal, at right angles.



Chapter 3. 3D Model to 2D Parts



Transforming a virtual object on the screen into a physical object in the real world might be the most exhilarating, empowering part of designing for CNC. While getting from design concept to 3D model to fabrication doesn’t yet happen at the push of a button, there are good practices that ensure a smooth process and beautifully crafted results. Digital craftsmanship begins well before you turn on the CNC router—it starts with your CAD model.








From Design to Fabrication


When you’re in the early phases of developing a design, either in your sketchbook or digital file, it makes sense to work freely so your ideas flow easily onto paper or screen. As your design begins to solidify into a well-defined concept, you’re ready to start preparing for fabrication. At this point, it’s helpful to begin organizing your CAD file in a way that accommodates the future steps in the fabrication process.


Taking time to develop an orderly CAD file seems like a tedious disruption to designing. The transition from digital to physical, however, has the potential to turn even the simplest project into a complicated endeavor. A bit of planning will go a long way in making an enjoyable process and producing a well-crafted outcome. Set and follow a few organizational standards early, and you’ll keep your model information accessible, reduce errors, and ultimately streamline your workflow as your design goes from CAD file to CAM program, and ultimately to the machine for fabrication.


At the stage in the process when you are preparing your design for fabrication, you’ll likely find yourself repeatedly making numerous small adjustments and coordinating many details throughout the design. Clear file organization simplifies the task of isolating a part, identifying a kind of toolpath, or making changes to repetitive elements. Good CAD organization is also essential when you are rapid prototyping and going through an iterative cycle of designing, fabricating and analyzing the prototype, to optimize and improve the design, optimizing, to improve the design. As you go from design file to CAM to prototype, it’s much easier to circle back around and adjust a CAD file that’s well organized.


Beyond working on your own, clear systems make it easier to collaborate with others on your project. It’s likely that you’ll get to work with someone else during the process: a friend in your fab lab, a professional fabricator at a local CNC shop, or a remote maker who downloaded the design files you shared online. A clear organization will make it easy for anyone to jump in and quickly understand your project.

















Mise en Place


For chefs, the French culinary phrase mise en place describes a properly organized workspace with both tools and prepped ingredients at the ready for preparing a preplanned menu or dish. We’ve found it to be a useful concept when digitally designing for fabrication and reference it in the design exercises in this book.


Mise en place, like design, is simultaneously the method and process of planning, and a system that facilitates the real-time execution of cooking a meal. A little planning, preparation, and forethought in your file setup will go a long way—and it will help you focus on designing in real time without having to stop and re-work.


For this exercise, you’ll need a copy of SketchUp Make (free) or SketchUp Pro (paid) version 2015 or later.



	
When you open the SketchUp file, you’ll find a 3D model of the AtFAB 5-30 Minute Chair situated on the X/Y plane, near the origin.



	
This file contains 10 flat parts that are components, which share a common thickness of ¾″ (19mm).



	
There are six components, since the chair sides and feet are copies of one part type. The geometries within each component are assigned to the layer 000_AtFAB Chair.






New to SketchUp?

If you’re brand new to SketchUp, we highly recommend that you get acquainted with the basics before attempting the design exercises in this book. The SketchUp website has a free learning section that will ramp you up quickly.












Download Files


	
If you haven’t already, download and install SketchUp.



	
Download the “model to cut sheet exercise” version of the 5-30 Minute Chair from the book’s website.



	
Open the AtFAB_CHR-LAYOUT.skp file you downloaded (Figure 3-1). This is a special version of the 5- to 30-Minute Chair that only contains a 3D model, created specifically for this exercise.





























Layers


Layers are a powerful tool for organizing a model and streamlining the process of fabrication. The file you opened contains two layers. You’ll find 000_AtFAB Chair, which contains all of the necessary parts for the 3D chair model. This layer is the modeling layer. You’ll also find SketchUp’s default layer, Layer0. You can ignore Layer0 for now, but you will learn how to use it for sketching in the next exercise.


In addition to these two layers already in the file, you’ll need to add several additional layers for flattened parts, material stock, and a few reference layers. You’ll also add layers for toolpaths like pockets, profiles, and drill cuts.
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Figure 3-1. Add layers to the file












Add Layers


	
Add a cut layer for cutting, naming it 000_AtFAB Chair cut.
Figures 3-1 and 3-2 show all the added layers.



	
Add a flatten layer for flattened parts, naming it 000_AtFAB Chair flat.



	
Add a storage layer for “storing” notes and other information, 000_AtFAB Chair stor.



	
Add an underlay layer to use a reference layer for guidelines and material stock, 000_AtFAB Chair under.



	
Next, add a layer for each type of cut. Use layer naming conventions that anticipate toolpaths: _holes, _pocket-1, _pocket-2, _profile-inside, _profile-outside, _text-etch.



	
Assign a different color to each new toolpath layer, so in the next step you’ll be able to see what elements are assigned on which layer.


Assigning colors to each toolpath layer is especially useful, when importing your SketchUp file into VCarve. Once in CAM, vectors organized on layers and associated by color allow you to visually check your work, as you efficiently and accurately assign toolpaths for machining.









Wondering why these layer names are so long?
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Figure 3-2. Standard layers and colors




Layer naming conventions help you manage drawing information at various steps from design through fabrication, and also when importing into rendering programs. Inserting a prefix like 000 seems unnecessary in a CAD file, but often becomes useful in isolating parts and managing layers, once your file is imported into a CAM program. You’ll find more about the CAM file and fabrication in Chapter 7.


Assigning colors to toolpath layers helps to visually differentiate one cut layer from another in the CAD program. Assigned layer colors will stay associated with the parts when you import the file into your CAM software.


Introducing a secondary prefix, like AtFAB Chair, is helpful when you import multiple design files into a single cut file in your CAM software. There are no absolutes in layer naming. Use whatever terms make sense for you that are also short, simple, and clear enough for someone else to understand.


























Underlays


Underlays are graphic references that are essential for defining limits, finding alignments, and providing other visual information that  keeps your file and model in order. Underlays can be anything from boundaries and center-lines to grids and reference points, which assist you in modeling your design and laying it out.


In this next step, you’ll draw a simple underlay consisting of a 2D outline of your sheet material or stock. This outline will serve as a reference for laying out the chair parts onto an actual 4′ × 8′ sheet of plywood.










Draw Sheet Material


	
Switch to the underlay layer, 000_AtFAB Chair_under.



	
Draw a 4′ × 8′ 2D outline of your material stock on this layer, as shown in Figure 3-3. Ensure that this 2D outline sits exactly on the X/Y plane, with its Z coordinate equal to 0.
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Figure 3-3. Draw a 2D outline of your material stock


























Flattening and Layout


These next steps walk you through the process of flattening each chair part by rotating it onto the X/Y plane and locating it within the boundary of the plywood underlay that you drew in the last step. Many CAM software programs will actually automate the layout process for you, efficiently nesting parts on a sheet with appropriate spacing between each part. From a design standpoint, however, sheet layout must go beyond efficiently placing parts within the boundary of your sheet stock. It’s critical to account for a much wider range of factors like grain direction, finish quality, and material efficiency, as well as CNC issues like pocket cutting and machine vibration. As you go through this step in the exercise, it’s helpful to keep a few rules in mind.










Face Right Side Up


Orient the prominent, exposed surface of a furniture part so that it faces upward on the sheet. Later in this section, you’ll see that the top face of the seat and the exposed faces of the sides, front, and back legs are facing upward, illustrated in Figure 3-4 and Figure 3-5.


Face direction is key when working with sheet materials, like plywoods, which often have different finish grades on each side (this will be discussed more fully in “Selecting Materials”). Face direction is also critical for pocket cuts (see “Cut Pockets on the Correct Side”), which must be milled from the top surface of the sheet. This chair doesn’t have pockets, but if you’re applying these flattening techniques to another design, note any design features as you lay out the parts.


Because every chair part is either symmetrical or else a mirrored copy, its layout process is more forgiving than a design that has asymmetrical or multiple unique parts. If flattening and laying out parts from a more complex design, take special care that the correct surface is facing upward. It frequently helps to rotate and move parts into place on the sheet, rather than mirror, to avoid cutting a backwards part.

















Consider Grain Direction


As you lay out each flattened part within the cut sheet, give consideration to the direction of wood grain across the part. There aren’t specific rules for handling wood grain, except to look beyond just the part for opportunities where the linear pattern can complement the whole design. Grain direction may wrap around a corner to emphasize volume, or it may run lengthwise to emphasize slender proportions. It may be parallel to the ground, while in in other pieces it may be perpendicular.

















Leave Space Between Parts


Leave at least one inch between parts and the material boundary. While it’s tempting to push parts closely together, it’s important to remember that an end mill has a physical diameter that creates a kerf when cutting. The tool needs to fit between the parts, and there must be enough stock material left over to keep the part in place. As the CNC cuts parts, the stock material loses structural integrity. Parts placed too closely together can vibrate out of place and become damaged.

















Minimize Material Waste


Finally, minimize material waste by laying out chair parts to use as little sheet material as possible. Once part orientation and grain direction are accounted for, keep moving parts and nesting them into each other until you find a layout that minimizes waste. While this exercise focuses on one chair, you should find that two chairs will fit within the sheet material boundary.

















Flatten and Layout Parts


	
Copy the entire model and paste it onto the flatten layer, 000_AtFAB Chair flat (Figure 3-4).



	
Turn off the original model layer, 000_AtFAB Chair.



	
Select a part. Using the rotate or move tool, rotate or move the part so that it is parallel with the X/Y plane.



	
Align the bottom face of each part with the X/Y plane and material stock outline.



	
Proceed with these same steps on all other parts.



	
With the bottom face of all parts aligned with the X/Y plane, arrange each flattened part within the material stock boundary, as shown in Figure 3-5.



	
Nest parts into each other so that material is used efficiently, while maintaining a 1″ minimum distance from the edge and between parts.
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Figure 3-4. Rotating the first chair part onto the X/Y Axis
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Figure 3-5. All chair parts flattened and nested within the material boundary


























Components


The ten chair parts you’ve been working with are comprised of six SketchUp components, a collection of vectors and surfaces combined into a single element. The Foot and Side are modeled one time, and then copied to make the chair’s two sides and four feet. The flattened copy you created in the previous step are additional copies of those six original chair components. Each component in this model was named using a number, but you can name them however you prefer.


SketchUp’s components allow you to keep a model organized by streamlining repetitive elements. Many CAD software programs have capabilities analogous to SketchUp components. Some programs call components blocks and others call them clones. When creating components, your strategy should be to minimize repetitive work that can lead to errors, so you can maximize efficiency while maintaining quality.


Beyond their usefulness in streamlining a modeling file, components are important to the CAD→CAM workflow of SketchUp→VCarve Pro. Exporting components—instead of independent elements or vectors—from SketchUp into VCarve Pro keeps a geometry’s information intact. When preparing your file for export into a CAM program, components also reduce repetetive tasks. When you edit a component, the copies of that component automatically update. You’ll see this feature in action in Chapter 4.


With all chair parts flattened onto the material stock boundary, you’re ready to convert flat parts from components into unique elements. A unique element turns an existing component into a new, separate component.










Create Unique Components
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Figure 3-6. Entity Info for chair component #001




	
Copy all flattened model parts and paste onto the cut layer, 000_AtFAB Chair cut.



	
Turn off the flatten layer, so that only the cut layer and underlay layers remain on.



	
Right-click on each individual component and select Make Unique, which will turn this particular instance of a component into one that is independent from its component “siblings.” You only need one unique component for each part type. Remember that the Foot and Side are each only one component.



	
Eliminate (delete) the duplicate elements, the extra Feet and the Sides.



	
Replace them with new copies of the unique component. Make three Foot copies (for a total of four Feet) and one Side copy (total of two Sides).



	
Add a “__” prefix to differentiate the new component from the original.







The chair part components, which were assigned to the 3D model layer and 2D flatten layer, are now turned off and can be reserved for any future design adjustments or changes you might want to make. By applying Make Unique to the visible chair components on the cut layer, you have differentiated them from the originals. Any edits to those new components won’t affect the original chair components.
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Figure 3-7. Ten parts and six components


























Profiles


Now, you’re ready to convert 3D flattened components into 2D vectors that will ultimately form your toolpaths. You will do this by deleting all 3D information, except a single outline of each part that sits on the X/Y Plane. This single outline is a group of lines and segmented arcs, which we refer to as vectors.










Make 3D Parts into 2D Profiles


	
To edit a component, right-click on it and select Edit Component.



	
Delete all vectors and surfaces that are in the third dimension. Retain only those 2D vectors that are aligned with the X/Y plane (Figure 3-8).



	
These remaining 2D profiles form your 2D cut lines.



	
Add a double underscore (__) to the original name for the revised 2D component (Figure 3-9).



	
Exit the component editor and proceed with next the component until all six chair components are modified from 3D parts into flat, 2D profiles.
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Figure 3-8. Delete all 3D vectors except those aligned with the X/Y plane.




The double underscore (__) is a VCarve naming convention. Labeling components with it ensures that a discrete component will be recognized when you import your SketchUp file into the software. In Chapter 7, you’ll learn how to work with components in VCarve Pro that have been defined this way in SketchUp.





[image: dcnc 0310 half]
Figure 3-9. This new component definition has a double underscore (__) before its name


























Cutting Layers


These next steps walk you through assigning layers to profiles, based on different toolpathing requirements. Earlier, in “Add Layers”, we defined layers for inside and outside profiles, as well as holes, pocket cuts, and text etching.


In this part of the exercise, you’ll keep it simple by assigning only inside profiles, outside profiles, and holes to each of the chair parts. (You’ll get to explore pocket cuts and etching in other parts of this book.)


In addition to working with components and layers, you’ll also work with SketchUp’s Make Group tool. Unlike components, groups are discrete entities, which in this case are nested inside a component. Grouping vectors is essential for modeling and layer management in SketchUp. It preserves a relationship between multiple, separate vectors when exporting parts into VCarve Pro or other CAM software.










Assign Profiles to Cutting Layers


	
To edit the chair seat component, right-click on it and select Edit Component.



	
Select both of the small holes on either side of the chair seat. Place both onto the layer 000_AtFAB Chair_holes by changing the layer in the Entity Info box with the drop-down menu. The holes should turn red.



	
With both holes still selected, right-click and select Make Group to group them. Place the grouped holes onto the layer 000_AtFAB Chair_holes.



	
Select the slot in the middle of the chair seat and place its vectors onto 000_AtFAB Chair_profile inside (Figure 3-10). The slot should turn green to match the layer color. Select Make Group to combine the slot vectors into a single entity. Place the group onto 000_AtFAB Chair_profile inside.



	
Turn off those two layers, select the remaining vectors that are exterior profile cuts, and place the vectors onto 000_AtFAB Chair_profile outside (Figure 3-11). The outer profile should turn blue. Group these vectors and put the group on 000_AtFAB Chair_profile outside.



	
Exit the component and apply these same steps with the remaining five components. When you’re finished, all vectors inside each component should be grouped with colors that match the appropriate cut layers. As you edit a foot and side 2D component, note how all component copies automatically update.



	
When complete, your component palette shows two sets of components named for the 3D parts and the 2D profiles.







Managing SketchUp Vectors

SketchUp forms geometries somewhat differently from other software programs, so that each part outline is comprised of multiple segments, with even arcs comprised of an imperceptible collection of faceted segments. Components help contain and manage this collection of vectors, so they act as a single element. Your workflow might differ in other software that produces closed polylines or polysurfaces, and arcs that are defined by equations.
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Figure 3-10. Assign slot to 000_AtFAB Chair_profile inside





[image: dcnc 0312]
Figure 3-11. Assign seat perimeter profile to 000_AtFAB Chair_profile outside
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Figure 3-12. 2D profiles on cut sheet
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Figure 3-13. Component palette with 2D profile components and 3D components



Inside and Outside Profiles

Inside and outside profile cuts are identified and separated into distinct layers for good reason. When an end mill cuts along the perimeter of a part, you’ll want to use an outside profile toolpath, as discussed in “Toolpaths”. Conversely, you’ll need to use an inside profile toolpath inside cuts, and possibly a drill toolpath for holes. Segregating different profiles onto distinct layers simplifies the process and accuracy of toolpath programming in your CAM program. Chapter 7 will explain in detail how to do this using VCarve Pro.


























Export Options


Now that your file has a complete set of 2D profile components with vectors placed on cut layers, it’s almost ready to save for import into VCarve Pro. VCarve makes the import task relatively easy by importing SketchUp files directly. However, you still need to go through a few final steps to ensure that the file imports as you want it to. This next exercise outlines the settings that preserve your part layout and layer definitions.










Save as SketchUp 2014


Preparing your SketchUp File for easy importing into VCarve requires a few final steps:


	
Turn all layers off, except 000_AtFAB Chair cut, 000_AtFAB Chair_holes, 000_AtFAB Chair_profile inside, and 000_AtFAB Chair_profile outside.



	
Select all of your 2D profile components, and select Make Component to nest them into a single component. Place this component onto the 000_AtFAB Chair cut layer.



	
Save this file as a SketchUp 2014 file. We’ll explain how to import these into a CAM program in Chapter 7.







VCarve won’t import layers that are turned off, so your 3D model and other design information on layers won’t import into the CAM file. Though the parts on these layers are not required for fabrication, in Chapter 4, you will see how organizing components in both 2D and 3D facilitates the process of designing for CNC.
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Figure 3-14. Files saved in SketchUp 2014 format can be opened in VCarve Pro CAM software



















Optional: Export a DXF File


If not working with VCarve, you can save your toolpaths into a DXF file that can be read by most other CAM programs.


DXF stands for Drawing Interchange Format, which is the interoperable version of AutoCAD’s native drawing format, DWG. Programs like SketchUp allow you to save into DXF format, while many CAD, illustration, and CAM programs will import the vector, text, and formatting data of a DXF.



[image: dcnc 0316]
Figure 3-15. DXF export settings in SketchUp




	
Select Export 2D Graphic, under the File drop-down menu (File→Export→2D Graphic).



	
In the export pop-up window, select the file name and location. In the Format pull-down menu, choose AutoCAD DXF File.



	
Click Options to open the window with DXF export options.



	
In the Export Options window, choose the settings shown in Figure 3-15 and select OK.


On the model and cut layers that are turned off, your file still has its set of chair part components configured as a 3D chair model and flattened into 2D. By exporting a 2D Graphic DXF, these layers will not export.


























Chapter 4. Getting Started with Design



This chapter introduces the many kinds of thinking involved in the design process, by taking you through the steps of designing a very simple bench with AtFAB joinery. While showing key steps and decisions in a design process, this exercise will also familiarize you with how to work within AtFAB’s organized system of joinery, structures, programs, and assemblies. AtFAB was always intended as a starting point for design, which we or anyone could take further. After completing the bench, you’ll have the skills to modify the projects in this book and enough knowledge to start designing completely new pieces that suit your own needs.


When we designed each new piece of AtFAB furniture, we didn’t literally start with the sniglet and work our way up. Rather, we looked to a particular need or use, like the need for a sturdy worktable or enclosed storage, and designed a piece to fulfill that need. To streamline our decisions, we worked within the AtFAB system, which had already figured out the hard stuff like joinery, structures, materials, and fabrication. Instead of constraining, a system frees you up to focus the design process on elegantly integrating functional needs with form, details, and proportions.


This chapter uses techniques with SketchUp to design an object in three dimensions, which will be fabricated as flat 2D parts, and then cut and assembled. You’ll create a basic 3D model for a bench, with integrated CNC joinery. While guiding you through an approach for solving a design problem, the process, concepts, and modeling techniques practiced here can be applied to projects throughout the book. We encourage you to find ways to hack each 3D file, whether by modifying overall dimensions to widen a chair or by pushing/pulling connections in a cabinet to add another shelf. Once you understand the principles of modification, we believe that you will soon want to design your own pieces from scratch!








Define a Project Program


As you embark on a design project, whether furniture or anything else, it’s essential to first research your design program (introduced in “Programs”). A program starts with having a defined need that a design must address. In this exercise, the need that you’ll fulfill is a bench that seats two people. While you already understand the basic program for a bench is seating, you’ll also want to identify more detailed features like ergonomic dimensions and key proportions. The more knowledge you have about the function and context of the thing that you are designing, the better the design will ultimately be.










Ergonomics


If you’re designing a custom piece of furniture for your personal use, you could simply take your own measurements and use them as the basis for your design. However, because this bench seats two people, and might be used by others besides yourself, it helps to think in more universal terms. Because you can’t anticipate the comfort of every individual who may use your bench, you can rely on ergonomics and design standards (see Appendix A) to ensure that it will accommodate the greatest range.


	Consider the following: 

	


	
How long does a bench need to be to seat two people?



	
What height and depth are comfortable?







	Dimensional requirements: 

	


	
General ergonomic standards suggest that a two-seater bench needs to be about 48″ long, and for comfort should be about 18″ deep and 18″ high (1220 mm × 450 mm × 45 mm).

























Fabrication Constraints


Other variables that will impact your design are the structural capabilities of your material, as well as the CNC machine size, end mill diameter, and stock material size and thickness. Like other AtFAB projects, the stock material and machine dimensions are already determined. We’ll use 4′ × 8′ sheets, with a nominal material thickness that is ¾″. Our end mill diameter will be ¼″. We can safely assume that our optimal bench dimensions will easily work within these constraints.


	Consider the following: 

	


	
How big is my material?



	
How big is my machine?







	Dimensional limits: 

	


	
Machine and material size are both 4′ × 8′.










However, there are numerous other program requirements that you might want to research prior to jumping into the design process of a project. “Develop a Program” will elaborate on these additional considerations that your design program might also include.
























File Setup For Design


Chapter 3 introduced techniques for using layers, components, and groups to keep your work organized. Setting up your CAD workspace, using layers that facilitate the design process and anticipate fabrication, makes it much easier to focus on your project.


This exercise expands on that organizational logic, as it walks you through the design process. As before, you’ll begin by setting up your SketchUp file and environment—or mise en place—to keep your work organized throughout the design and fabrication process.










Layer Naming Conventions


In Chapter 3, you started with a finished design and then created layers for flattening the parts and preparing their profiles for toolpathing. You will employ those same layers in this exercise. Since you are designing the object itself in this exercise, you will also use several additional layers. The following is a comprehensive list of the layers and a bit more background on the role each one has in the overall workflow:


	Working layer

	
Layer0 is SketchUp’s special default layer. Use this layer as your working layer to create preliminary 3D bench elements, and develop the design. The working layer is the looser, sketchier layer where you explore ideas and model preliminary concepts at different stages of the design process. As your design becomes more defined, you can place elements onto the modeling layer and begin working there. Later in the process, you can always go back to this layer when you need to sketch. See SketchUp Layers: Sacred Layer0 for more info.



	Modeling layer

	
000_bench model is where you’ll place the finalized 3D model of your bench.



	Flattening layer

	
000_bench flat is used for flattened 3D parts, configured into a cut sheet, so they can ultimately be cut on a CNC router.



	Underlays

	
000_bench under is a layer for spatial or graphic elements like guidelines, reference points, boundaries, or objects that are critical to the design process, but not part of the design itself. On the underlay layer, place things like the material boundary, critical ergonomic dimensions, center lines, or a module for spacing hardware or joints.



	Temporary layers

	
Create temporary design layers with a separate prefix, putting them at the end of the list. You can add (and delete) temporary layers (like zzz_stock, zzz_massing, zzz_sophie, zzz_storage), using them to “store” modeled objects during the design process. Objects placed on these layers are not part of the actual design and also aren’t part of the machining workflow. However, they are essential 3D elements that you use in the process of creating the design. Put items like the bench massing, 3D stock material, or the sniglet outline onto this storage layer. Turn them on and off as necessary.



	Cut layer

	
000_bench cut contains vector lines from the flattened parts that form the basis for CNC-able cut files and your toolpath layers.



	Toolpath layers

	
If you’re planning to go beyond this exercise and machine your bench, you’ll need to add toolpathing layers for profile toolpaths and holes (profile inside, profile outside, and holes). The same goes for adding pockets (pocket 1, pocket 2) and for any decorative engraving you may wish to incorporate (text / etch).





















Create File, Add Layers


	

Create a new SketchUp file. You can design in either inches or millimeters, whichever suits your workflow best.



	

Activate these window palettes:



	
Window→Entity info



	
Window→Layers



	
Window→Outliner



	
Window→Components







	

Set up your layers. Add the modeling and flattening layers:



	
000_Bench model



	
000_Bench flat











A prefix, like 000, allows you to easily sort and organize your layer list as you work. You can easily change the prefix numbers to move layers up or down in SketchUp’s layer palette.




	
Add the reference layer:



	
000_Bench under







	
Add temporary layers:



	
zzz_massing



	
zzz_storage



	
zzz_sophie (scale figure)



	
zzz_stock







	
Optional: Create the cut file and individual toolpath layers:



	
000_Bench cut



	
000_Bench_profile inside, layer color green



	
000_Bench_profile outside, layer color blue



	
000_Bench_holes, layer color red



	
000_Bench_pocket side 1, layer color orange



	
000_Bench_pocket side 2, layer color yellow











Assigning colors to each toolpathing layer in the SketchUp file will help when importing the file into VCarve. Associating toolpathing layers by color helps you visually differentiate the profiles and accurately and efficiently assign toolpaths in VCarve.
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Figure 4-1. Detail of the layer palette, Layer0 is selected



















Draw the Cut Sheet Underlay


	

Make Layer0 the current layer.



	

Draw a two-dimensional 4′ × 8′ box (1220 mm × 2440 mm × 19 mm) on Layer0. This box (shown in Figure 4-2) is an example of an underlay. It represents the boundaries of a plywood sheet. It also orients you to the scale of the material relative to the size of the bench and its individual parts.



	

Group the box and then move it to 000_Bench under. Now that it’s on its own layer, you’ll be able to turn it off while you work.







Don’t omit this step. Besides serving as a useful underlay, this box is ultimately used to set up the cut file (explained in Chapter 3) and will be imported into VCarve. It also serves as a reference for scaling and troubleshooting, and will be quite helpful for comparing the size of your design relative to the size of a cut sheet.





[image: dcnc 0402]
Figure 4-2. Underlay that represents a plywood sheet, used to lay out cut file




Working with SketchUp groups

It’s critical to always group and name newly created geometries. SketchUp’s interface depends upon groups to organize and maintain your model’s geometry. Ungrouped edges and faces, called loose geometry, will interfere with and merge with other edges and faces. Subsequent instructions won’t specifically tell you to group. When modifying a group, first open the group for editing by right-clicking and selecting Edit Group. See Grouping Geometry for more about handling groups.


























Massing Model and Stock Material


In the earliest stage of designing, it helps to start with rough, abstract elements, and then develop the design by gradually going into greater and greater detail. In this section, you’ll make the first move by creating a massing model—an abstracted solid model of the object you’re making—in this case, a bench.


As you first make this rudimentary, three-dimensional massing block, use your program research as a starting point. Dimensions derived from general ergonomic standards for a two-seater bench are 48″ long by 18″ deep and 18″ high (1220 mm × 450 mm × 450 mm).


You’ll also model a standard sheet of plywood, or material stock. You’ll use this stock as the source for creating every bench part. By modeling your bench parts from copies of this stock, you’ll ensure that each has a consistent material thickness.


You’ll use ¾″ as the material thickness of your stock. This is a standard nominal thickness, referred to as the variable TNOM, and used throughout this book. Chapter 5 delves into TNOM and working with sheet material thickness.

Imperial to Metric Units

For this exercise, a standard sheet of 4′ × 8′ plywood converts to the metric standard, 1220 mm × 2440 mm. The nominal ¾″ material thickness converts to 19 mm.
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Figure 4-3. Material stock alongside bench massing












Create Massing


	

Create a three-dimensional volume that’s approximately 48″ long, 18″ high, and 18″ deep, based on ergonomic standards. This is your bench massing model, it will serve as an envelope to work within as you design your bench.






Underlays are helpful references

Like the two-dimensional box you drew in the previous step, the 3D massing model is also an underlay. Both serve as references for the bench model and CNC cut sheet.



















Model Material Stock


	

Model a sheet of plywood from your cut sheet outline. Use the Push/Pull tool to make the stock a nominal thickness 4′ × 8′ × ¾″, as shown in Figure 4-3.






Push/Pull in SketchUp

To create the massing and stock material, use SketchUp’s Push/Pull tool, explained in Pushing and Pulling Shapes into 3D. As the primary modeling tool used in this exercise, it might help to practice pushing and pulling to familiarize yourself with SketchUp’s interface.




	

Group and then name your newly modeled plywood sheet. Right-click and select Group, and then enter a name in the Entity Info window’s instance field.






Groups and Layer0

Get into the habit of creating all new geometry on Layer0, by ensuring that Layer0 is active (selected). After grouping newly drawn geometries, you can move those object groups onto their respective layers. This practice keeps your model organized and will ensure that later steps in the CAD/CAM workflow go smoothly.




	

Place onto layer zzz_stock.



	

Position the modeled plywood stock adjacent to the bench massing you drew previously.







Visualize and Assess

Now that you’ve modeled the bench massing and cut sheet underlay, visualize how the bench parts might lay out onto a sheet of plywood. Juxtaposing the bench massing alongside the cut sheet underlay helps you to quickly evaluate the part sizes and anticipate grain orientation.


It’s pretty clear that no bench part will be larger than a 4′ × 8′ router bed, so you won’t need to use any end-to-end joints to scarf pieces together. It also looks like the grain will run lengthwise along the longer parts.


























Standards Versus Proportions


Good design always meets general ergonomic standards, and it also works within manufacturing methods, material limits, and other constraints. After optimizing a design for function and fabrication, you can still find ample room for creative maneuvering during the design process.


When we design, we like to introduce balanced proportions at varying scales within the object, from the overall dimensions down to the smallest joinery details. Proportions are a kind of shorthand that designers use for organizing forms. Proportions, especially those found in nature (like the golden ratio, 1:1.618), bring visual harmony into a design.


The 18” × 18” × 48” massing you just modeled meets ergonomic and fabrication criteria. Lengthening it, so it’s 18” × 18” × 54” (450 mm × 450 mm × 1350 mm) gives it a perfectly proportioned ratio of exactly 1:1:3, without interfering with ergonomic needs or fabrication constraints.










Refine Massing Dimensions


	

Pull one end of the volume, so that the length matches 54″, shown in Figure 4-4.



	

Place the volume, so that the center of its bottom face sits on the origin.



	

Group and then place the massing onto layer zzz_massing by clicking on the Entity Info window and selecting the layer from the drop-down menu. You’ll need the massing for the next step, so leave the layer turned on.








[image: dcnc 0404]
Figure 4-4. Refine bench massing proportions


























Schematic Design: Model Parts


Since the actual bench will be fabricated from ¾″ stock material, it’s sensible to use virtual sheet goods of the same thickness to create the bench parts. In this section, you’ll transition your rough massing model into a bench in its absolute simplest form—a long horizontal seat with four vertical “legs” on each side. Next, you’ll copy and modify the ¾″ thick stock, aligning it with the massing block, until you’ve created rudimentary versions of three bench parts.










Copy and Modify Stock, Form Seat


	

Make a copy of the stock. Ensure that you’re working on Layer0 and then paste the stock copy.



	

Explode the copied group by right-clicking and selecting Explode. Then re-group and name it (e.g., bench_seat) in the Entity Info box.



	

Modify (Push/Pull) the length and width dimensions to match the top surface of the 3D bench massing volume to form the bench’s seat.
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Figure 4-5. Copy and modify the stock to form the seat




	

Align the top face of modified stock with the top of massing. The part should be inside the massing block. Figure 4-5 shows one stock material copy resized to fit the top of the massing block.



	

Turn off layer zzz_stock. You can turn this layer back on, whenever you need to refer to the material stock later in the process.






















Create Bench Sides


	

Duplicate the bench seat. Rotate and move the copy to the end of the massing using the Copy/Rotate method discussed earlier (Q → ⌥ Opt ).



	

Modify the stock width/length until it covers the end of the massing (right-click and select Edit Group → Push/Pull).



	

Duplicate the side you created and Copy/Move (M → ⌥ Opt) it into position to form the other end of the bench. The massing block with the stock panels forming the seat and two sides is shown in Figure 4-6.








[image: dcnc 0406]
Figure 4-6. Copy and modify stock to form the right and left sides




When modeling parts, ensure that you only push and pull its length and width. Never modify the thickness of the material stock. It’s critical that each part of your bench maintains a consistent ¾″ nominal thickness, since you are modeling parts that will ultimately be cut from the same sheet of material.



















Add Front and Back Parts


	

Make a copy of the seat. You’ll use this copy to form the front of your bench, beginning the “boxing in” process that will create a strong structure.



	

Rotate the seat copy 90 degrees. Move it to cover the “front” of the bench.



	

Create the back by making a copy of the front. Position it opposite the front part to form the bench’s “back.”
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Figure 4-7. Copy and modify stock to form the front and back




Remember that the massing model is the dimensionally accurate “envelope” of the final bench. Place all new bench parts (that will form the actual bench) inside the envelope, aligning the top face of the seat or outside faces of the sides with the face of the envelope. That way your final bench will maintain the correct proportions defined at the beginning of this exercise.


























Using Reference Lines


With essential parts modeled and organized into the basic shape of the bench, we can now begin adding finer details to it. Let’s first lighten the bench to make it less boxy in appearance, which has the added benefit of requiring less material. We’ll achieve this by shaping the front, back, and sides to form four conventional “legs” for the bench to stand on.


In addition to the “legs,” we’ll need to shape “beams” across the top of each part. These beams will connect the legs, forming a structural frame that’s strong enough to support sitters of all kinds. In the next steps, you’ll modify these four parts into an upside down “U-shape” that will lighten your bench and maintain its structural integrity.


To model our bench legs, we first need to determine a dimension that is great enough to offer structural support, while preserving our preference for lightness. We’ll choose 4″ (100mm) for both beam depth and leg width, so the entire U-shape is a consistent width. Before you begin modifying the parts, it will help to draw a series of temporary reference lines, which will allow you to model with precision, consistency, and efficiency (Figure 4-8). Later in this exercise, you will use reference lines as you model joinery on every part.
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Figure 4-8. Reference lines for beams and legs












Form Legs
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Figure 4-9. Beams and legs formed on the front and side




	

Define a dimension for the beam depth and leg width. We’ll choose 4″.



	

Sketch a horizontal reference line along the top outer edge of the front part. move it down 4″ (100mm), keeping the line aligned with the outside vertical face of the part. Similarly, draw a line along the top of a side part, moving it down by the same distance. These two reference lines form what is called a datum, a benchmark that you can use to align or locate other design elements.



	

Draw vertical reference lines along each outer edge of both the front part and one side part. Move these lines 4″ (100 mm) toward the center, keeping them aligned with the outer face. Your model should look like Figure 4-8.







	

Form the front piece into a “U-Shape,” using your vertical and horizontal reference lines for alignment. Select the front, Edit Group, and then use the Push/Pull tool to form the empty void. Exit the group.



	

Make the side piece into a “U-Shape,” using the reference lines for the side piece. Your model should now match Figure 4-9.



	

Copy the front and side parts, and replace the back and second side with copies.





























Modeling Feet


Because we’d like our bench to hold up on a variety of flooring conditions, we will add “feet” for extra reinforcement. In addition to protecting the bottom of your bench (as well as the floor) and improving durability, feet are also a critical structural assembly. By joining the long and short sides, they provide extra stability and keep your bench’s structural frame rigid.
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Figure 4-10. Bench with temporary and underlay layers turned off












Form Feet


	

Make one last copy of the stock material and modify it to create a small rectangular “foot.”



	

Place the stock copy under one of the bench’s legs, intersecting it with the corner where the long and short sides meet. Just like the sides, seat, and beam, the foot edges pass through the leg in an impossible way.



	

Make three additonal foot copies, placing each under the other three legs. Figure 4-11 shows the bench with rough feet added to the model.
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Figure 4-11. Model the first foot


























Evaluate and Analyze


Now that all of the bench parts are well defined, it’s a good time to analyze your design in its rudimentary state before going into further detail. Step back to look at your model with fresh eyes. Clear your workspace a bit, so you can get a better view.


Now that you’ve created your bench parts, you no longer need to reference the massing and stock material, and you can hide them from view. With each placed on its respective layer, zzz_stock and zzz_massing, you can hide both objects (and easily show them later, if needed).










Scale


Use a scale figure to gauge the size and proportions of your design. After working intensively in any 3D CAD environment, your project can feel rather scale-less. A scale figure is an easy way to give some context.


Upon opening a new SketchUp file, you’ll find a default scale figure. Putting this figure onto its own layer (e.g., zzz_sophie) allows it to be easily turned on and off for reference. You can download one from SketchUp’s 3D Warehouse model repository.

















Iteration


Design is a back-and-forth process between art and engineering. Good design manages to integrate both. As you develop a design in greater detail, it’s essential to continually incorporate this process of stepping back to analyze so that you can improve your design along the way. This cycle of continual improvement is called iteration.


Earlier, we walked you through the process of evaluating the bench massing and adjusting its proportions to 1:1:3. Examine the form of the beam and legs relative to the overall bench proportions. Does frame depth or leg width make the bench feel too light, too long, or too heavy? Does the bench seem sized appropriately to accommodate the scale figure? We won’t make adjustments as part of this exercise, but now would be a good time in the process to do so if you decide to go that route.
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Figure 4-12. The iterative process


























Evaluate and Refine Structure


Now, look over the model again, this time with an eye on structure. The legs, beams, and seat form a structural frame that resists the gravity loads when people are seated. As people sit down on and get up from the bench, they also put dynamic, lateral forces onto the bench structure. The seat forms a diaphragm within the frame, keeping the bench square and rigid as people take a seat. The four feet prevent the legs from splaying outward, giving the bench enough strength to support those who are seated.


In examining the overall proportions, beam depth, and leg dimensions, we see that the bench might benefit from a bit of structural reinforcement. To give our structural frame additional strength, we will add an extra beam along the center of the bench. Adding this beam allows the seat to act like a torsion box, which helps the seat to handle a long span and to keep the bench rigid.










Add a Center Beam


	

Copy the front part; then move it toward the center of the bench and align its top midpoint with the center of the seat.



	

Delete the legs; they’re unnecessary—we’ll leave only the beam that locks into the side parts. Figure 4-13 shows the bench with the center beam added.
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Figure 4-13. Copy and modify the front piece to form a center beam


























Organize with Components


The process of determining and applying a program, developing a massing model, and roughing out the parts of your bench is called schematic design. You’ve solved a series of design problems in a specific and thoughtful way, and now you’re ready to commit to your design decisions. In the next steps, you’ll convert your bench parts into SketchUp components and configure them for designing simultaneously in two and three dimensions.


Components create extra organizational steps, but help to streamline the design process and your workflow. They allow you to edit and visualize a part simultaneously in 2D and 3D, and to manage duplicate parts and elements in a design. Give your components short, simple, easily recognizable names—imagine that you’ll ultimately want to share your file with someone, and you want to make it as easy as possible for them to pick up where you left off.


Take a minute to step back and count the unique parts in the bench. Is there an opportunity to minimize errors and adjust the design by replacing duplicate parts with components? Yes! While the bench is made of eleven pieces, it only has five unique parts. The four feet are identical, as are the two side parts and the front and back parts. These part types, combined with the seat and the beam, comprise the five unique parts shown in Figure 4-14. By turning each unique part into a component, you’ll only have to edit one part, and any changes or modification to that part will take place across all of them. Next, you’ll make unique parts into components (refer back to the steps outlined in “Components” in Chapter 3).
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Figure 4-14. Eliminate duplicate parts












Define Components


	

Make a copy of all ten bench parts and paste them onto layer 000_Bench model.



	

Turn Layer0 off. Your bench parts and material stock should still be visible.



	

Delete all duplicate parts. Make sure that you move to layer 000_Bench model first and delete the parts on that layer.



	

Make each unique part into a component, by selecting the part and then right-clicking and clicking Make Component.



	
Name the components:



	
000_Bench Beam



	
000_Bench Front



	
000_Bench Side



	
000_Bench Foot



	
000_Bench Seat











	
Your five new components should appear in the component palette, matching Figure 4-15.



	

Rebuild your 3D model with the bench components. It should look like the bench in Figure 4-16.
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Figure 4-15. Newly created components in the Components palette



















Flatten Model, Layout Parts


In anticipation of developing toolpaths, copy your bench components and lay them out onto a virtual cut sheet. As component copies, these “flat” parts will automatically update along with the evolution of your design.


	
Turn the underlay layer (000_Bench under) back on. You’ll need to use the 2D stock material boundry to layout your parts for machining.



	
Copy the entire model and paste it onto the flatten layer, 000_Bench flat (Figure 3-4).



	
Rotate each individual part down onto the stock outline, aligning the bottom face of each part to the plane of the outline.



	
As you place parts within the cut sheet boundary, match the flattened lay out shown alongside the rebuilt model in Figure 4-16.



	
The layout in Figure 4-16 keeps outside faces of the bench facing upward, leaves adequate space between parts, and rotates long parts so that they nest into one another. For a comprehensive explanation of these and many other factors to consider when you lay out parts, refer back to “Flattening and Layout”.
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Figure 4-16. Rebuild model with defined components


























Design Development: Joinery


With parts defined, converted into components, and organized into both 3D model and the 2D cut sheet, you’re ready to move into the smaller scale of detail. While the phase you just completed is called schematic design, the next phase, where you will be designing joinery, is referred to as design development.


Thus far, you have modeled parts to “pass-through” one another in an impossible way. Early in the design process, it is sufficient to sketch things in this way, so you can work through the larger scale issues of your design. Now that you’ve resolved the larger issues, you can move onto the details, like composing slots, tabs, and joinery at these points of overlap.


Chapter 2 explains how joints create an interdependency between furniture parts, which improves the structural stability of the bench by distributing loads and forces evenly. To gain the advantages of joinery, it’s critical to distribute joinery in the right places and to properly position, orient, and size joints to maximize contact between parts.


Take a look at your bench and identify the distinct conditions where parts converge and where joinery should go. Start thinking about what kind of joinery assemblies might be most appropiate for each intersection (refer back to “Eight Basic CNC Joint Conditions”).


This section takes you through modeling a series of common joints for the bench. To keep things simple, we’ll stick to mostly edge-to-edge joints (also described as lazy fingers) for joining the seat to the legs, the legs to the feet, and the legs to one another. For the cross beam that interlocks with the seat and sides, you’ll model end-to-face and end-to-face-to-edge joints. In the process of forming all of the bench joinery, you’ll produce a corner assembly, tab assembly, hanger assembly, and foot assembly. Let’s get started by organizing the bench’s many slots and tabs.










Joinery Organization


Finding some kind of order helps you properly locate and distribute joints, and it facilitates component repeatability.
To give some order to the bench joinery, we will orient details symmetrically, work with standard sizes, and keep all joints consistently aligned to reference lines. A clear, consistent ordering system like this will coordinate our joinery placement with the proportions of the overall bench, so joinery and parts form a harmonious composition with the object overall.


Before jumping into the steps of modeling joinery, it helps to first draw multiple reference lines on Layer0. A datum and center line assist you in precisely locating and aligning slots and tabs. We will follow a process similar to the one used to make guidelines for forming the U-shaped bench legs.


In addition to working with reference lines, it helps to find opportunities for consistency. It will simplify things, for instance, to make all tabs and slots one size that matches the 4″ (100 mm) dimension of the beam and legs. We can always make adjustments later, but 4″ (100 mm) is a good starting point that will be easy to manage while modeling the various details.

Imperial to Metric Units

These next steps will model 4″-long joinery slots and tabs, which are ¾″ × ¾″ to match the nominal material thickness. If you’re working in metric units, these slots and tabs are 100 mm × 19 mm × 19 mm.



















Draw Seat Reference Lines


	

Sketch two reference lines along the top of the beam. Sketch a third parallel line and center it between them. This is your centerline.



	

Make two copies of this centerline, moving the first 2″ toward the front of the seat and the other 2″ toward the back.



	

Sketch a line perpendicular to the beam, connecting front and back midpoints of the seat. This is the centerline in the short direction.



	

Make two copies of this line, moving the first 2″ toward the left end of the seat and the other 2″ toward the right end.







	

Draw a line along the top end of the seat and move each 4″ toward the center of the bench. Then repeat this step at the other end.



	
Your bench should now look like Figure 4-17.







By snapping to midpoints and endpoints of your model, you can quickly draw reference lines. Use the measuring tool to confirm the distance between guidelines and parts of the model.
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Figure 4-17. Bench with reference lines overlayed onto the seat



















Draw Sides Reference Lines


In these next steps, you’ll draw reference lines to organize the joinery on all sides of your bench.


	

Draw a line along the front of the seat and move it down to the midpoint of the legs. Being on the midpoint, this line will be 9″ (225 mm) from both the top of the seat and the floor.



	

Copy this reference line and move it up 2″. Make a second copy and move it down 2″.



	

Draw a vertical reference line between the top midpoint of the front and ground.



	

Copy this vertical line and move it 2″ toward the left side. Make a second copy and move it 2″ toward the right side.



	

Draw a vertical line from the top midpoint of the side. Copy this vertical line and move it 2″ toward the front. Make a second copy and move it 2″ toward the back.







Modeling in both 2D and 3D

As you work with components, you’ll see parts update on the cut sheet and in the model. This allows you to work on whatever part, or view, is easiest. Sometimes, it makes more sense to work directly on the 3D model so that you can see where the parts and joinery align and need to correspond, while at other times it’s easier to work on the flattened part directly.


Work however best suits your needs. Occasionally, you may find that you need to move a part out of the way to get at another part. The SketchUp inference engine makes it easy to move parts back into alignment.





[image: dcnc 0418]
Figure 4-18. Guidelines overlayed onto the front and side




Different Modes of Thinking—Don’t Get Stuck!

In the process of designing a project, you will find yourself moving through different kinds of thinking. As you work through the design process, it is useful to become aware of how your mindset shifts over the course of working on your project.


Sometimes, you are trying to imagine or invent a thing that doesn’t yet exist; other times, you might be modifying a part, but finding that it’s not yet as it should be. Occasionally, you’ll have to resolve a design to handle structural criteria, material efficiency, and ergonomics. Then at other times, you may have to incorporate new, unanticipated requirements into the design.


During the process, you might also find yourself carrying out rudimentary drawing tasks, in order to thoroughly implement an idea across the entire design. Similarly, you might also run into repetitive and possibly mundane efforts, like keeping your layering conventions straight or organizing components.


Alternating between different tasks and kinds of thinking can be an advantage for the creative process. If you’re frustrated by a challenging problem to solve, give the problem-solving part of your brain a rest and instead spend time working on repetitive tasks. Alternating the kinds of thinking can be restful or rejuvenating so that you can approach broader design negotiations with a “full well.”


By alternating kinds of thinking with your mood and energy levels, you’ll never get stuck or blocked.



Gary Rohrbacher
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Make Joinery


This next section walks you through the process of modeling the joinery, by using the reference lines you just drew. Going part by part, you’ll get started on making a corner assembly, and what will eventually become a tab assembly.  You’ll start with the simple task of adding slots in the seat, and follow up by modeling both slots and tabs in the front, back, and side parts. The section will then walk you through the slightly more complex task of modeling a hanger assembly and foot assembly, which involve joining together three parts.










Create Seat Slots


The seat has five slots. You’ll first model its four perimeter slots, each at the midpoint. Then you’ll start on the tab assembly by modeling a fifth slot centered exactly in the middle of the seat.
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Figure 4-19. Push slots into the sides and top of seat




To form each perimeter slot, you’ll start by drawing small, precise construction lines outside the component, by snapping to the guidelines and to the model parts themselves. These construction lines help you accurately form the surfaces from which you use SketchUp’s Push/Pull tool to shape the slots.


	

Draw two vertical construction lines at one end of the seat, by using the guidelines as a reference. Each construction line should be ¾″ (19 mm) tall and spaced 4″ (100 mm) apart. See the left-hand side illustration in Figure 4-19. Select all construction lines and go to Edit→Cut.



	

Fully select the seat component three mouse clicks are required to select and edit the component, and Edit→Paste the construction lines into it.







Always draw construction lines outside of the component; then cut and paste them into the component when it’s selected for editing. Drawing construction lines directly inside the component can cause the lines to interfere with geometries. This process of drawing, cutting, editing, and pasting becomes automatic after you do it a few times.




	

Form a 4″ × ¾″ slot at the end of the seat, using the Push/Pull tool. Push the rectangle ¾″ into the seat edge. The resulting slot should be 4″ × ¾″ × ¾″.



	

Create an identical slot on the opposite end of the seat.



	

Create 4″ × ¾″ slots on front and back seat edges. Exit the component, and using guidelines, locate two vertical construction lines at the middle of the front edge. Cut and paste the construction lines into the component.



	

Push a 4″ × ¾″ × ¾″ slot into the front edge, using the Push/Pull tool. Repeat these steps to create an identical slot on the back edge of the seat.



	

Double-check length and width with the Measure tool. It’s especially important that your perimeter slot width aligns with the ¾″ thickness of the adjacent part.







Measure as you go, after making slots (and tabs). Use the measure tool to check that faces align, and that you modeled the length and width precisely.




	

Create two horizontal construction lines in the seat center. Exit the component and draw using the guidelines and the beam as your reference. These construction lines will be ¾″ tall and 4″ apart, as seen on the right in Figure 4-19. Cut and paste the construction lines back into the component.



	

Make the center slot in the seat, using the Push/Pull tool to push the 4″ × ¾″ rectangle all the way through the seat.



	

Exit the seat component.
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Figure 4-20. Seat with slots in sides and top



















Make Joinery on Front


In this section, you’ll form slots and tabs to create the end-to-end joints that comprise the corner assembly, connecting the front, back, and sides. In these steps, you will apply the same techniques of drawing construction lines to help accurately define surfaces that you will then push/pull into tabs and slots.
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Figure 4-21. Front with three new tabs




	

Draw construction lines on the top edge and two side edges of the front component, using the guidelines as well as the slot you just modeled on the seat front as a reference. Select all construction lines and select Edit→Cut.



	

Fully select the front component three mouse clicks are required to select and edit the component. Edit→Paste the construction lines into place.







Use previously modeled slots and tabs as references to assist you in drawing construction lines and for pushing/pulling corresponding slots and tabs into alignment.




	

Using the Push/Pull tool, push either end of the top edge down so that these edges align with the bottom face of the seat. This leaves a 4″ × ¾″ × ¾″ tab at the middle that fits the front seat slot.



	

Form a tab on the side of leg by using the Push/Pull tool. Push the surfaces above and below each side tab, leaving a 4″ × ¾″ × ¾″ tab centered on the edge of the leg. Repeat on the other end of the part.



	

Exit the front component. The front part should have three tabs, as illustrated in Figure 4-21. Notice that the back part will automatically update.






















Make Joinery on Sides


	

Draw construction lines on the top and both side edges of a side component. You can use the slots modeled on the seat and the front/back as reference. Select all construction lines and go to Edit→Cut.



	

Fully select a side component—three mouse clicks are required to select and edit the component. Edit→Paste all construction lines into place.



	

Form the top, center tab, using the Push/Pull tool to push either side of the edge down. Leave a 4″ × ¾″ × ¾″ tab that fits the slot in the middle of the seat edge.



	

Form a 4″ × ¾″ × ¾″ side slot into the edge of the side leg. This slot corresponds to the tab on the front leg. Repeat on the other leg. The side part should now have a tab on the top and slots on either side, as shown in Figure 4-22. Notice that the other side part automatically updates.
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Figure 4-22. Side with slots on legs and tab on top




The Power of Components

As you go through the process of modeling the side part, you’ll quickly understand the power of components. When modifying one component, SketchUp automatically updates your changes in all other instances (including copies of your component flattened on the cut sheet). Not only do components spare you the tedious work of modifying every single joint in the bench, they also allow you to see that you are consistenly connecting each and every part.



















Make Hanger Assembly


Forming a hanger assembly requires the same techniques used previously, this time to modify three parts, the beam, side, and seat. While it seems like a complex intersection of parts, they are easily shaped if you go part by part and draw construction lines to form the Push/Pull surfaces. Use the guidelines, as well as previously drawn slots, to help you locate construction lines accurately.
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Figure 4-23. Push into top of beam, to form center and end tab




	

Draw a horizontal construction line 4′ across the top end of the beam. Draw a second construction line where the end of the seat slot intersects the beam. Select all construction lines and select Edit→Cut.



	

Select the beam component. Paste the construction lines into the component. Using the Push/Pull tool, push the surface between both lines ¾″ down, as shown in Figure 4-23.



	

Repeat on the other end of the beam. This leaves a 4″ × ¾″ × ¾″ tab at the middle that fits the center slot of the seat.



	

Draw a horizontal construction line at the midpoint on the end of the beam. Cut/Paste it into the component. Using the Push/Pull tool, push the surface below the construction line ¾″ into the beam. This leaves a tab at the top half of the beam. See far left illustration in Figure 4-24. Repeat this on the other side of the beam.



	

Exit the beam component.



	

Create a slot for the newly formed beam tab. Use the beam tab to locate a construction line. See far right illustration in Figure 4-24.



	

Select the side component. Paste the construction line into the component and push the corresponding slot through the side.



	

Exit the side component.



	

Create a slot in the seat for the top beam tab. Use the beam tab to locate a construction line in the seat. Select the construction line and go to Edit→Cut.



	

Select the seat component. Paste the construction line in place on top of the beam tab and push the corresponding slot into the seat. Repeat at the opposite end of the seat.



	

Exit the seat component. The beam, side, and seat parts should look like the parts shown in Figure 4-25.



	

Delete all guidelines (or move them onto 000_Bench under).
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Figure 4-24. Push end of beam to form hanger; push corresponding slot on side
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Figure 4-25. Exploded view of complete hanger assembly



















Form Foot Assembly


Similar to the hanger, forming a foot assembly involves modifying three parts: the front, side, and foot. This exercise starts with shaping the triangular chamfer in the foot and then goes part by part to form the joinery that connects the foot to the base of the legs. As you work your way around parts, rotating the 3D view will help you to better see and select surfaces.
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Figure 4-26. Push to remove triangle shape from square foot




	

Rotate the view, so you can see the inside of the leg assembly.



	

Draw a diagonal construction line at the intersection between the foot and each leg. Select this line and go to Edit→Cut.



	

Remove the inside triangular corner. Fully select the foot component and Edit→Paste this construction line into the component. Using the Push/Pull tool, push down to remove a triangular shape from the foot, as shown in Figure 4-26.



	

Exit the foot component.


Now that you’ve given the foot a direction, check your 3D model.  You may need to rotate your other foot component copies so that they properly align with each leg.





	

Rotate the view, so the outside of the leg and foot is visible.



	

Locate the tabs on feet and legs. Draw a vertical construction line on the midpoint of each outside face of the foot.



	

Form the joinery between the foot and legs, as shown in Figure 4-27. Starting with the foot, use the Push/Pull tool to push slots into the foot.



	

Make tabs at the base of the legs, starting with the side leg and then front leg. Make matching slots on opposite legs of each part.
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Figure 4-27. Shape end-to-end-to-end joint


























Analyze Bench Joinery


After adding so many small details into the design, step back, zoom out, and examine the logic and effects of your joinery. Evaluate whether the direction, location, and proportion of all joints support the bench’s hierarchy of function, as well as its process of assembly.


For instance, part overlaps should accommodate seated individuals, who will have the most contact with the top and front of the bench. In the design, you’ll see that most of the seat covers the front edge, with small tabs pushed toward the center and ends. The seat surface is continuous where two individuals are most likely to sit. In addition, joinery adds a nice detail to the middle of the seat and suggests a subtle boundary between two seated individuals.


Another issue to analyze at this point is constructability. It’s entirely possible to design a piece of furniture in a CAD model that is physically impossible to assemble in real life. Consider the process of assembly as you design parts and locate joinery. In the case of the bench, it’s easy to envision a straightforward sequence of assembly that forms a frame with the four sides, places the beam and seat on top, and the feet on the bottom.










Evaluate Joints


In these next steps, you’ll circle back through your model and organize the parts to prepare for the next steps.
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Figure 4-28. Bench with all joinery




	

Turn on 000_Bench flat to review your 2D sheet layout parts alongside the parts in their 3D configuration.



	

Look at the 2D sheet layout and confirm that there is adequate spacing between components, especially after tabs have been introduced.



	

Check that components in the 3D model haven’t shifted out of place and also look over all of your joinery to ensure that tabs align with slots and faces. If any faces or components are out of place, modify the component to bring it or its faces into alignment with adjacent parts.





























Design Refinement


Now that you’ve developed a design that integrates function with structures and joinery assemblies, material and fabrication, and construction feasibility, it’s time to analyze the bench as an overall design. Good design emerges when all of these issues are successfully interrelated. However, it’s only at this point in the process when you’re fully acquainted with all of the issues that you have the ability to handle them simultaneously. This is the point in the process when good design happens. In the next section, you’ll walk through the steps to analyze and highlight opportunities to make overall adjustments to the design.










Evaluate the Overall Design


	

Examine overall bench proportions. Now that all the details have been added, do the elongated proportions complement the grain direction? Or should parts be rotated on the sheet?



	

Consider individual part proportions that allow all parts to share a common proportional language that complements the whole. Adjust beam depths or leg widths to make them consistent. Modify the overall bench dimensions if it makes sense.



	

Coordinate all joinery so that it enhances the overall object. Do all tabs share a consistent size? Do similar joinery conditions use similar joinery? Can a slot and tab be resized or relocated, or might new tabs be added or subtracted?



	

Look for overall design improvement. Consider whether you can do less with more. Determine whether every design decision relates everything to everything, with every shape working ergonomically, structurally, aesthetically, and for fabrication and assembly.







As you improve and iterate on the design, explore options on your sketch layer, Layer0. Copy components to this layer and make them unique. This way you can test ideas, while preserving your original design.


























Sniglets and Fasteners


After finalizing the overall design, you’re ready to introduce the finer details like sniglets and fasteners. You have already read about fillets and sniglets in Chapter 2. This exercise walks you through the steps of how to implement them in a design. The next steps will also show you how to incorporate other details into a design, like holes that accommodate fasteners.


It’s quite useful to make sniglet and hole components that you can copy, place, and rotate as required throughout the model. Using one “master” reduces the number of mistakes and the enormous time and tediousness involved in drawing each separately. For holes, you can make a master hole that fits a particular fastener. By using components, you can later adjust its diameter if you decide to introduce another size of fastener. In these next steps, you’ll make a master sniglet and master hole to use in your project.










Draw Sniglet and Hole Components


	

Draw a master sniglet on Layer0 by following the instructions in “Exercise: How to Draw Fillets”. Assume a 5/16” (8mm) diameter that works with a typical ¼″ end mill for our ¾″ sheet material.



	

Select all segments. Then make the sniglet into a component. Name the component sniglet 8mm.



	

For the fastener hole, draw a 2D circle on Layer0 to accommodate our anticipated fastener size. We’ll use a ¼″ (6mm) diameter circle to accommodate common hardware.



	

Select the circle and make it into a component. Then name it circle 6mm.
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Figure 4-29. Sniglet and hole components




When naming components that you might want to import into other projects, add dimensional information to the component name. You’ll always know the size of the circle or sniglet at first glance, without having to measure the geometry.



















Model Sniglets


Sniglets go into every interior corner, to eliminate corner material and to accommodate flush-fitting joinery. While some CAM programs (like VCarve Pro) have utilities you can use to add dogbone or T-bone fillets to your design, this extra step allows you a bit more control. You can pay more attention to the actual corner detail profile, while also thoroughly considering its exact direction and placement in the overall design.
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Figure 4-30. Locate sniglet profiles and then form into 3D




	

Working on a 2D flattened part, place a sniglet at every inside corner. Be sure to work outside the component itself as you place and arrange sniglets.



	

Select the collection of sniglet components and go to Edit→Cut.



	

Select and Edit the part component. Edit→Paste the sniglet collection and explode the individual sniglet components.







	

Using the Push/Pull tool, push the sniglet shape into and through the part.



	

Exit the part component and repeat until all parts have sniglets on every inside corner.







It’s usually more convenient to work on the 2D parts as you introduce sniglets and holes, especially in those cases where access to the part is limited. When you want to work on parts configured in 3D, it’s helpful to use transparency view options as much as possible, so you can clearly understand parts. It can also help to isolate or temporarily move components in 3D to work on them.
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Figure 4-31. Finished sniglets on the bench seat
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Figure 4-32. Bench parts with sniglets



















Model Holes


To ensure a fastener securely attaches two parts together, center holes so that they are in the middle of a tab and in the middle of the material thickness, as shown in the far left in Figure 4-33. Working in the 2D parts layout, draw temporary reference lines to assist you in accurately placing all fastener holes.
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Figure 4-33. Locate and make holes




	

Working with one 2D part at a time, draw reference lines to help you center holes in the middle of each tab.



	

Select a hole component and center the hole at the intersection of the reference lines. Be sure to work outside of the part component, as you place the holes component. See the center illustration in Figure 4-33.



	

Select the collection of hole components for a single part and go to Edit→Cut.



	

Fully select and edit the part component, place holes, and explode them.



	

Using the Push/Pull tool, push the hole shape into and all the way through the part, as seen in the far right of Figure 4-33.



	

Exit the component and repeat until all the parts have holes.



	

Delete the guidelines.


Sometimes it isn’t possible to fit a fastener into tight spots, like in between tabs in the hanger and foot assemblies. Since the fasteners only need to assist the joinery in holding parts together, you can omit any fastener hole that seems to crowd the joinery.









A 3/16” diameter hole requires an 1/8” endmill to cut it. By making the hole a component, you’ll be able to adjust its diameter to match any end mill or fastener that you want to introduce.


























Visualize and Simulate


3D modeling software isn’t just for building a model. By allowing you to quickly and accurately visualize your design, it can be quite generative in the design process. Being able to see the thing you are working on from different angles on the screen allows you to analyze and develop a model further. You can quickly flip the model around from front to back and bottom to top. You can evaluate proportions in flat, orthogonal views. You can verify that all fasteners and sniglets are properly placed. And you can even compare your design to a scale figure.


SketchUp, like most CAD software, allows you to toggle between different visualization modes. Sometimes it helps to see all lines at once in wireframe, or to focus on profiles in hidden line, or to examine only planes and volumes in surface render. When you reach a stopping point in modeling, running through these different visualization modes can prove quite helpful in evaluating your design.


Going further, you may find it valuable to actually add texture maps to the parts of a 3D model. This visualization helps you evaluate the grain direction and consider different materials relative to the design. Texture maps also allow you to see the contrast of edges and joints relative to the overall design.


Beyond the modeling program, rendering software can take simulation a great step beyond. You can use rendering software to thoroughly study the materiality and overall effects of your design in an environment. You can study your model relative to light, reflection, and shadow, and you can see the effects of accurate materials. The renderings throughout this book were generated using Maxwell Render, a software platform we use to document and communicate AtFAB as well as our other projects.
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Figure 4-34. Render the model to evaluate the grain direction and details














Part II. Virtual Meets Physical



The following chapters provide an introduction to materials, prototyping, CAM setup, and machining basics. We’ll walk through the essential steps of transforming a digital CAD drawing into a perfectly crafted piece of furniture.





Chapter 5. Precision-Fit Plywood Joinery



In many ways, plywood can be the perfect material for your CNC projects. As a natural material with an inconsistent thickness, however, it can also be challenging to work with. As enticing as it is to jump right into cutting a CNC project, digital craft results from understanding material properties and taking time to prepare. Perfectly executed plywood joinery does not happen on its own. However, by carefully measuring your plywood, adjusting your CAD files, and then testing to make sure that you’ve got everything right, your job will go smoothly and yield perfect results.








Plywood


Plywood is a nearly ideal material for CNC fabricated furniture. It’s available in big sheets and comes in a multitude of styles and species. Plywood is easy to find, and it’s relatively inexpensive compared to other materials. It can span large distances, but can be flexible if needed. It can be left plain or covered with paint, clear coatings, veneers, laminates, solid wood, and other finishes. It can be easily glued or joined with mechanical fasteners.


Plywood’s advantageous properties stem from its composite, manfactured origin. Plywood is an engineered material comprised of numerous layers, or plies, that are stacked and glued together into large sheets. Within a sheet, each ply grain is rotated 90 degrees to form an especially strong material. This process gives plywood an excellent strength-to-weight ratio. Parts cut from an especially heavy material may sag under their own weight. Similarly, parts cut from a weak material may buckle under if carrying heavy loads. Furniture parts cut from plywood, however, won’t usually have this problem.


A sheet’s faces are the large exposed top and bottom layers, while the thin edge surfaces show the cross-section of plies, appearing “striped.” CNC profile cutting exposes these striped edges, providing an opportunity for furniture designs to express them in joinery details.










Selecting Materials


Your choice of plywood type can radically transform a design. A table made from raw sheathing, for instance, looks very different from the same design cut from refined, prefinished veneer plywood.


Plywood is marketed and priced to feature the face veneer, but to ensure clean CNC joints, the core is equally important. Checks, voids, and gaps on the interior plies will yield unsightly and possibly compromised joints, so it’s best to avoid lower graded plywoods that usually have these flaws. Avoid plywood or other material that has excessive camber or warping, since sheet materials that do not lie flat on the CNC bed will result in imprecisely cut parts.
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Figure 5-1. Cross section of three plywood types




Face Veneer Grades

Manufacturers typically produce plywoods with a front and back, which makes sense for cabinetry and finish paneling. As a result, you’ll find that most plywood has one side with a higher grade of veneer, and another side with a lesser quality veneer.


Face veneers are assigned a letter grade: A is the best quality and D is the worst. These faces are indicated by letter pairings like A/B (desirable) or C/D (terrible).
When working with plywood sheets that have different quality faces, you’ll need to pay extra attention when placing the material onto the machine bed to ensure that the best quality face ultimately ends up on the most visible, prominent side of your furniture. See “Cut Pockets on the Correct Side” for tips.




	Construction Grade

	
Also referred to as softwood plywood, these sheets consist of 3–7 plies made from conifers like pine, cedar, or spruce, and are used as residential sheathing or flooring underlayers. It’s the cheapest plywood type, typically not very attractive, and often contains defects. If you’re on a budget, seek out products that have sanded finishes, without warping, knots, checks, and voids.



	Cabinet Grade

	
Also called hardwood plywood and intended for cabinetry or other visible applications, these sheets have thin hardwood veneers and 7–9 softwood or composite interior plies. They are more expensive than construction-grade plywoods, but typically have far less warping, knots, checks, and voids, making them the ideal starter material for CNC-fabricated furniture.


The term “hardwood plywood” refers to the type or species of wood used, such as maple, birch, or oak. It is also frequently used to indicate an “attractive veneer.” If a top-quality softwood veneer such as cedar or knotty pine is used, that sheet is still called hardwood plywood.



	Architectural Grade

	
The highest end plywoods are comprised of 9–15 very thin, typically Baltic birch, veneer plies. Often called multiplex, such products are undoubtedly the ideal material for fine CNC furniture, and at double the cost of cabinet grade, they are also the most expensive. The thin plies, however, offer durable, refined edges. There are numerous options for unfinished and prefinished hardwood face veneers and laminates.




























Nominal Thickness


Here’s where the real complication comes in: plywood is almost never as thick as labeled and described. Lumber dimensions have nominal thickness, which differs from actual thickness. Like 2×4s that are never really 2″x4″ (they’re closer to 1.5in x 3.5in), three-quarter-inch plywood is rarely actually ¾″ thick. Sheet goods are almost always thinner than specified, but not consistently so. A sheet of ¾″ Douglas fir plywood is almost never the same thickness as a sheet of ¾″ Baltic birch. And a sheet of ¾″ Baltic birch from one mill may not be the same thickness as a sheet from a different mill.


In addition, wood in general is a “living” material and can change dimensions based on temperature, humidity, and manufacturing techniques. Plywood from a particular mill may vary between batches, and even the sheets within a bundle of plywood can vary from the top to the bottom and from day to day because of environmental changes. It can even vary within an individual sheet—a sheet in the middle of a stack will generally gain and lose moisture in the edges but not on the faces.


For projects where pieces need to fit together accurately for aesthetics and/or strength, not knowing the precise thickness of your material poses a challenge. However, if you select your materials by choosing clear, flat sheets and measuring to find ones that have some dimensional consistency, you can manage the rest of the process. In later steps, you can treat material thickness as a fundamental variable that you need to plug into a very basic “measuring and scaling” equation.

Metric Versus Imperial

Like socket and wrench sets, plywood is manfactured in both Metric and Imperial sizes—and just like those tool sets, the approximations can be “close,” but are not necessarily equivalent.




We’ve put together a list of tested and recommended materials and additional sourcing information in Appendix B.












Calipers


Calipers, shown in Figure 5-2, are an essential tool for accurately gauging material thickness. Calipers measure the distance between two surfaces: either between the outside surfaces of a material (large bottom jaws) or the inside surfaces of an opening (small top jaws). While tape measures and rulers are helpful with larger dimensions, calipers offer more precise measurements, particularly with smaller items. These days, most calipers found in a shop are digital, and they are capable of measuring to at least a thousandth of an inch.



[image: dcnc 0502]
Figure 5-2. Measuring material with digital calipers




	Measure Before You Buy

	
Always bring calipers (Figure 5-2) when you shop for materials; you’ll need to measure the thickness of different plywood grades and sheets before you buy.






Plywood sheet thickness can vary from batch to batch, sheet to sheet—and even within each sheet itself. To ensure that the materials you’re buying have an aproximate matching thickness, take some base measurments and use them to help make your selections.


Most of the projects in this book use more than one sheet; the Cellular Screen in Chapter 16 uses seven. When you’re working on multiple-sheet projects, try to find some consistency across all sheets.


Even if you’re only buying a single sheet at a lumber yard or big box store, get your money’s worth and avoid project pain. Large sheets of plywood that you can barely maneuver yourself may seem like difficult items to inspect for warping, voids, and face quality—but you’ll regret it if you don’t. Remember that they want to sell you wood. It’s not exactly cheap, and you should be picky. Just start going through a pallet; employees always show up to help.


Once you have a sheet off the rack or out of the pile, turn it on its long edge and look down the length to ensure that it’s not too badly warped. Warped material is harder to hold down, doesn’t machine well, and can lead to broken tooling.
























How to Digitally Dial In Joinery Fit


The key part of digital craftsmanship is matching your digital CAD file to your physical material. Now that we’ve explained the inherent dimensional variation of actual sheet materials, let’s shift our focus to the virtual side of the process.










Designed for 19mm Plywood


Designers model a project using a virtual material thickness that is approximate to real sheet material stock. Since it is a general approximation, material dimensions in a digital CAD file will likely differ from real materials, because of the variability we explain earlier. Nominal thickness in design files, or TNOM, is an assumption, not an exact measurement. To model the two-seater bench in Chapter 4, you had to assume a sheet material thickness of 19mm. Each AtFAB project in this book was modeled with sheet material in these assumed thicknesses. The interconnected joinery in the cut files derived from those 3D models will only fit together if machined from plywood with an identical thickness.


Dialing in your joinery fit requires a few methodical steps, so the nominal material in a CAD file matches the actual material you have on hand.


Because of plywood’s uncertain actual thickness, it’s critical to thoroughly measure your material. Once you know your material’s physical properties, you can then calculate the difference between the actual and virtual material thickness, and adjust the CAD file to match the actual material.


TNOM in CAD

Nominal thickness is an assumption made by a designer; it’s the thickness of the material used to model a CAD design. For most of the AtFAB CAD files and the projects in this book, TNOM is equal to 19mm (or 0.748031”).


There are a small number of projects that use thinner materials. The Cellular Screen (Chapter 16) is made from nominal 12.7mm, or ½″ material. The Open Storage Cabinet (Chapter 14) incorporates 12.7mm (½″) and 5mm (roughly ¼″ or 0.19685”) thick material for its shelves and dividers. While the Poke Credenza (Chapter 15), employs 5mm (roughly ¼″ or 0.19685) for its sliding doors.




You might recall in Chapter 2, AtFAB designs use sniglets that are 110% of the actual end-mill diameter size to accommodate downward file scaling. This additional percentage ensures your sniglets won’t be too small for the end-mill, if you reduce the file’s scale to match material that’s thinner than TNOM.


The following pages walk you through the steps of measuring, calculating, and scaling.

















Measure Your Materials


	

Using calipers, measure the thickness of your plywood sheet in at least four places—near the edges of the sheet—as indicated by TA, TB, TC, TD in Figure 5-3.



	

Record your measurements as you take them. Use a record-keeping strategy that you’ll be able to easily reference in the future, like a notebook or spreadsheet. You’ll find that you want to refer back to these as you work through the projects in this book.



	

Repeat. If a design uses multiple sheets, repeat this process with each individual piece of plywood.



	

Find the greatest thickness from all of your measurements on all sheets. This measurement is TMAX.







With your material’s physical measurements in hand, you’re ready to adjust your CAD file’s nominal dimension to your plywood’s actual dimension.


TMAX

TMAX represents the thickest sheet material dimension or actual material thickness. To ensure that all parts cut from your actual material have perfect, well-fitting joints, your digital file must be adjusted to match TMAX.
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Figure 5-3. Measure material thickness at multiple points, maximum thickness is TMAX



















Scale Your CAD File


The natural fluctuation of sheet material thicknesses makes standardization—and standard cut files—impossible. Because your actual material thickness (or TMAX) will never precisely match the designs file’s nominal thickness (or TNOM), you’ll need to scale your CAD file to match your material thickness or your joints won’t fit together. Cutting parts from an unadjusted CAD file will produce parts that won’t fit. Joinery will either be too loose, leaving parts to rattle around, or too tight, with tabs too fat to fit through slots.


Luckily, scaling your CAD file is a simple process.


	

TMAX / TNOM = S. Divide your measured material thickness (or TMAX ) by the nominal material thickness of TNOM to get S—a scaling percentage.



	

In the SketchUp file, turn on only the toolpathing layers.



	

Select all 2D toolpaths on the toolpathing layers and then scale them by S, the scaling percentage.



	

Save and rename the file. Add the amount scaled to the filename (e.g., AtFAB_CiBii-.9867.skp). This differentiates it from the original, unscaled version of the file, and indicates the file’s scale. You’ll forget!


Small-scale adjustments usually won’t have an impact on fastener holes. If you want to maintain a specific hole diameter for particular fasteners or pegs, scale holes with the rest of your vectors and then change the dimension of the 2D hole component.




Check that S does not reduce the cut file scale by too much. Sniglet diameter should always be equal or greater to your end-mill dimension.




Since different designers may use different standards, it’s good to make a habit of measuring slots and material thickness in any CAD file that you download. AtFAB files on OpenDesk, and other files floating around the interwebs, may use an 18mm TNOM.
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Figure 5-4. Scale cut file by S, matching joinery to TMAX


























Scaling, Offsetting, and Parameters


Scaling the CAD file by a small percentage, S, makes up for any discrepancies between TMAX and the nominal ¾″. This scaling method is the simplest and most direct way to match the virtual CAD design with the material, which came after much trial and error. It is worth explaining scaling in the context of other methods of adjusting a CAD file for material.










Why Scaling Works


Scaling all parts by a multiplier, S, has proven to be the most efficient and accurate way to adjust a cut file to match TMAX. As shown in Figure 5-5, scaling resizes every part proportionately, resulting in flush connections between slots and tabs. The only shortcoming of this technique is that it works best with a nominal amount of scaling.



A scale differential less than 5%, which is within the nominal thickness variation of most standard material stock, won’t be perceptible in a free-standing object.



A 5%–10% scale adjustment to furniture might be perceptible, but typically won’t affect function.



A scale adjustment greater than 10% will affect the function of a furniture piece, yielding a tabletop that is 10% lower, a chair that is 10% smaller, or having 10% less height between shelves.

















Why Offsets Don’t Work


At first glance, it may seem that offsetting vectors is the simplest and most obvious way to adjust a cut file to fit TMAX. However, take a look at Figure 5-6, and examine what happens with the example slot and tab as vectors are offset.


Using this function in any CAD or CAM program inconsistently affects the X and Y disproportionately,
impacting the ratio of height and width.


Offsetting creates tabs deeper than the material thickness, and it changes sniglet radii to form uneven and possibly uncuttable toolpaths. Parts and joinery don’t fit when you offset toolpaths.

















The Parametric Solution


A third alternative is to adjust the file by precisely redrawing all 2D vectors to match TMAX, while still preserving the proportions of each part, shown in Figure 5-7.


However, by laboriously redrawing each part, there is a high probability of missing a small detail in the process. A powerful CAD program with parametric capabilities can automate this adjustment, while sparing you the tedium and possibility for mistakes.


Parametric software, explained in Chapter 12, can have a steep learning curve but has tremendous potential when coupled with digital fabrication. Chapter 13 and Chapter 14 are accompanied by parametric applets, which allow you to transform every furniture part, so it precisely fits TMAX.



 Figure 5-5. Scaling a cut file to TMAX
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 Figure 5-6. Offsetting to TMAX
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 Figure 5-7. Parametric transformation to TMAX
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Prototyping


Prototypes are used to evaluate a design at varying stages during the design and fabrication process.


From a practical standpoint, prototyping allows you to identify errors and troubleshoot defects before committing to making a full-scale, final piece. From a design standpoint, prototypes enable you to take risks with innovative ideas and to gather immediate feedback. Working digitally enables rapid prototyping, where you can iteratively cycle through a process of designing, prototyping, and making improvements, over and over.


Prototypes can take many forms, but for CNC furniture there are two kinds that are especially useful. Partial prototypes made at full scale are essential to digital craftsmanship, by helping you to dial in machine settings and to evaluate finishing techniques. Scale prototypes, made by fabricating your digital file at a smaller scale, are great for evaluating a new or modified design.
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Figure 5-8. Partial prototype test pieces for each project












Partial Prototypes


Partial prototypes are small samplers of a larger design that you make using your actual project material. A partial prototype is great for trying out especially complex and tricky portions within the design, before committing to the fabrication of an entire design. Partial prototypes are also quite useful for evaluating joinery fit and ensuring that you scaled the CAD file to perfectly match TMAX.

















Test Pieces


Each project in this book is accompanied by a partial prototype called a test piece, shown in Figure 5-8 and in the image that opens this chapter. They were designed to simulate the most complex joint combinations within each project. After measuring materials and scaling a CAD file, fabricating this test piece is the next step for ensuring tight-fitting joinery.


Preliminary fabrication tests prevent the disappointment and waste that comes from cutting an entire piece of furniture with incorrect settings. Each project’s test piece was designed to use as little material as possible, but still be large and detailed enough to allow a thorough analysis of all the joint conditions within the furniture piece.
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Figure 5-9. Joinery fit: too tight versus too loose




To ensure that your test piece properly simulates the critical joinery of your project, it’s essential to fabricate it exactly as you would the actual furniture piece. First, you apply identical scaling adjustments (S) to the 2D test piece vectors in CAD (as explained in “Scale Your CAD File”). From there, you’ll assign identical toolpath settings in CAM software (which will be explained in “Partial Prototyping: Using a Test Piece”), and proceed to cut the test piece from the exact material that you’ll be using for the actual piece.


Most of the time, these careful steps lead to a test piece with perfectly fitting joinery, enabling you to confidently proceed with cutting your project. When joints aren’t perfect, however, the test piece is small enough to quickly make digital adjustments, cut another test piece, and compare the new fit to the previous one (“Troubleshooting” goes into greater detail with these steps). The beauty of prototypes is that they enable the iteration that’s necessary for flush joinery, the hallmark of digital craftsmanship.

















Scale Prototypes


Scale prototypes are small-scale versions of a design, cut with a desktop CNC or laser cutter out of inexpensive materials like cardboard, plexiglass, or aircraft plywood. They differ from partial prototypes in that they can be used earlier in the design process. If you have access to a laser cutter at your workshop or fabrication space, you have a quick and inexpensive way to make scale prototypes of digital designs.


Although they are small, scale prototypes can assist you in analyzing structural integrity, testing accurate fit between parts, and evaluating complex patterns or embellishments. They’re also helpful if you’re making modifications to the projects throughout this book, as they help confirm that you haven’t misplaced a sniglet or misaligned a joint. Scale prototypes allow you to see the overall composition of details in physical space. Understanding the whole object enables you to intelligently analyze a design in ways that you may have not imagined, when looking at the CAD screen.


To prepare a scale prototype file, you simply follow the same steps as you would in adjusting a CAD file (explained in “Scale Your CAD File”). The only difference is that thin prototyping materials like acrylic or cardboard have a TMAX, which is much smaller than nominal plywood thickness. Scaling toolpaths to match this thickness requires a much smaller S percentage.
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Figure 5-10. Scale furniture prototypes made of 1⁄8″ aluminum cut by a CNC waterjet
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Figure 5-11. Chair prototypes in different scales made of laser-cut plexiglass and chipboard




Surplus Material

Always purchase extra material for testing and for recutting parts. Surplus plywood is also useful for partial prototypes and in the event that a part is damaged during the cutting, finishing, or assembly process. With extra material on hand, you can easily cut a replacement part for one that was damaged by human or machine.


As you embark on your first projects, we recommend that you purchase a second sheet of plywood, or cut a small project and reserve the other half sheet for testing.


In the project chapters, we recommend that you have at least 1'x4’ of additional material on hand for every project in this book—but it’s a best practice to have an extra half or full sheet around.





















Chapter 6. Machining For Designers



This chapter dives deeper into computer-controlled routing fundamentals, with a basic overview that covers large-format CNC router and end mill anatomy, essential workshop accessories, and machining basics like feeds and speeds—with a focus on plywood projects.








Machining Begins with Material and Tooling


When planning a CNC project, your first question should always be: “What material do I want to cut?” All machining begins with your choice of material—every subsequent choice stems directly from the material you select.


The follow-up question is: “What cutting tool should I use?” Every material has specific tool geometries that work well, and each cutter and material pairing has an optimal range of rotational speeds.


Computer-controlled cutting machines that use rotational tooling have emerged from two very different material-focused disciplines: woodworking and metal machining, also known as milling. As you grow as a maker—or begin to design for other materials—you’ll encounter online, print, and in-person advice from experienced woodworkers, life-long metal machinists, and versatile fabricators who work in many materials.


Each field has its own best practices and terminology, so to help you understand the fundamentals, we’ll start at the beginning—with a brief history of tool rotation.

















Spindles and Speed


Generically, a spindle is a rotating shaft that transfers motor power to a cutter as it spins around an axis. When applied to a material, the tool attached to the spinning spindle bites into the substance, creating subtractive waste products, called chips, with each revolution.


The frequency of rotation, or speed, of a turning mechanical component around a fixed axis is measured in revolutions per minute. Rotational speed can be abreviated as: RPM, rev/min, or r/min.


On a machine, the term “spindle” refers to the entire motorized assembly that moves up and down the z-axis, not just the shaft. Spindles conventionally spin clockwise (although there are a few that spin counter-clockwise), and most tooling—and all the machining information in this book—assumes a clockwise rotation.










Chip Formation


As the spindle turns a tool, the cutting edge slices into the material, removing a fragment called a chip. The size of the chip is called chip load.


Chips are not just the waste product of machining—they are key to heat dissipation. The act of cutting a chip generates a small amount of frictional heat. Chips absorb this heat, pulling it away from the tool and the workpiece, as they are ejected through the flutes. If this heat were allowed to build up, it could quickly dull tools, leave burn marks on wood, or even start a fire.


Creating chips that dissipate heat quickly while balancing both cut quality and time spent is fundamental to machining. The speed that a machine turns a cutter has an impact on what materials can be cut and what type of tool can be used. Different machine types have different ranges of spindle speed.
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Figure 6-1. Chip formation



















What Is a Milling Machine?


Mills were invented in the early 1800s. Originally they were large, heavy, rigid, high-precision, motorized (but not computer-controlled) machine tools made to cut very hard materials like metal. The spindle that rotates a rotational cutter capable of lateral cutting called an end mill is stationary, while the material is clamped in a vice to an x-y moving table.1 Most mill spindles have a speed range of 3,000–7,000 RPM. Anything higher than 7,000 RPM is considered, routing or high-speed machining (see “High-Speed Spindles”).

















What Is a Router?


In 1915, Oscar Onsrud and his son Rudy repurposed a jet motor, creating a hand-held spindle that turned much faster than a mill spindle and ran on compressed air—founding Onsrud Machine Works. In order to cut at higher RPM, Onsrud created a new type of cutting tool that could spin at 30,000 RPM, far faster than any end mill at the time could cut. Called router bits, or router cutters, these tools had modified end-mill geometry that could cut wood at high rotational speeds and lateral feeds.


Modern routers are woodworking power tools that use router bits to carve joinery grooves, decorative moldings, engraving, inlays, or simply to cut out parts. This is usually accomplished by tracing a template, sometimes with a bearing-guided router bit. Routers come in many types and sizes and are usually handheld, but can also be mounted in a table—or attached to a machine frame. Some routers are single speed, but most have adjustable, designated, spindle speeds somewhere between 10,000–25,000 RPM, much faster than mill spindles.


For example, a Porter-Cable 7518 3-1/4 HP variable speed router used on some ShopBots can be adjusted to run at any one of five different speeds: 10,000, 13,000, 16,000, 19,000, or 21,000 RPM.


When working with a CNC router, never use a router bit with a guide bearing.




Routers can cut much more than wood; plastics and soft metals like aluminum cut well at high RPM.



















High-Speed Spindles


Some CNC routers have actual router power tools attached, while others have variable high-speed spindles, so-called to differentiate them from traditional mill spindles, which operate at a much lower RPM.


Overall, high-speed spindles (Figure 6-2) are powerful and much quieter than routers. On large-format CNC routers, like the ShopBot PRSstandard and PRSalpha,2 high-speed spindles are industrial-quality components with precision bearings that enable them to cut better and last longer than a router. They also have less runout, or rotational wobble, can operate at full torque (twisting force) at lower RPM without bogging down, and have minutely adjustable speeds from around 5,000–25,000 RPM.


There are also modern milling machines that are capable of high-speed machining, or HSM. These mills move quickly at high RPM, making light passes to achieve high metal removal rates.




Figure 6-2. High-speed spindle on a ShopBot PRSalpha CNC router
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Machining Variables


Each material has a range of workable spindle speeds. For example, spindle speed for routing plywood is somewhere between 11,000–18,000 RPM.  But speed is only one of several variables in the feeds and speeds equation that determines how the tool, material, spindle speed, and tool movement through the material, or feed, work together to make a cut.


Knowing the optimal spindle speed range for plywood is helpful, but how do you determine the exact spindle speed to use?










Relating Everything to Everything


Feeds, speeds, and chip load are machining’s trinity. They can be defined separately, but when cutting, all three work together simultaneously to produce chips.


When trying to grasp a concept, always look at how it is measured or calculated. That’s the key to understanding exactly what the thing is, what variables are in play, and what relationships are important.


	Speed

	
Spindle speed, measured in revolutions per minute (RPM) is calculated from a combination of specific aspects of cutter geometry, feed rate, and chip load:
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	Feed Rate

	
Feed rate is the velocity at which the tool moves laterally through material. Feed rate is measured in distance per time, or inches per minute, and abbreviated IPM3:
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	Chip Load

	
Chip load is the amount of material removed by each flute’s tooth as it makes one revolution while being pushed along at a feed rate and spindle speed. Chip load is measured in feed per tooth, or inches per revolution, abbreviated as IPR:










Rough Chip Loads By Material

The chip load, feed, and speed formulas all take individual tool geometry into account by including the number of flutes (cutting edges) into the equation.


While actual chip load is different for each specific tool geometry, chip load generally increases gradually with bit diameter. Some rough chip loads for sheet materials are shown in the following table.4


Onsrud provides chip load data specific to their tooling. For more information, see http://www.onsrud.com/xdoc/Feed-Speeds.







	CHIPLOAD
	1/4 inch
	1/2 inch





	Softwood

	.002-.020

	.003-.030




	Hardwood

	.005-.020

	.005-.030




	MDF

	.005-.030

	.005-.020




	Plywood

	.005-.020

	.005-.030




	Laminated Chipboard

	.008-.020

	.010-.030
























Where to Begin?


The interconnected nature of feeds, speeds, and chip load are obvious from these equations. At first glance, this seems like a “chicken and egg” problem. If all the variables are dependent on one another, where do you begin?


Start with what you know: namely, that you want to cut plywood on a CNC router and that you’ll need a router bit designed for that purpose.


But before you can select a tool, you’ll need to address the following questions:



	
What type of CNC router are you using?



	
What type of material are you cutting?



	
What is the material thickness?



	
How are the parts laid out?



	
How is the material being held to the machine?




























CNC Router Anatomy


Large-format CNC routers are built for quickly cutting softer materials by moving the cutting tool through a full 4′ × 8′ sheet material, which is fixed to a stationary bed. While the details of such machines vary from manufacturer to manufacturer, most share a common anatomy.


	Rails

	
The rails are extruded aluminum tracks that employ either a motorized rack and pinion system or a v-rail/v-wheel linear bearing system to create linear motion. The machine’s gantry, YZ car, and spindle sit atop and slide along the rails.



	Gantry

	
The gantry is the y-axis of the machine; it sits atop the long x-axis rails that run the length of the machine bed. It holds the z-axis carriage (and spindle) moving forward and backward along the x-axis rails.


Machines that move the spindle around while the material remains fixed are also called gantry-style machines.






Desktop machines are likely to use rods and leadscrews, or rods and belts, instead of rails. They often secure the material to a moving y-axis table while the spindle moves in the x-axis.




	YZ Car

	
It moves left and right on the y-axis across the gantry, while carrying the z-axis and the attached spindle.



	Deck and Spoilboard

	
This is the flat, rigid surface where material is placed for cutting, typically made of metal. Deck size determines the maximum material size that can be used on the machine. The deck is covered with a protective, sacrificial layer, also called a spoilboard or waste board. When the spindle cuts through material, the tool scrapes the top of the spoilboard, marring the surface. The spoilboard is replaced when it becomes worn out. The entire area (that is, the deck/spoilboard combination) is also referred to as the bed.


A bed doesn’t need to be flat like a pool table; it just has to be parallel to the motion of the tool (trammed). To ensure proper spoilboard/spindle alignment, the sacrificial layer is placed on the machine and surfaced by cutting away a small portion of the entire top face with a large bit. This preparation results in making the spoilboard surface parallel to the motion of the tool.






Spoilboards need to be maintained and should be resurfaced regularly. Deep grooves in the waste board contribute to workpiece vibration because they prevent the sheet from lying completely flat on the bed. This vibration is a key culprit in tool breakage.




	Dust extraction

	
The bigger the CNC, the more likely that it will have a built-in vacuum system attached to the spindle, which cuts down on dust particles in the room and overall machining mess.






Three-axis CNCs have a few limitations. They can only cut materials that fit inside the workzone and they are unable to make undercuts.


	Workzone

	
Also known as the cut area, a CNC’s workzone is the portion of the deck where machining can occur. Deck size determines the maximum material size that can be placed on the bed, but the actual workzone is often slightly smaller. The projects in this book assume a cut area of 4′ × 8′.



	Undercuts

	
Three-axis CNCs can only cut top-down into the material on the bed. They are unable to maneuver underneath the material, in order to cut shapes that overhang or overlap when viewed from above. You can only make such features, called undercuts, if you manually flip the material over to cut the other side.
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Figure 6-3. ShopBot PRSalpha 96″ × 48″ with annotations of key elements












Safety


Routing has some inherent dangers: machines have moving parts, bits can break, and chips and other particles become airborne. It’s best practice to always wear safety goggles and a proper dust mask (if your shop doesn’t have a dust filtration system). Plus, routers are loud when cutting, so wear ear protection. Spinning spindles can catch and pull in anything that hangs loosely on the body, so always remove jewelry, especially necklaces, and tie back long hair and roll up your sleeves.
























Workholding Strategies


In order to cut the material, it needs to be secured to the machine bed. There are two basic ways to hold down material: mechanically secure it to the bed, or use a vacuum system. Your workholding strategy is important to consider up front; hold-downs are physical objects that you’ll need to factor into your design and cut files. Mechanical hold-downs, for instance, must be placed outside of the path of the spindle and gantry, as collisions can cause tool and machine damage. Decide on a strategy early in your design process and keep it in mind when preparing the cut sheet.










Screws and Clamps


Mechanical hold-downs are off-the-shelf items like screws and clamps. Screws are the easiest and most common way to secure large sheets to the sacrifice sheet. They don’t take up much space, and they can be driven in flush with the material being cut. As you cut sheets of 4′ × 8′ plywood for the projects in this book, it’s best practice to add a screw at each of the corners and then add additional screws approximately every two feet around the perimeter of the sheet. Carefully place the screws as close to the edge of the material/machine as possible, so you’ll be able to leave a 1″ margin around your cut files and be confident that you won’t hit any screws when machining.


Clamps are very useful when working with smaller size materials, or when you’d prefer not to mar your workpiece with screw holes. However, clamps have one key disadvantage: they protrude above the workpiece. This means that you’ll need to account for them both in your design and the toolpaths you create to avoid hitting the clamp with the machine.

Finding Safe Hold-Down Locations

Prior to cutting your actual design files, find safe locations for screws and clamps in your CAD/design files and then create a very shallow marking toolpath that creates “dimples” to mark hold-down locations on the sheet. After you run the marking toolpath, you’ll clearly see the safe locations for adding screws or clamps.



















Vacuum Systems


A vacuum system uses suction to secure material to the machine bed, enormously simplifying the cutting process. It eliminates the need to dedicate material to mechanical fasteners and to plan toolpaths around them. Most significantly, it speeds up the process of taking material and parts on and off the machine.


There are two types of vacuum hold-down systems: conventional and universal. Conventional systems are usually specific to a particular task or process and utilize a small machine area, where a universal system utilizes the entire machine bed and is applicable to a broad range of applications. When we mention a vacuum hold-down in this book, we’re talking about a universal system. Although typically more expensive, they are well suited to jobs that make through cuts in sheet goods.


A vacuum hold decreases the more through cuts you make. You’ll want to limit the amount of small parts and cut them first, while you have more pressure.




Figure 6-4. Bill Young’s shop with its ShopBot PRS Alpha CNC router and vacuum hold-down system
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End-Mill Anatomy


A router bit is a type of end mill. These terms are more or less interchangeable, but there are individual attributes that make a tool optimized for cutting a specific material.


The term end mill has a milling/machinist origin, and mills existed long before there were routers. Because routers and high-speed spindles spin at dramatically higher RPM than traditional mill spindles, machinists created modified end mills for routing wood without burning it up and starting a fire. These mills were capable of cutting at higher spindle speeds, and were subsequently dubbed router bits.


Fortunately, both end mills and router bits share common anatomical features, so knowing their parts will help you focus on the features that most impact your project.
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Figure 6-5. Key parts of an end mill




	Tool Materials

	
End mills come in a variety of materials.
Tools made of solid carbide are more expensive, but yield the best finish, have the longest life, cut quickly through material, and plunge well. Less expensive carbide-tipped and high-speed steel (HSS) tools tend not to perform as well and prove to be less durable.



	Flute

	
The radial or helical grooves machined into a tool. Each flute has a sharp cutting edge (or tooth) that cuts and then evacuates chips. End mills with one, two, or three flutes are used in woodworking, with two flutes being the most common. Tools with four or more flutes are typically used to mill harder substances.



	Shank

	
The plain region without flutes that is inserted into the spindle. Shank diameters come in standard sizes, the most common are: ¼″, ½″, and 1⁄8″.



	Cutting Edge Length

	
Abbreviated CEL, this refers to the part of the tool that has flutes and teeth and is able to cut material. Also called length of cut, LOC, or LC. The cut length of an end mill determines the maximum depth of cut (see “Depth of Cut”).



	Cutting Edge Diameter

	
Also called CED, this is the diameter of the cutting edge length (CEL). It determines the minimum feature size, or the smallest physical detail that can be created when using a specific tool.


Shank (SHK) and cutting edge diameter (CED) are usually the same, but they can be different, especially on smaller diameter tools. For example, you can have a tool with a ¼″ SHK and a 1⁄8″ CED. See Figure 6-12.



	Overall Tool Length

	
The overall tool length, or OAL is comprised of both the cutting edge length (CEL) and the shank (SHK). It determines how far the tool can protrude from the spindle in the z-axis direction.



	Deflection

	
It’s important to select the shortest overall tool length with the largest possible diameter. The farther a tool protrudes from the spindle, the more it will deflect, or bend and flex, as cutting forces are applied. While a small amount of deflection always occurs when machining, pushing a tool too hard (especially smaller diameters) can create oddly angled cuts, dramatically shortened tool life, dulling, and increased breakage.






Finding a CNC to Use

You don’t need to own a CNC router to pursue any of these projects. You simply need to find one near you. Many community colleges and universities have shops with digital tools. By signing up for a course, you’ll learn how to use the machines and gain access to your institution’s facilities and equipment.


The recent proliferation of community makerspaces, Fab Labs, TechShops, and other shared workshops, paired with the increasing affordability of CNCs and increasing educational focus on engineering and innovation, means it’s easier than ever to get access to high-quality, reliable machines.


In addition to CNC routers, most of these spaces offer incredible access to an array of tools, software, classes and workshops and are also typically equipped with desktop 3D printers, laser cutters, and other tools that make it possible to pursue a wide range of projects. We always imagined that AtFAB could be a gateway DIY CNC project at such a place, where you could start and finish a project within the space of a weekend.



















Collets


A spring collet is a flexible type of chuck, or tool clamping system intended to hold a cylindrical object. The collet is part of the spindle assembly. The tool is inserted into the collet and then tightened with a collet nut that compresses it tightly around the inserted tool.


Like end mills, collets also have dual diameters. They come in standard sizes with an exterior measurement that matches the CNC’s spindle and an interior measurement that corresponds to a tool’s shank.

















End-Mill Geometries


Pairing your material and machine setup with the proper tool is vital, but it can be a challenge; there are an immense variety of cutter types and shapes available for every conceivable material and cut type. But don’t worry, we’ll walk you through the basic principles and tool types—and provide tool recommendations for routing plywood with part numbers and suppliers to get you started.



[image: dcnc 0606]
Figure 6-6. Tool end types












End Types


End mills for machining wood have two basic end types: those that are able to plunge straight into material, and those with flattened end flutes that must be ramped in.


	Standard/Plunge End

	
These tools are sometimes called fishtail or swallow tail end mills, due to the indentation at the end of the tool. These tools work well for both profile and pocket cutting. For profile cuts, it produces a completely flat edge surface. For pockets, it leaves a clean, 90-degree angle between the side and the bottom, and gives the bottom of the pocket a flat surface (for further details, see “Pockets”).



	Finish/Flat End

	
The fishtail-style plunge end mill can leave toolmark scratches in the bottom of a pocket, which can be eliminated by using a finish or flat end mill (FEM), which must be ramped into the cut due to its much flatter end.



	Ball-nose

	
A ball-nose end mill has helical flutes and a round end, which is best for contour cutting, and is capable of creating topographic smoothness because its ball end makes minimal contact with curved surfaces.



	V-Bit

	
A v-bit has an angled tip that carves a deep v-shaped groove into the material surface. Typically the sharp bottom of a v-bit is aligned with the toolpath, making it ideal for v-carving, or cutting decorative details with a three-dimensional effect without the need for an actual 3D model. V-bits come in a variety of angles and depths, depending upon your desired depth and width of cut.



	Engraving

	
Engraving tools make a shallow cut along a toolpath. They are capable of etching very fine, often decorative, details into a surface.





















Flute Types


End mills for machining wood have radial or helical flutes. Radial flutes are straight grooves that are parallel to the tool’s axis, while helical flutes wrap around the tool.


Higher helix angles clear chips away from the cutting edge faster. Straight tooling with radial flutes have a 0° helix angle, while spirals for cutting wood can have a helix angle of up to 35°. In addition to high helix angles, router bits also have steeper rake (tool attack angle) and clearance angles to evacuate the chips much faster than a traditional end mill.


As the tool turns, the direction of the spiral determines which way chips are ejected. The two basic types of helical end mills are upcut and downcut, shown in Figure 6-7.
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Figure 6-7. An upcut tool pushes chips up and out, while a downcut tool forces them down into the kerf, as it cuts




Stay away from left-hand rotation tools, often indicated with an “L” or “LH” in the tool number. They are meant for spindles that rotate counterclockwise.




	Upcut Spiral

	
This tool’s flutes eject chips upward, out of the gap created between the cut piece and the waste material (kerf). Because the chips are forced up, the material’s top surface can become chipped or frayed (known as tearout), while the bottom face will be cleanly cut.


Although upcut tools are very efficient at dissipating heat and clearing chips, they have some undesirable  effects that can make them a poor choice for routing plywood. The upward chip movement pulls the material up from the cutting bed, creating a troublesome lifting effect on lighter, thinner materials. This movement can also pull at small cut parts and long skinny parts. This can be problematic for vacuum holdowns, and you’ll need to use tabs to keep parts in place.



	Downcut Spiral

	
A downcut spiral’s flutes push chips downward, toward the machine bed. When cutting with ¼″ and 1⁄8″ downcut tools, the chips can become compacted in the kerf, which helps to hold the material against the CNC machine bed.


When through-cutting, the downward force created by the chip ejection can cause tearout on the bottom face, while the top face will have a nice finish.






Don’t drill with downcut tools. It’s already hard to clear chips when drilling, and pushing the chips down into the hole further exacerbates this problem.




	Compression Spiral

	
A compression tool is a combination of an upcut and downcut spiral. It pulls material up from the bottom of the cut and down from the top of the cut, leaving a good-quality finish on both the top and bottom faces. This seems ideal, but compression tools are expensive, and most are meant to cut in one pass at full depth.



	Straight Flute

	
These radial two flute tools have a zero-degree angle and create a superior finish in natural wood and wood composites. The entire straight flute makes contact with the material when cutting. Chips are not pushed up or down, creating a good edge quality on most materials.






Straight flutes are Bill Young’s tool of choice for routing Baltic birch plywood.




Not all router bits can run at the highest available router/spindle RPM. The tools we recommend are safe at high speeds, but you should be aware that large diameter tooling, especially cheap, low-quality bits, may be unsafe to run at max RPM. Refer to manfacturer documentation for safe speeds.




Onsrud Tooling Catalogs

Onsrud Cutter’s tooling catalogs are a great place to learn about the wide variety of bits available. To select a tool based on your project’s individual needs:



	
Download a Onsrud routing production tools catalog.



	
Browse by material (plywood is composite wood).



	
Find the appropriate geometry for your project, taking cut type, part orientation, hold-down type, and material into account.






























Feed Direction


Material is often fed into machines—for example, you feed fabric into a sewing machine, wood into a table saw, or metal into a stationary milling machine spindle. But when routing, either with a hand router or a gantry-style CNC router, it’s the opposite—you feed the spinning tool into stationary material.


Feed direction determines which way the tool moves around the part when cutting and how the tool’s clockwise-rotating flutes create chips when they make contact with the material. This impacts the edge quality of your cut parts.


As illustrated in Figure 6-8, a conventional feed direction cuts a closed part in a counter-clockwise direction, while climb cutting moves clockwise around a part’s perimeter.










Conventional Cutting


With conventional cutting, the primary cut is made as the tool exits the material. The chip starts out thin and then ends thick. This can cause end-grain splintering in hardwoods, but it works well for composite sheet goods, like plywood.


This scenario is safer on a table or hand-held router, and because hand-held routers paved the way for CNC tools, this cut type is considered to be the “conventional way.”

















Climb Cutting


In a climb cut, the chip starts thick and ends thin. This can result in a smoother cut in materials such as hardwood because it eliminates end-grain splintering. However, the forces created can also mar the finsh and push parts around due to the bit trying to “climb” out of the cut. In addition, the forces created can deflect the tool.


Conventional (counterclockwise) and climb (clockwise) feed directions are reversed when pocketing or cutting the interior of a part. When making interior cuts, a conventional feed direction will move clockwise, and a climb cut will move counterclockwise.
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Figure 6-8. Climb versus conventional



















Feed Direction Strategies


Although we’re recommending a conventional cut for plywood, this isn’t gospel. Machining advice is always specific to the exact materials and tooling you’re using. Plywood varies greatly between brands, types, and even between batches. Sometimes climb cutting may work better than conventional.


The key is to jump in and test your material/tool pairing and settings. Always cut in the direction that gives you the best finish. Cut some test pieces and look at both the part and the scrap/waste material. If the scrap looks better than your cut parts, reverse the feed direction.


You can also try using an onion-skin strategy. This is a machining methodology that utilizes the strengths of both climb and conventional cutting. First, climb-cut the part, but leave a thin “onion skin” layer behind. Then cut the final pass as a conventional cut.5
























Ramp Moves and Tabs


Although center-cutting end mills can plunge straight into the workpiece when beginning a toolpath, it’s hard on the cutter and leads to premature wear—while it is possible to drive them axially into your workpiece that doesn’t mean you should.


Ramp moves are a much gentler way to ease the tool into the material. Ramping in at a gradual angle reduces heat buildup and spindle/z-axis load, plus it helps to reduce vibration and keeps parts in place while machining. Because you’re slowly ramping into the cut, keep your plunge rate, or axial cut rate, the same as your feed rate.










Smooth Ramps


Smooth ramps work well for easing the tool into large parts. Because center-cutting bits have flutes on both the sides and bottom, and three-axis CNCs can move in the x, y, and z axes at the same time, it’s possible to gradually and smoothly move the rotating tool into material at an incline, as shown in Figure 6-9.

















Spiral Ramps


This ramp type slowly eases the tool into the material over the full perimeter of a profile toolpath. Spiral ramps are particularly useful for small parts because machining forces can push them around as they are being cut. If the part becomes dislodged from the main workpiece, it will get caught up by the moving tool, resulting in ugly gouge marks in the part, which can also fly off the machine bed. This is bad for safety, your parts, and your end mills, which can break. Spiral ramps also help to maintain vacuum hold because they help to keep parts from lifting.
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Figure 6-9. Smoothly ramping into cut



















Tabs


Tabs are small, rectangular sections of uncut material, added to profile toolpaths in CAM software, that keep a part joined to the waste material when making through-cuts. Tab length, thickness, and placement are usually user configurable. Also called bridges, tabs are helpful for keeping small parts in place or long, thin parts from vibrating, especially if you don’t have a vacuum hold-down system.

Pratical Tab and Ramp Advice

For most large parts, I use a four- to six-inch smooth ramp into the cut, but with really small parts (like feet) and holes I use a spiral ramp. On small parts, I also use a single tab at the start point of the cut and move the start point so that it’s on a straight side that’s parallel to the grain. I rarely use tabs on large parts unless they are long, thin, and want to vibrate, and then a couple of tabs help.



Bill Young




Routing Strategies

When I need to access a full-size 4′ × 8′ router, I head over to my local Fab Lab, where we use screws for hold-downs on our ShopBot PRSstandard. I hate cutting off tabs, so I always use a downcut tool (Figure 6-7) when making through-cuts, a trick I learned from Jonathan Ward when we were at the Haystack Mountain School of Crafts.


A downcut tool forces the chips down toward the bed into the kerf, packing them around the part to keep it from moving. The success of this “no tab” downcut technique is dependent on a plywood thickness-to-tool diameter ratio. It works well for cutting large format parts from ¾″ or ½″ plywood using a ¼″ or 1⁄8″ diameter tool. Larger tools create a bigger kerf, and chips don’t always stay tightly packed, especially when using dust extraction without a vacuum system.


In his private shop on Virginia’s southern shore, Bill Young uses a vacuum hold-down system on his ShopBot PRSalpha. He uses a two flute straight router bit (see “End-Mill Geometries”) when working with plywood because it yields a nice surface finish on both the top and bottom of the parts, and lasts longer than a downcut helix. Plus, this tool’s cutting action doesn’t lift the part, helping to maintain the vacuum and keeping the part firmly anchored until the job is finished.



Anna Kaziunas France
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Figure 6-10. ShopBot PRSalpha 96″ × 48″ with assembled test piece




























Pockets


Pocket cuts have vertical sides and a flat bottom and can be used to create a recessed area for anything you can imagine, from joinery connections to adornments. Pocket toolpaths are similar to inside toolpaths; they both cut on the inside of a closed line, but pockets also remove all the material inside the cut line to a specified cut depth.


If you’re familiar with the traditional hardwood slot creation techniques of grooves, rabbets, and dados, you can think of a pocket as the “Swiss Army knife” of CNC slots. If you’re attempting to translate a woodworking design created by more traditional means for CNC sheet goods, woodworking slots (grooves, dados, and rabbets) are defined in terms of how they run with or cut across the grain. However, because plywood is made from individual sheets turned at right angles and glued together, it doesn’t have a singular “grain” like hardwoods do.


When clearing pockets, there are two basic ways to remove the material: offset and raster.
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Figure 6-11. Multiple views of cutting a pocket via the raster method and showing tool stepover












Offset


Pockets cut using the offset method start at the center of the pocket indentation and move in a spiral pattern until the tool reaches the pocket’s outside edge.

















Raster


A raster pocket begins at one end, and the tool moves side to side from one end of the pocket to the other, clearing out a recessed area, as shown in Figure 6-11.


When pocketing visible designs or features, rastering with the grain can help hide toolmarks in wood. However, grain direction when pocketing is more relevant when working with hardwood than plywood. With plywood, you’d need to determine what ply your cut depth will reach, and which way the grain is rotated, a tricky proposition.

















Stepover


The amount of tool overlap between passes is called the stepover value. The smaller the stepover percentage, the finer the finish due to the increased toolpath overlap. A stepover value of 50.0%, or one-half the diameter of the bit, is usually enough to minimize tool marks and leave a smooth bottom surface.
























Depth of Cut


Depth of cut, also called pass depth or depth per pass, is how deep each individual machine-cutting pass should be to reach the cut depth. It often takes several passes to cut all the way through material.
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Figure 6-12. Pass depth for ¼″ tool versus smaller 1⁄8″ tool




Depth of cut is determined by both material thickness and end-mill diameter. When cutting with small diameter tooling (1⁄8″ and smaller), it’s best to make shallower passes than when using ¼″ and larger diameter tools.


The general rule for determining depth of cut is that one pass should equal the diameter of the end-mill. So, as shown in Figure 6-12, a ¼″ end mill takes three passes to cut through a ¾″ sheet of material or two passes for ½″ material.


Making more passes takes more time, but makes a cleaner cut and puts less stress on your tool. Increasing cut depth by too much can lead to poor cutting quality, as well as end-mill breakage. Experienced fabricators often push cut depth to the limit to save time by reducing the number of passes. However, beginners and those with few tools might want to err on the conservative side.


Both depth of cut and tool diameter have an effect on chip load. When depth per pass exceeds a tool’s diameter, the chip load becomes greatly reduced. If your cut depth is greater than two times the tool’s diameter, the chip load is reduced by 25%. If you cut deeper still, to three times the diameter, it’s reduced by 50%.

















Putting It All Together


Material properties are the primary factor driving your machining decisions. Knowing how to properly combine machining variables with your tool choice allows you to efficiently cut parts with clean, smooth edges, regardless of a material’s hardness or thickness. To produce quality parts in a reasonable amount of time, it’s critical to consider cut depth and feed direction and to optimize the end-mill geometry with feeds and speeds that produce the correct chip load.


As it cuts through material, an end mill produces a tremendous amount of heat. If allowed to build during machining, this heat will actually dull the tool, or worse, cause it to break. In order to prevent tool failure. This heat must somehow be dissipated.


An end mill is ingeniously engineered to rely upon the very chips it is cutting to evacuate heat and to sustain an operable temperature. In CNC machining, there is a sweet spot where tool geometry combines with feed-and-speed settings to remove chips at a rate that effectively dissipates this heat.


When you find this sweet spot, your machine runs smoothly and even quietly, without chatter or vibration. Your parts come out with very smooth edges that need a minimal amount of sanding or filing. Test pieces are helpful in finding the right balance. You can easily cut multiples of them to test various setting combinations.
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Figure 6-13. Well-formed woodchips have a slight curl












Troubleshooting


We recommend using the AtFAB project test pieces, introduced in “Test Pieces” and downloadable from the book’s website, to dial in your feeds and speeds. The test pieces are small, and because you’re already using them to fine-tune joinery fit prior to cutting the full-size project file, they’re also perfect for ironing out machine settings.


If your cuts have a rough surface finish or your bit broke halfway through cutting a part, double-check your CAM settings first, especially the number of zeros (speeds) and the decimal points (feeds). Chapter 7 will explain how to import a design file and create toolpaths in a CAM program.


After checking the numbers, or if you’re using the CAM defaults, here are some tips on how to dial in your feeds and speeds using chip load as a guide.
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Figure 6-14. AtFab furniture projects machined by Bill Young, assembled and photographed by Gary Rohrbacher




	Check Your Chips

	
After cutting a test piece, take a look at your chips. As shown in Figure 6-13, well-formed chips often have a curl to them. If they look like fine dust, then they’re too small, and your feed rate was too fast.



	Feed a Screaming Bit

	
If the machine emits a loud, high-pitched noise, or scream, as it cuts through the material, it is “hungry”; feed it by increasing the feed rate.



	Cool Tool Test

	
A tool with a feed rate that is too fast will be warm—or even hot—to the touch. After cutting a part, wait for the machine to come to a complete stop. Tools can get hot enough to burn you, so touch the bottom of the spindle first. If the spindle isn’t noticeably hot, touch the tool shank. If the tool is at room temperature, then your feeds and speeds are properly dissipating heat.



	Bracketing the Feed Rate

	
When you’re having trouble dialing in your settings, always adjust your feed rate first. A process that can help is similar to bracketing in photography. Keeping the speed the same, increase the feed rate until the part finish deteriorates; then back off and decrease the speed by around 10%.



	Feeding Too Fast

	
When a feed rate is too fast, the end-mill evacuates chips too quickly. This rapid removal prevents chips from having enough contact with the end-mill to absorb its heat. This reduced contact causes the tool to retain heat and ultimately fail. Decreasing the feed rate slows the speed of the tool along the toolpath. This decrease in feed increases the duration of contact between the end-mill and chips, so the chips adequately absorb heat before they are ejected.



	Feeding Too Slow

	
When the feed rate is too slow, the chip evacuation doesn’t keep up with the chip formation. These chips retain heat, and this buildup of heat, in combination with the forces of feed, will break your bit. Increasing the feed rate will move the end-mill more quickly along the toolpath, so that the rate of evacuation keeps up with the rate of chip formation.






Don’t be afraid of pushing the feed rate; it’s good to keep the tool moving quickly through the cut. Most bit breakage comes from cutting too slowly.




	Decrease Cut Depth

	
Cut depth is another factor that can lead to suboptimal machining. First, double-check your settings, because it’s easy to enter the incorrect numbers or put a decimal point in the wrong place. If your depth of cut is agressive, then dial it back to match your end-mill diameter.



	End-Mill Flutes

	
As the number of cutting edges increases, your feed rate should increase to prevent burning and premature tool dulling. Using more flutes reduces chip load and improves surface finish, if the feed rate remains the same.



	Spindle Speed/RPM

	
You rarely need to adjust your spindle speed. That’s probably around 12,000 RPM when cutting plywood with a ¼″ diameter two flute tool. It’s typical to pick a speed that works for your material and then adjust the feed rate accordingly, using the formulas in “Machining Variables”. However, speed is another variable that you can consider. When the chip load is too large for your tool to handle, decreasing the RPM will reduce the rate of chip formation. Alternatively, you can increase your spindle RPM to allow the tool to form chips more quickly.






In the next chapter, you’ll get hands-on with CAM software, where you’ll be able to import files, define toolpaths, and run machining simulations.

















1 A Google image search for “Bridgeport mill” will give you an idea of what an old-school, knee-and-column mill looks like.
2 PRS or Personal Robotic System
3 Under the hood, ShopBots are configured in inches per second. Either way, feed is still length traveled per time elapsed.
4 Onsrud data compiled by ShopBot and Centurion Tools
5 Router Bit Basics for CNC by Steve Glassel describes the process in detail, see Appendix A.



Chapter 7. Modeling Software to Machine



Computer-aided manfacturing or CAM software is where the virtual design converges with the physical material and machine. In the past, programming toolpaths and operating CAM software were the realm of expert machinists. Recently, however, there’s been an explosion of affordable, user-friendly CAM programs to set up your project for fabrication. “Programming toolpaths” is now far simpler than it sounds. Rather than write code from scratch, modern CAM software interfaces help you create cutting definitions for the parts you want to machine.








From CAD to CAM


As introduced in Chapter 2, a CNC uses a specialized tool called an end mill to cut and carve a digital design. The machine follows user-defined toolpaths, or instructions, that tell it where and how deep to cut. In Chapter 3 and Chapter 4, you went through the process of laying out and organizing parts into SketchUp components, and assigning 2D profiles to toolpath layers. Now you’ll create actual CNC toolpaths in a CAM program.


This chapter introduces CAM fundamentals, walking you through file setup and toolpath creation in VCarve Pro, using the AtFAB Rotational Stools SketchUp file. You’ll learn the principles and practices of file setup, toolpath settings, and machining simulation that are essential to the pursuit of digital craftsmanship.










Digital/Physical Alignment


Machining your files is exciting; your digital dreams are about to become real objects!  However, when the tidy virtual space meets reality, things can get a little messy. CAM software is where your digital “model space” meets the physical properties of your machine and material.


CAM programs are organized to help you manage the transition from digital file into reality. Before you begin importing the digital information, it’s critical to first identify the physicalities of both your machine and your material. Know the dimensions of your machine bed, as well as the length, width, and thickness of your anticipated sheet material. It’s also key to locate the XYZ origin (Figure 7-2) and orientation of the machine bed, as well as its default units. With these physical attributes identified, you are ready to start setting up a CAM file that coordinates physical machine and material with the digital information in your CAD file.

















Units


When you transition from designing to machining, you inevitably export and import files across multiple programs. It’s a good practice to pay attention to the unit settings in your file and familiarize yourself with import/export settings in your CAD and CAM software. Mixing units can cause trouble with parts that scale to the wrong dimensions or cause your machine settings to go wildly off.
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Figure 7-1. Digital CAD file origin in “model space”
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Figure 7-2. Machine origin on a ShopBot PRS Alpha CNC router




The digital/physical alignment process becomes much clearer and easier once you’ve become acquainted with the toolpath creation process as well as the specific machine you’ll be using. It’s best practice to always set up your CAM files to correspond to the bed size, orientation, and origin of the physical machine you’ll be using to cut those files. This enables you to machine with confidence, because you know exactly where the tool will cut.
























VCarve Pro


After working with many CAM programs over the years, we have grown to appreciate VCarve Pro for many reasons. Created specifically for CNC routing (not milling), it has a SketchUp plug-in that allows smooth imports, but also has the ability to open massive DXF files with ease—never crashing or choking. VCarve excels at creating and tracking the multiple toolpaths necessary for machining the projects in this book.


VCarve is widely used and easy for beginners to learn, but full-featured enough for experts. In addition, its interface changes very little between software upgrades, and there’s a free trial version available. The one drawback is that it only runs on Windows. However, don’t let that discourage you, as there are plenty of workarounds for Mac users (see “CAM Workarounds for Mac OS”).


Currently, the VCarve Pro “trial” is actually a limited version of the full software package. The trial doesn’t expire, but you’re constrained to saving your work in Vectric’s .CRV file format, and you won’t be able to send the toolpaths you create to a physical machine. That’s completely fine for the purposes of this book, because if you already have your own CNC—or have access to one in a shared shop—that machine will already have a CAM software toolchain in place. The toolpath creation principles will remain the same, regardless of software.


CAM Workarounds for Mac OS

VCarve is only available for Windows machines, and although times are changing, this is typical for CAM software. If you are running Mac OS and you have the hard disk space to install a copy of Windows, I highly recommend Parallels. In addition to creating CNC toolpaths, I use it whenever I need to run CNC machines using Windows- or Unix-flavored control software machines from my Mac. You can also use Mac’s built-in Boot Camp, Virtual Box, or another Windows emulation program.



Anna Kaziunas France












Download and Install


	
If you don’t already have Vectric’s VCarve CAD/CAM software, download and install a free trial from the Vectric site. For this project, you’ll need the Rotational Stools (Figure 7-3) SketchUp file (ATFAB_STL_D4CNC.skp), which can be found on the book’s website.
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Figure 7-3. The Lazy and Lively Rotational Stools and vectors




This file, like all project files for this book, was organized and saved as SketchUp 2014 using the same process you followed in Chapter 3. When you open the file in SketchUp, you’ll find the 2D part profiles placed onto toolpathing layers, with individual parts and the overall cut file grouped into SketchUp components. You’ll also find a fully modeled version of the Rotational Stools on 3D modeling layers.


Chapter 8 will walk you through the process of fabricating the stool parts from your finished CAM file. If you already have your material—and want to fabricate the stools after completing this CAM setup exercise—you’ll need to scale your CAD file to match your material’s thickness (TMAX). Refer to “Measure Your Materials” and “Scale Your CAD File” for details. If you’re not ready to fabricate, proceed through this exercise with the CAD file as it is.


This exercise walks you through key steps of setting up a CAM file and creating toolpaths for the AtFAB projects. For software help, you’ll find an extensive manual within VCarve Pro itself (Help→Help Contents) that offers detailed information on VCarve’s commands and features. It also provides links to Vectric’s video training resources at http://support.vectric.com.



















Open VCarve and Create a New File


	

Open VCarve Pro. You’ll see a blue sidebar to the left of the blank main window, in Figure 7-4.



	

Create a new file by selecting the “Create a new file” option from the startup screen; you can also simply click File menu→New or enter the keyboard shortcut 
Ctrl + 
N. Your new, blank file will look like Figure 7-7.
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Figure 7-4. Open VCarve Pro
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Figure 7-5. New file opened in VCarve Pro trial edition 9.009


























Job Setup


When setting up a new file, VCarve Pro prompts you to set up the job size, material thickness, position, origin, units, scaling, and modeling resolution and color options. Because other operations actually depend upon these settings, VCarve Pro (helpfully) prevents you from going further until you verify that your file is set up to match your actual machine and material.


Next, you’ll begin to align your digital file with physical reality by setting up your workspace to match your sheet material and machine cut area.

Use default Job Setup options

You’ll use the default VCarve Pro setup options for most of this exercise, but we go through the process of explaining what to enter to clarify and explain the settings.












Job Type


Selecting a Job Type (Single Sided or Double Sided) is the first step in setting up a VCarve Pro file. It also determines what settings are displayed. When you cut the AtFAB projects from this book you’ll be routing single sided jobs.


	
Keep the default setting, Single Sided, as shown in Figure 7-6.








[image: dcnc 0705 1]
Figure 7-6. Job Type
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Figure 7-7. New file with default job setup options



















Job Size


The Job Size matches the actual dimensions of your material; this exercise uses a 4′ × 8′ × ¾″ plywood sheet. The units should match the default units of your CNC machine. While Width (X) and Height (Y) can be generalized, Thickness (z) must be the actual measured thickness of your sheet material, or TMAX from “Measure Your Materials”.


	

Enter 48.0 inches for Width (x) and 96.0 inches for Height (y), as shown in Figure 7-8.



	

Enter TMAX in Thickness (z) field.







If you’re working through the exercise, without plans to machine immediately, enter TNOM—the nominal value of 0.75 inches—in the Thickness (z) field.


	

Select inches, as shown in Figure 7-8.








[image: dcnc 0706]
Figure 7-8. Job Size



















Z Zero Position


The default Z Zero option sets the z-axis origin to the surface of the material. It’s also possible to set Z Zero to the surface of the machine bed. (“Pocket Cutting: Top Down or Bottom Up?” elaborates on why you would do this.)


	

Keep the default Z Zero option selected (Material Surface, as shown in Figure 7-9.








[image: dcnc 0706 1]
Figure 7-9. Z Zero Position



















XY Datum Position


A datum is a fixed starting point of scale or operation. The datum position is intended to correspond to the machine’s origin or (0,0), which is usually set separately using machine-specific control software, but can be offset in CAM. Offsetting shifts the origin of your CAM file by a specified (x,y) amount relative to the machine bed size. Since the digital files you’re using are mapped to a full sheet, you don’t want to offset.


	

Keep the default datum options selected, shown in Figure 7-10 (unless your CNC is configured differently); “Use offset” should be unchecked.








[image: dcnc 0708]
Figure 7-10. XY Datum Position



















Design Scaling



[image: dcnc 0710]
Figure 7-11. Design Scaling




This option scales the entire size of your file relative to the Job Size (X & Y) values you entered in “Job Size”. That’s problematic for parts that were designed and scaled in CAD to be dimensionally accurate.


	

Keep the default, making sure the box is unchecked (Figure 7-11).






















Modeling Resoluton



[image: dcnc 0711]
Figure 7-12. Modeling Resolution




The modeling resolution and appearance settings are purely visual and have no effect on the toolpaths themselves.


	

Keep the default settings shown in Figure 7-12.






















Complete Setup



[image: dcnc 0712 2]
Figure 7-13. Click OK to complete the Job Setup




	

When finished, click the OK button at the bottom of the Job Setup panel, shown in Figure 7-13. The Job Setup options will automatically be replaced by the drawing panel.







After you configure your Job Setup once, VCarve Pro will remember your selections and entries. They’ll be there each time you create a new file—but you’ll still need to click OK to confirm them every time.




If you ever need to access the Job Setup menu after setup, you can reach it through the Edit menu→Job Size and Position.




Note that VCarve doesn’t prompt you to c lick the OK button. If at some point you find yourself unable to select any vectors or use any commands, it’s because you haven’t hit the OK button to close out the menu.


























Importing Vectors


With the job setup complete and physical parameters defined, you’re ready to import the Rotational Stools SketchUp file.


Download the Rotational Stools files from the book’s website. You’ll need ATFAB_STL_D4CNC.skp for this exercise.










Import Stools SketchUp File


	

Choose Select File→Import Vectors from the top menu and then navigate to the ATFAB_STL_D4CNC.skp SketchUp file you downloaded.







The SketchUp File Import window (Figure 7-14) opens with several settings to choose.

















Layout of Imported Data


Think back to when you were organizing the last step of “Save as SketchUp 2014”; after all the “part components” were laid out onto the cut sheet, you grouped them all into a final, single group. The Rotational Stools file has also been organized this way.


All project files in this book have been organized this way, just like the Chair example.




Grouping components prevents VCarve’s Auto Orientate feature from automatically re-laying out parts. When factors like grain direction and alignment matter, as explained in Chapter 3, manually arranging parts onto the sheet is preferable to depending on Auto Orientate to do the job alone.


	

Choose Exploded Flat Layout and Auto Orientate under Layout of Imported Data.








[image: dcnc 0713]
Figure 7-14. SketchUp File Import window detail



















Create Circles/Arcs


	Create Circles for Polygons

	
Since SketchUp segments circles, this setting changes circles into polylines. This that ensures the CNC machines smooth circles for holes rather than faceted shapes.



	Refit Arcs to Boundaries

	
Similar to Create Circles for Polygons, this setting turns segmented arcs, particularly in sniglets and other types of corner fillets, to approximate SketchUp arc fillets. This keeps sniglets smooth rather than faceted.


	

All boxes should be checked under Create Circles/Arcs.


























Component/Group Handling


	Group imported parts

	
For Component Handling, choose this setting to keep all SketchUp components grouped.



	Keep components starting with two underscores (__) together

	
In addition to the component handling setting, this option ensures that each component in the SketchUp file acts as a single part in VCarve. This setting allows toolpaths common to one part, but assigned to separate layers, to remain together.






You may recall using this double underscore convention to name your components in SketchUp, as we did in “Make 3D Parts into 2D Profiles”. That step ensured that these SketchUp components were imported as distinct parts in VCarve.




	

Select the first two options only, “Group imported parts” and “Keep components starting with two underscores (__) together” under Component/Group Handling.






















Data to Import


Because the Rotational Stool file was saved with only its toolpathing layers turned on, you want to select “Import all visible data in file.” The other option that imports visible data on selected layers is helpful if you want to import particular layers.


	

Choose “Import all visible data in file” under Data to Import. All the boxes should be checked.



	

Click OK to import the file. The imported file will look like Figure 7-15.





























Vector and Layer Adjustments


Importing one file format into another is always a little tricky, and as you’ve seen from all the conversion settings, there are many things that can go wrong. Once you’ve imported your SketchUp vectors, it’s helpful to check over all of the settings, vectors, and layers.


Distinct parts should appear, just as they did in SketchUp. Ensure that the vector layout in the main VCarve window matches the screenshot shown in Figure 7-15. The cut file outline should match the Job Size and orientation.


The workflow from SketchUp into VCarve typically requires a few additional adjustments. These next steps will walk you through these adjustments of aligning the cut file to the material stock, ungrouping vectors, and joining open vectors.










Align Cut file to material stock


	

If the sheet material outline does not align with the sheet in the main VCarve window, select all vectors in the file (either with the cursor or 
Ctrl + 
A).



	

Click the Align Tools option from the Drawing Toolbar→Transform Objects→Align Selected Objects icon, shown in Figure 7-15. This will align the entire cut file with the material stock that you just defined in the Job Setup.



	

Close the Alignment Tools by clicking the Close button at the bottom of the palette (Figure 7-17). You may need to scroll down to the bottom to see it.



	

Save your file as a VCarve file or CRV. Name it Rotational-Stools.crv.







When working in the blue sidebars, you’ll need to click a “Close” button at the bottom. Just like you had to click “OK” to get out of the Job Setup menu, you’ll need to click “Close” to deactivate the Drawing palettes that open up.





[image: dcnc 0715]
Figure 7-15. Rotational Stools file in VCarve Pro, use Alignment  Tools to correct sheet misalignment.
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Figure 7-16. Alignment Tools palette open, vectors aligned to material





[image: dcnc 0717]
Figure 7-17. Alignment tools “Close” button



















Ungroup Vectors


The technique of combining all 2D components within a single overall component in SketchUp preserves your cut sheet layout during import, but all parts will be grouped into a single layer as a result. On initial import, you’ll find that SketchUp layers will be black, rather than distinct toolpath layer colors, distinguishing inside cuts from outside cuts and holes.


If your file imports without its layer colors, you’ll need to release the group so that each part is placed onto its originally assigned cut layers. To ungroup parts back to their original layers:


	

Select all vectors, then from the Drawing sidebar go to Edit Objects → “Ungroup objects onto their original layers,” as shown in Figure 7-18.



	

Select only the parts; not the outside cut sheet border. Click the Zoom Selected icon, Drawing→2D View Control→Zoom Selected, to enlarge your view of the parts.


You can also ungroup by right-clicking and selecting Ungroup Objects→Ungroup objects back onto original object layers.





	

After ungrouping, the vectors take on the color of the SketchUp toolpath layers: blue for outside profiles, green for inside profiles, and red for holes (Figure 7-20).
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Figure 7-18. Ungroup objects back onto their original layers
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Figure 7-19. Select only the stools vectors and then Zoom Selected
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Figure 7-20. Ungrouped vectors return to their SketchUp layer color



















Join Open Vectors


VCarve toolpaths work best when they’re created from closed vector shapes. Diligently grouping vectors while in SketchUp usually ensures that your imported file will have closed vectors, but sometimes things don’t go as planned.


It’s possible that your part vectors are not joined together, but are individual lines in places. Luckily, VCarve has a “Join Vectors” operation that lets you quickly identify open vectors and close any open, unjoined vectors that you may have imported.


	

Check for open vectors by Edit → Select All Open Vectors. If any are open, it’s easiest to fix them one layer at a time.







	

Turn on the blue layer, Profile Outside, and turn off all other layers.



	

Select all elements on Profile Outside choose Drawing → Edit Objects → Join Open Vectors.



	

Repeat this process with the Inside Profile and with other layers.








[image: dcnc 0721]
Figure 7-21. Joining the open outside profile vectors




You can also select all by using 
Ctrl + 
A and then hitting 
J to bring up the Join menu.




If you find discrepancies with orientation, origin, or scale, it’s best to go back to your CAD file, check the origin and units, and re-import into the file.


























Creating Profile Toolpaths From Vectors


Each profile toolpath has a unique combination of cutting attributes. “Toolpaths” explained how a tool could be programmed to cut inside, outside, and on the vector. Depending on where the tool cuts, relative to the vector, the kerf shifts position, and, in turn, changes the dimensions of the part.


Before you create the toolpaths for the Rotational Stools, take a look at Figure 7-22, which contains three identical squares drawn with identical dimensions. Each square is cut with a 1⁄8″ profile toolpath, each toolpath having a different relationshp to the drawn vector.



[image: dcnc 0723]
Figure 7-22. The same size, equally spaced boxes with outside, inside, and on line profile toolpaths applied




In Figure 7-22, the red line with black arrows visually represents the path the tool will travel to machine the part. Figure 7-23 shows a 3D machining simulation of the toolpaths.



[image: dcnc 0724]
Figure 7-23. 3D machining simulation of outside, inside, and on line toolpaths in Figure 7-22




The outside toolpath creates a dimensionally accurate part, while the inside toolpath cuts a correctly sized slot. The on vector cutting option is not dimensionally accurate as a slot or a part. Avoid cutting on the vectors, unless you are etching or cutting decorative embellishments.










Rotational Stools Toolpaths


ATFAB_STL_D4CNC.skp has three toolpathing layers. The vectors that outline each part are assigned to the Profile Outside layer, the square shapes centered in each of the seats are assigned to the Profile Inside layer, and the vectors that form the fastener holes are assigned to the Profile Hole layer.


Up to this point, you have been working with virtual vectors organized onto layers—let’s turn them into actual, physical toolpaths!


To cut out the Rotational Stool’s outer profiles, you need to assign the tool to cut on the outside of the vector, creating dimensionally accurate parts that will fit together well. Conversely, to machine the Stool’s inside profiles and fastener holes, the inner dimension is important, so you’ll assign an inside toolpath that will cut on the inside of the vector.


In addition to defining the relationship between the cut path and 2D vector, toolpaths also require four other inputs: tool diameter, cut depth, pass depth, and toolpath type.


In the following steps, you’ll be using the Toolpaths menu, shown in Figure 7-24 to create three different toolpaths to handle these different cutting requirements. As you define each toolpath, it’s helpful to take advantage of your layer organization. Use the Layers List palette to isolate and assign definitions to each toolpathing layer.


The Toolpaths menu is on the right; the Layers menu is on the left.



[image: dcnc 0725]
Figure 7-24. Layers List palette on the left side, and Toolpath Operations on the right



















VCarve’s Multi-Menu Interface


VCarve Pro has top-level drop-down menus, but it also has two main blue “side menus” that both govern and demarcate CAD and CAM functionality. The left toolbar area shown in Figure 7-24 is for job setup and CAD operations. In later steps, we’ll use the right toolbar, which is exclusively for creating toolpaths.


This makes it a little confusing to note what menu an operation is under. To clarify, we’ll reference the Toolpaths menu as a top-level menu and then use an arrow to indicate the option grouping in that menu (e.g., Toolpaths→Toolpath Operations), just like we have done previously for other top-level menus.
























Fastener Hole Toolpaths


First, you’ll define toolpath settings for the fastener holes, sized for the fasteners that will be used to hold the parts of the stool together. These steps walk you through defining an inside toopath for a smaller 1⁄8″ end mill, which will cut all the way through the material.










Select Profile Toolpath Operation


	

Click the Toolpath tab on the right-hand side of the screen to open the Toolpaths blue side menu.



	

Turn on the Profile Holes layer and turn all other layers off.



	

Select all vectors on the Holes layer, 
Ctrl + 
A.



	

To define a toolpath type, select Toolpath Operations→Profile Toolpath to open the 2D Toolpath menu, as shown in Figure 7-25. Figure 7-26 shows the 2D Toolpath menu.







There’s a little thumbtack icon at the top right of both the blue sidebar menus. Click it to “pin” the menu open—or unpin it to increase the size of the file-viewing area.





[image: dcnc 0726]
Figure 7-25. With the Holes layer isolated, select all vectors and click the Profile Toolpath icon



















Open the Tool Database


	

Click the Select… button from the Tool section of the 2D Profile Toolpath menu, Toolpaths→2D Profile Toolpath→Tool, to open the Tool Database, as shown in Figure 7-27.








[image: dcnc 0727 2]
Figure 7-26. The open 2D Profile Toolpaths menu




Figure 7-28 shows the Tool Database pop-up window that will open over the main VCarve interface.
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Figure 7-27. Tool selection from the toolpaths menu



















Select 1⁄8″ Tool


VCarve has a long list of prepopulated end-mills in its Tool Database, as well as the option to define your own. Until you are fluent in CNC routing, it is fine to use the default settings assigned by VCarve.


	

Choose a 1⁄8″ diameter end-mill, Imperial Tools→End Mills→End Mill (0.125inch).







	

Click the Apply and OK# buttons. The Tool Database window will close.







This chapter provides a basic introduction to CAM by covering the basic process of creating profile toolpath options. Chapter 6 provides additional detail on feeds, speeds, and the machining process, but the focus of this book is on the design-through-fabrication process so that you can successfully fabricate the projects we cover.





[image: dcnc 0729]
Figure 7-28. Tool Database pop-up menu with default options



















Cutting Depths












Start Depth (D)


Cutting usually begins on the material’s surface, but if your material isn’t flat, is dirty, or you simply want to machine away the top layer for some reason, then you add a start depth to tell the machine how much material to remove before it begins cutting the toolpath.


	

Keep the default Start Depth of 0.0 inches. Plywood has a thin veneer that you don’t want to remove. The Cutting Depths options are located at the very top of the 2D Profile Toolpath menu, Toolpaths→2D Profile Toolpath→Cutting Depths, as shown in Figure 7-29.






















Cut Depth (C)


Setting cut depth to a small increment past your material thickness will ensure that the end mill cuts a profile all the way through. Set depth to .76” or 1/100” past the measured thickness.


	

Set the Cut Depth to 0.76 inches, or 1/100” past the measured thickness. “Show advanced toolpath options” should be checked. Because you’re just walking through the exercise, you’re using a nominal thickness (TNOM).







If you’re actually machining, remember to carefully measure the actual material thickness to calculate TMAX, as explained in “Nominal Thickness”.
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Figure 7-29. Cutting Depths menu
























Edit Passes


VCarve assigns a number of passes for the end mill to cut through the material. Depending on the thickness of your material and the size of your end mill, multiple passes may be needed to achieve the desired cut depth. Pass depth is the vertical amount of material removed by each small cut; their sum total is the cut depth.


Factors like material hardness, end-mill type, edge quality, and desired cutting time determine the number of machine passes. In this case, four passes will efficiently cut through ¾″ plywood, leaving edges that require only a light sanding.


	

Click the Edit Passes… button to open the Edit Passes pop-up menu, changing the Number of Passes at the bottom of the menu to 4.
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Figure 7-30. Tool Settings



















Machine Vectors


To cut accurately sized holes, you’ll need to create an inside toolpath that cuts on the inside of the vectors.


	

Select Inside/Left and Conventional.



	

Use the defaults for the rest of the Machine Vectors options. Keep the “Allowance offset” at 0.0 inches and keep “Use vector start points (don’t optimize)” unchecked.



	

Ignore the Tabs section below Machine Vectors. Leave the box unchecked.
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Figure 7-31. Machine Vectors menu



















Name and Calculate Toolpath



[image: dcnc 0733 2]
Figure 7-32. Click the Calculate button to create the toolpath





[image: dcnc 0734]
Figure 7-33. It’s OK to ignore the profile toolpath warning message, because it pops up every time—but always double-check the cut depth info




	

Change the toolpath name from “Toolpath 1” to “000 Inside Holes,” a name that describes attributes of the toolpath.



	

Recheck all settings then click the 
Calculate button at the very bottom of the Toolpaths menu.







By default, a pop-up warning alerts you that cut depth is deeper than material thickness. Every time you create a toolpath that cuts all the way through the material, VCarve will warn you. It’s OK to ignore the profile toolpath warning message, because it pops up every time—but always double-check the cut depth info!




You may need to scroll down to see the 
Calculate button (see Figure 7-32).



















Simulate Toolpaths


After it calculates your toolpath definition, VCarve automatically opens the 3D Window and Preview Tab, as shown in Figure 7-34. Besides allowing you to pan, zoom, and rotate the view of your sheet material, VCarve simulates your toolpath definitions through animation and visuals.


By visually showing the toolpath, or actual movements that the end-mill will make, you’ll be able to analyze the results and make any necessary corrections.



[image: dcnc 0735]
Figure 7-34. Profile toolpath created and 3D machining simulation shown




	

Zoom in and take a look around. The red lines are the X and Y, or horizontal, moves that the tool will make. The green lines are the vertical moves. The blue holes are the individual passes at different three-dimensional depths.



	

Click the tab above the visualization next to “3D View” that says “Rotational Stools” to flip back to the CAD file vector view, as shown in Figure 7-36. As demonstrated in “Creating Profile Toolpaths From Vectors”, this view shows the part vectors in red and the toolpath in pink with little arrows indicating the direction the tool will travel as it cuts.







Hold the 
Ctrl key to pan. Zoom in and out or orbit by scrolling with the mouse.





[image: dcnc 0736]
Figure 7-35. 3D simulation of machining holes, each individual pass depth is shown in blue





[image: dcnc 0737]
Figure 7-36. Two-dimensional toolpath view, zoomed in very close; the tool makes a small, tight circle inside the red, selected vector


























Seat Inside Profile Toolpaths


Next, you’ll define the Stool’s inside profiles on the seat parts. Return to the main VCarve window, to turn off the Profile Holes Layer and turn on the Profile Inside layer.


Next, you’ll create a second inside profile toolpath for the seat slots in the same way you created the fastener hole toolpaths.










Select Profile Inside Vectors


	

Close the Preview Toolpaths menu (there’s a Close button at the bottom, just like in the Drawing menu options).



	

Uncheck the 000 holes toolpath in the Toolpath List. The hole toolpaths will disappear. Unchecking a toolpath hides it from view, but it is still there and can be reselected at any time.



	

Open the Layers tab (bottom of the left Drawing menu).



	

Turn on the green inside profiles layer and hide the holes layer (shown in Figure 7-37).



	

Select all vectors on the Inside Profiles layer, 
Ctrl + 
A.







Toolpaths, once calculated, are distinct entities from the vectors used to create them. Unchecking the toolpath name from the Toolpath List will hide the toolpath, but it’s often helpful to leave it on so that you can see the relationships.





[image: dcnc 0738]
Figure 7-37. Selected seat inside profiles; the green inside profiles layer is on, and all other layers are hidden



















Create Seat Inside Profile Toolpaths


	

Create a new profile toolpath by keeping the vectors selected and then clicking the profile toolpath icon under the Toolpaths menu→2D Profile Toolpath.



	

Open the Toolpath Database by hitting the 
Select… button under the Tool section, Toolpaths menu→2D Profile Toolpath→Tool.



	

Select a 0.25 inch end mill (¼″), Tool List→Imperial Tools→End Mill (0.25 inch).



	

Enter the settings shown in Table 7-1. Any settings not specified will be left as the VCarve Tool Database default.







Table 7-1. Seat Inside Profile Settings


	Tool Diameter

	0.25 inch (¼″) end mill




	Passes

	3




	Cut Depth

	0.76”




	Machine Vectors

	Inside/Left




	Direction

	Conventional




	Toolpath Name

	000 Inside Profiles








[image: dcnc 0739]
Figure 7-38. Selected 0.25-inch tool from the Tool Database



















Simulate Inside Profiles


When VCarve automatically opens the 3D Window and Preview Tab, you will see this new toolpath added to the Toolpath List at the bottom of the right-hand menu.


	

Ensure that 000 Inside Profiles is turned on (checked) and review the animation and visuals of the vectors, and the actual cuts made by the ¼″ end mill.



	

Check that the material is cut all the way through, that the cut shapes match those in the original cut file, and that no details are obliterated by accidentally selecting a tool that’s too large.








[image: dcnc 0740]
Figure 7-39. Machine paths for inside cuts




Tabs

Many CNC fabricators use tabs, or small, uncut material bridges, to keep parts in place as they are cut, see “Tabs”. We frequently work without them, using alternative hold-down strategies or downcut tools (see “Routing Strategies”). Consider using tabs when working with small parts, narrow parts, or lightweight materials.


See the VCarve software manual, Help→Help Contents, to learn about tabs and how to place and use them. We recommend placing tabs manually, rather than having VCarve automatically add them for you.


























Outside Profile Toolpaths


Now it’s time to cut out the parts by creating outside profiles. You’ll repeat the same process of selecting vectors and then programming the toolpaths like you did previously with the inside seat toolpaths, using the same ¼″ end mill.










Turn On Layer, Select Vectors


	

Return to the main VCarve window and turn on the Profile Outside layer, 000 AtFAB stools_profile outside.



	

Select the vectors.






















Select ¼″ Tool


	

Create a new outside profile toolpath by keeping the vectors selected and then clicking the profile toolpath icon under the Toolpaths menu→2D Profile Toolpath.



	

Open the Toolpath Database by pressing the 
Select… button under the Tool section, Toolpaths menu→2D Profile Toolpath→Tool.



	

Select a 0.25 inch end mill (¼″), Tool List→Imperial Tools→End Mill (0.25 inch).






















Create Outside Profiles


	

Enter the settings shown in Table 7-2. Any settings not specified will be left as the VCarve Tool Database default.







Table 7-2. Outside Profile Settings


	Tool Diameter

	0.25 inch (¼″) end mill




	Passes

	3




	Cut Depth

	0.76”




	Machine Vectors

	Outside/Right




	Direction

	Conventional




	Toolpath Name

	000 Outside Profiles
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Figure 7-40. Isolate Outside Profiles



















Simulate Outside Profiles


VCarve automatically adds this third toolpath (000 Outside Profiles) to the Toolpath List at the bottom of the right-hand Toolpaths menu.


As before, review the animation and visuals of the vectors, spindle path, as well as the actual cuts made by the ¼″ end mill. Ensure that kerf matches the end-mill size, that material is cut all the way through, and that the cut shapes match those in the original cut file.



[image: dcnc 0742]
Figure 7-41. Run Simulation of Outside, Inside, and Hole toolpaths


























Adding Ramps


In the previous chapter, we provided a basic conceptual overview of ramping (refer back to “Ramp Moves and Tabs” if you need a refresher). This section covers ramps from a CAM perspective and provides additional information on how to add a smooth or spiral ramp to your profile toolpaths in VCarve.


	Smooth Ramps

	
VCarve makes it easy to add smooth ramps that work well for gradually easing the tool into large parts. When creating the profile toolpath for a large part, click the Ramps tab, check “Add ramps to toolpath,” and select “Smooth.” Add a “Distance” of 6.0 inches for a large part, or add 4.0 inches for something smaller, like the Rotational Stools. The machining preview will now show cyan ramping movements.






	Spiral Ramps

	
The spiral option ramps the tool into the material slowly over the complete circumference of the profile toolpath. The angle is automatically calculated to ramp from the start point to full depth over the perimeter distance around the job.






Adding a spiral ramp to profile toolpaths for small parts, like AtFAB feet, is a good way to avoid possible part movement problems. Spiral ramps help maintain vacuum hold because they keep parts lifting.




Adding smooth ramps to pockets keeps the sides nice and clean, which helps to avoid tearout on the top face.












Add Smooth/Spiral Ramps


	

Re-open the profile toolpath you created in the last section by navigating to the Toolpath List at the bottom of the Toolpaths menu and then double-clicking on the toolpath name, 000 Outside Profiles.



	

When the 2D Profile Toolpath menu opens, scroll down to the Tabs menu and then click the Ramps tab, opening the Ramps menu, shown in Figure 7-42.



	

To add a smooth ramp, click the “Add ramps to toolpath” box, shown in Figure 7-43. The default value is 4.0″. You can keep the default.







When cutting multiple passes, the ramp moves will occur at the start z height of each pass. Ramping speed happens at the plunge rate for the tool used.


If you are cutting large parts, bump the number up to 6.0″ if you’re cutting smaller parts, dial it down.




	

Re-run the toolpath simulations you created in “Simulate Outside Profiles”. Previously there were two different toolpath line colors: red and green. The red represents travel moves, and the green lines that go straight down are vertical plunges. Now you’ll see three different colored lines; the cyan colored slanting lines are the ramp moves.






Bill Young’s AtFAB CRV files

This project does not have feet, but for the other projets in this book, it helps to add a spiral ramp (Figure 7-44) to each of the feet. To see examples of smooth and spiral ramps in VCarve pro, download Bill Young’s CRV files from designforcnc.com
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Figure 7-42. The default Ramps menu, no options selected
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Figure 7-43. Smooth ramp added to toolpath
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Figure 7-44. Spiral ramp added to toolpath


























Toolpath Order


After programing these three toolpaths, it’s probably obvious that the CNC machine must make many multiple passes to complete a job. The CNC performs each toolpath operation separately, in a predefined cut sequence. Logically, one operation will need to go first, with the second and third to follow.


When assigning a cut sequence, it’s ideal to cut holes and interior cuts situated within larger parts first and then follow up with cutting outside profiles. Small, inside, self-contained cuts within larger parts are generally less likely to shake loose once they’re cut. Some overall parts, on the other hand, have the potential to shift or vibrate out of position, once cut from the sheet. By cutting the outside profiles last, you eliminate this risk for misalignment.










Define Cut Sequence


	

Turn all toolpaths on. Go to the Toolpath List at the bottom of the Preview Toolpaths menu and check all the boxes.



	

Use the up and down arrows to move the three toolpaths into the correct order:


	
000 Holes,



	
000 Profile Inside,



	
000 Profile Outside.
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Figure 7-45. Toolpath cut order is important; always cut holes first, then inside profiles, and then the outside profiles—otherwise the parts may move around, causing problems


























Simulation and Analysis


VCarve has many options for machining simulation and visualization that enable you to analyze and test your toolpath programming prior to fabrication.


Simulation is critical to preventing the digital fabrication equivalent of a typo, which can be a time-consuming, irreversible, costly mistake—compared to a misspelling on the page.










Visualize and Analyze


Using multiple kinds of visualization will help you catch errors made earlier in the workflow or design process, before you fabricate them. Experiment with VCarve’s various simulation and visualization features in the 3D view.


	Animated Simulation

	

	

Run the animated preview again, but now with all three toolpaths in the correct order.



	

Speed up or slow down the animation so that you can follow the cutting process.








	3D Views

	

	

Zoom, pan, and rotate the view to see all parts.



	

Use Remove Waste Material to examine the cut parts on their own.



	

Turn on 2D Profiles to study cut parts relative to the original vectors.
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Figure 7-46. Visualization Menu



















Quality Control


VCarve’s simulation features help you anticipate and plan for critical moments in the fabrication process, such as the time it takes each pass to complete, when the machine stops for manual end-mill changes, and the order of parts completion.


	

Use the simulations to check that all parts, including sniglets, are shaped properly, and that the tool cuts every part out in its entirety.



	

Is your end-mill diameter too big? Will it obliterate small details?



	

Determine whether the tool is cutting through the material and that all parts are included in the cut sequence. If you find errors, you can either adjust your design or increase your tool size and re-simulate before actually cutting.
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Figure 7-47. Visualization of cut parts on their own




	

Return to the Main VCarve Pro window and turn on all layers and all toolpaths so that toolpaths are overlayed onto the vectors.



	

Check the alignment and that outside and inside toolpaths are positioned correctly relative to the original vector profile, Figure 7-48.
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Figure 7-48. Toolpaths and vectors overlay with estimated times


























Save Toolpaths for Fabrication










Toolpath Summary


	

Return to the main toolpath menu, select Toolpath Operations → Summary of All Toolpaths Including Estimated Times to get the machining specifications and times for each toolpath.






















Save Toolpaths to File


	

Review these details and once satisfied, return to the main toolpath menu again to Save Toolpaths to File. Save these toolpath operations for output to Shopbot 3, or the format preferred by the CNC machine you plan to use.







If you are using the trial version of VCarve, you won’t be able to save and export toolpaths for machining, just re-save your CRV file.



















Ready to Fabricate?


While this exercise ends here, your toolpath file for the Rotational Stools is ready to fabricate. Chapter 8 walks you through the exciting next steps of fabricating and assembling your first AtFAB furniture project.



















Chapter 8. Rotational Stools




Now that you’ve learned what goes into setting up a CAM file, you’re ready to cut a pair of Rotational Stools. The following pages take you through the basics of digital technique, where the precision of the digital file meets the physical variability of material, fabrication, and assembly. This first project shows you how to create tight-fitting joinery by putting the basic concepts of measuring material and scaling files into practice. It also walks you through how to evaluate fit, and it offers simple techniques for assembly, drilling, and fastening.




	Chapter Themes

	


	
Quickstart Machining Project



	
Evaluating Joinery Fit



	
Using Fasteners



	
How to Drill Fastener Holes







	Design Files

	


	
3D: ATFAB_STL.skp



	
Cut: ATFAB_STL.dxf







	Sheet Goods

	


	
One-quarter sheet of 4′×8′×¾″ (1200×2400×19) for two stools







	Tools & Hardware

	


	
Fasteners: 24



	
Profiles: ¼″ end-mill



	
Holes: 1⁄8″ end-mill



	
Drill and bits



	
Blue tape



	
Allen wrench



	
See Appendix B
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About the Design


With a substantial amount of joinery packed into a few small, simple parts, the Rotational Stools are an ideal first project. Both stools share the same overall outer dimensions, and both are comprised of five pieces, with two part types. Each stool has four identical leg parts, which are organized into a rotational structure that interlocks into the seat (see “Structures”). What differentiates the stools is how each utilizes different types of joinery. Lazy fingers are used to join the “Lazy” stool (left), while the “Lively” (right) has tight, through connections. While originally designed as small stools, many find that the pair work equally well as mini side tables.

















Before You Begin


To cut a pair of Rotational Stools, you only need a partial sheet of 4’ × 8’ × ¾″ material. However, you may prefer to purchase an entire sheet, so you can use the surplus to prototype, troubleshoot, or experiment by cutting the project several times.


Since they are already quite small, the Rotational Stool file isn’t accompanied by a test piece (explained in “Test Pieces”), but we will employ that technique in other projects in this book. For this project, it’s possible to cut several versions from a single sheet of plywood, so you can test various CAD scaling and CAM setting combinations, and learn the variables that factor into achieving a perfect joinery fit.

















Measure and Scale


If you went through “Job Setup” without measuring your material and scaling your cut file, proceed with these steps to prepare a CAD file and CAM settings.



[image: dcnc 0801]
Figure 8-1. How to measure and scale the Rotational Stools




Refer to “Selecting Materials” for guidelines on plywoods and follow the instructions in “Measure Your Materials” to measure your sheet material and identify its actual thickness, TMAX. Divide TMAX by TNOM to find your scaling percentage (S).


Download and open ATFAB_STL.skp. Refer to “Scale Your CAD File” and scale all Rotational Stool part toolpaths by S so that they match TMAX. Import this scaled CAD file into VCarve and follow “Job Setup” to define toolpaths for your scaled file. Once you have saved your scaled toolpath operations for output, you are ready to fabricate.

















Cut and Evaluate Fit


Proceed with cutting your first set of parts on the CNC. After cutting is complete, gather all cut parts from the sheet, dust each part off, and stack similar parts together on a work surface.










Evaluate the Lazy Stool


Piece together several parts of the Lazy Stool, handling each part carefully. Hold parts so that they are squarely aligned and feel the face of a tab relative to the face of the adjacent part. Is the tab flushly aligned with the face? Or does the tab extend beyond the face (or vice versa)?


While perfect flushness between these two surfaces is your objective, the Lazy Stool will still be functional even with parts that are less than flush. The Lazy Stool has edge-to-edge and edge-to-edge-to-edge joints, which are more forgiving than the interlocking through and end-to-face connections of the Lively Stool. You won’t really know how well your parts fit until you test complex, multi-sided joinery, like the connections found in the Lively Stool.
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Figure 8-2. Cut parts for the Lazy (left) and Lively (right) Rotational Stools



















Evaluate the Lively Stool


Just as before, piece all parts of the Lively Stool together. Do the four legs interlock with a modest amount of resistance? Does the opening in the seat fit snugly over all four leg tabs? If all five parts fit squarely and stay together on their own, it means your CAM and machine settings were correct, and your CAD file was scaled properly to fit your material thickness (TMAX). Whenever you achieve a perfect fit, record your material measurements, CAD scaling, as well as your CAM settings for future reference.


	Fit is too loose

	
If the Lively Stool parts rattle around, and the tabs of your Lazy Stool extend beyond the adjacent face, you scaled your CAD file by a percentage (S) that was too large to fit TMAX (see “Scale Your CAD File”).



	Fit is too tight

	
If it takes brute force to fit the Lively Stool parts together, or they don’t fit together at all, you scaled your CAD file by a percentage (S) that was too small to fit TMAX. Turn to “Troubleshooting” for tips on how to analyze further, so you can ultimately get a perfect joinery fit.




























Troubleshooting


Don’t get discouraged when your first round of Rotational Stool or test piece parts don’t fit. When starting out, easily assembled, perfectly aligned joinery doesn’t always happen after the first or second attempt. Getting to the perfect fit simply requires additional scaling, or minor adjustments to machine settings, and re-cutting of your adjusted test pieces. This process may feel quite tedious at first. However, taking these extra steps at this stage will ultimately give your furniture square joinery, solidity, refinement, and a long, useful life. And, the more you go through the process of troubleshooting, the more knowledge you’ll gain about digital craft, and the better you will be able to anticipate. When troubleshooting, start by identifying the problem and then planning a course correction.










Measure


When you don’t get the right fit immediately, it first helps to understand the magnitude and nature of the discrepancy. Take precise measurements so that you can analyze the first outcome, and course correct. Using calipers, measure slots, tabs, and material thicknesses of several parts. Measure the overhang or underhang of a tab and adjacent face. Using a pen and painter’s tape, mark up the stool parts with your measurements and any additional notes based on your analysis.

















Analyze


Compare the material thickness measurement of your parts with the original TMAX to ensure that there wasn’t an error in your original material measurements. Once you’ve determined that the original TMAX matches your current material measurement, look for consistencies in your discrepancies. For instance, slots that are larger than TMAX are usually accompanied by tabs that extend beyond the face of an adjacent part. Both of these issues can arise as the result of a CAD file that was scaled by too large of a percentage (S).


Evaluate the edge quality of your parts. Parts that easily release from the sheet and require little sanding indicate that your tool and machine settings were appropriate. If part edges are rough, your machine settings may be a factor. Chapter 6 offers more detail on the variables that factor into ensuring quality CNC machining.

















Adjust


The extent and magnitude of your discrepancies determine where to make adjustments. CAD modifications are always a first remedy. Calculate the difference between slots and material thickness, and recalculate the scale percentage of discrepancy.


Open the CAD file and scale the entire file by this amount (see “Scale Your CAD File”). Proceed with programming toolpaths and cutting the adjusted parts exactly as you did the first time. (When troubleshooting, it helps to isolate the cause/solution and avoid multiple adjustments.) Put the newly cut parts together and evaluate the fit. Repeat this scaling and recutting process until you arrive at the ideal fit.


Modifying CAM settings is ideal when all of your parts fit, but they are only slightly greater or less than flush. When you are a hair off from a perfect fit, test combinations of machine feed, speed, and other settings in your CAM software (see Chapter 6). If these CAM setting modifications don’t correct the fit, or if part discrepancies are more significant, then further adjustments to the CAD file are required.

















Evaluate and Iterate


After making appropriate CAD and CAM adjustments, go back and rescale the original CAD file, reassign toolpaths in CAM, and recut the parts. Compare the fit of your new parts with the fit of the first round and make new notes on the new parts. Continue this process until you have achieved a flush fit. It always helps to compare and analyze each adjustment, in order to understand the relationship between scaling, machine settings, and materials.


Carefully record all adjustments to your machine settings and CAD file. Starting from the first modification you make to the original file, keep a chart of changes to the files and write settings directly on a test piece after it has been cut. Having a clear record becomes especially helpful when making multiple adjustments and evaluating several Rotational Stool versions or test pieces alongside one another.
























Assemble


After you have successfully cut a pair of Rotational Stools with parts that fit perfectly, you are ready to assemble them. Collect your parts, and very lightly file or sand any rough edges. Keep the sanding block and file parallel to the edge and don’t oversand or round the edges. Carefully dust off each part and stack similar parts together on a protected work surface. It helps to use a cloth or moving blanket, so as not to scratch the parts or damage the worktop.



[image: dcnc 0803]
Figure 8-3. Assembly diagram of the Rotational Stools




Prior to assembly, gather your hardware and matching drill bit, drill, and blue tape, as well as an Allen wrench or screwdriver that matches your fasteners. Place everything within easy reach. Lay your recently cut stool parts out in the order of assembly, with the right sides facing upward.


The Lively Stool is best assembled upside down. First, place the seat with the top facedown on your work surface. Interlock the four legs and snap the four leg tabs into the center hole of the seat. You might find blue tape and an extra set of hands especially helpful in keeping the Lazy Stool parts together during assembly. Start by placing the seat with its top facedown on the work surface. Piece all four legs together and secure them firmly with blue tape.



[image: dcnc 0804]
Figure 8-4. Lazy and Lively Rotational Stools



















Fasteners


Since the furniture joinery does most of the structural work, the lighter load on your fasteners means you have some flexibility in your choice of hardware. Fasteners ranging from wooden pegs to heavy-duty industrial fasteners to the lightest of screws will do the job and can be as minimal or as expressed as you want.


Wooden pegs, either prefabricated or cut to size from dowels, create a subtle inlay detail against plywood parts. Since pegs are glued into place, they are best used for furniture that won’t be dismantled. Peg and hole diameters should match so that the peg fits through the hole, requiring a bit of pressure. Length should be about twice your material thickness (2 * TMAX). Dowels are best inserted with a very small amount of adhesive in order to fix the furniture parts and the dowels themselves in place.



[image: dcnc 0805]
Figure 8-5. Length (2 * TMAX) and diameter (1/3 < TMAX) fasteners pass through pilot hole and into opposing part




If you intend to dismantle a piece of furniture, or you just like the ease and appearance of hardware, it’s best to use screws that are easily removed and reused. Polished finishes are often better at reflecting the furniture material, so they end up blending in to the surrounding material. Like dowels, fasteners should be about twice your material thickness (2 * TMAX). Any less and the fasteners aren’t bearing deeply enough into the material, and any longer demands more drilling and screwing than is really necessary.


Fasteners should match the hole made by your CNC router so that the shank passes through the hole with threads just grazing the interior. The screw head diameter should always be greater than the hole diameter. Select a thread diameter no greater than one-third of your overall material thickness (1/3 < TMAX), which should ideally match the hole made by your CNC router. We often work with Stafast decorative screws, particularly the small, flush-mounted SCS0540HD. With a length of about 1 ½″ and shank diameter that fits within the 1⁄8″ fastener hole, the screw is perfectly sized for ¾″ plywood parts.










How to Drill


While the CNC router predrills holes into the face material, you’ll still need to manually drill holes into the edge of the opposing part for pegs and hardware. Predrilling holes for pegs is a necessity. Though predrilling prior to screwing in fasteners may seem optional, it’s actually a good practice for many reasons. It prevents splitting of the plywood plies, and also allows a clean contact between the fastener threads and the hole. Also, you’ll have a greater choice of fasteners, if you’re not relying on self-tapping screws.


Use the hole cut by the CNC as a pilot hole, helping you perfectly locate the fastener and align your drill.




	

Piece furniture parts together and secure with blue painter’s tape (Figure 8-6).








[image: dcnc 0806]
Figure 8-6. Drill through pilot hole




	

Predrill all holes for fasteners (Figure 8-7). Start by working around the sides, before drilling seats and tops. For furniture pieces with feet, save the feet for last. Drill directly through the pilot hole cut by the CNC machine, keeping your bit perpendicular to the face. Drill into the edge of the opposing part, matching the drilling depth to the length of your fastener.








[image: dcnc 0807]
Figure 8-7. Insert fastener




	

Screw in fasteners, matching the drilling sequence. Start by securing the sides to each other first, then attach seats (or tops), and then feet (Figure 8-8).
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Figure 8-8. Tighten fastener by hand





Consider the starting point and sequence of drilling and fastening. It helps keep joinery aligned when you drill and fasten from the center of the furniture and work outward to the edges, corners, and feet. Working methodically will also help prevent missing a hole!





Be careful not to over-rotate when screwing fasteners into the material. Heads should be flush, and not pressed into the face veneer.





















Chapter 9. Cat In Bag 
ii Table




With a mere five parts that lock together with a friction fit, the Cat in Bag ii table is an elemental piece of furniture that requires no fasteners and only a half sheet of plywood. Such simplicity makes it well suited for practicing fabrication fundamentals and perfecting your techniques for joinery fit. As an advanced project, the Cat in Bag ii table serves as a blank canvas and opportunity for exploring materials and finishes.




	Project Themes

	


	
Finishes for CNC Projects



	
Working with a Test Piece



	
Friction-Fit Joinery







	Design Files

	


	
3D: AtFAB_CiBii.skp



	
Test: AtFAB_CiBii_TEST.skp



	
Cut: AtFAB_CiBii.dxf







	Sheet Goods

	


	
One sheet of 4'×8'×¾″ (1200×2400×18) for a table and tests







	Tools and Hardware

	


	
Profiles: ¼″ end-mill



	
1⁄8″ end-mill (optional)



	
Drill and bits (optional)



	
Fasteners (seven in total; optional)



	
Allen wrench (optional)



	
Drill and bits



	
Blue tape



	
See Appendix B
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About the Design


The Cat in Bag ii is a low coffee table with rotationally arranged, interlocking legs that form a frame. The tabs lock into the table top with an end-to-face connection (detailed in “Eight Basic CNC Joint Conditions”), featuring functional CNC joinery as a surface embellishment. While it may not share the volumetric and rectilinear edges found in other pieces, the Cat in Bag’s rotational structure and rounded corners do share AtFAB’s simplicity. The table’s shape emerged from design explorations for a parametrically transformable shape and structure (see “AtFAB’s Parameters”). It is where the concept for the rotational structure originated.

















Before You Begin


This project is well suited for practicing basic CNC fabrication steps and digital techniques. If you’re looking for more of a challenge, the large surface area of the table top and modest material requirements make this project an especially good opportunity for exploring materials and finishes. Refer to “Selecting Materials” and Appendix B on essential considerations in selecting and sourcing plywood and sheet materials for your project. Consult “Finishes for CNC Projects”, for finishing recommendations and techniques that are well suited for CNC furniture projects.


If cutting a single table, the cut file uses one 4′×8′ sheet of plywood and provides plenty of surplus material for cutting test pieces and testing out finishing techniques. However, if you’d like to cut two tables from a single sheet, you’ll need to purchase additional surplus material for test cuts and finish experiments.


Because its parts friction-fit together without the need for glues or hardware, the Cat in Bag ii Table is the only project in this book that you can make without fasteners. If you like the detail of mechanical fasteners or dowels, or would like the extra reinforcement, the cut file includes holes on each of the legs and the top. If you plan to use fasteners, ensure that you purchase the seven required fasteners that functionally and visually coordinate with both your material and finish.


Download the two required files for this project, AtFAB_CiBii.skp and AtFAB_CiBii_TEST.skp.

















Finishes for CNC Projects


In most cases, furniture made from raw plywood parts isn’t especially durable over the long term. A protective coating not only allows a piece to stand up to dust, impact, and even weather, but it also gives you a chance to customize your furniture project to suit a particular environment. Since material thickness has an impact on joinery fit, it’s best to work with finishes that add minimal thickness to the furniture parts.


Even with this limit, there are many finish options and an infinite array of techniques to explore. Regardless of what finishes you use, it’s helpful to test any finish prior to making your final project so that you can practice application techniques and get an idea of the final product. It’s also critical to review manufacturer instructions on application techniques and safety.


	Oil and Wax

	
A simple combination of tung oil and beeswax on veneer plywood adds a barely perceptible amount of thickness to the sheet material. Oiling and waxing need to be done somewhat regularly on a finished piece of furniture, but the fragrance and tactility of natural oils and waxes can make it quite an enjoyable process.



	Translucent and Clear Coatings

	
Permanent clear finishes will protect parts from dust and scratches, and sometimes even moisture or sun exposure. Wipe-on acrylic and polyurethanes require multiple coats, but they soak in and add a minimal thickness to cut parts. When applied sparingly in advance of a clear coat, stains, analine dye, and milk paint provide a rich, translucent color that allows the grain to come through.



	Painting

	
Applying latex or oil paints is another option. Spraying is much less labor-intensive than working with a paintbrush, and allows you to build up a painted coating, while controlling the thickness. With a paint booth and some practice, it’s even possible to achieve a shiny, lacquered coat of hard-wearing enamel. Since paint thickness affects the fit of joints, it’s especially critical to paint test pieces and calibrate joints before cutting a final furniture piece.







[image: dcnc 0901]
Figure 9-1. Color-blocked table




	Color, Then Cut

	
Another way to introduce color into a project is to prepaint the plywood sheets prior to cutting parts on the CNC router. Allow the paint to thoroughly dry or cure overnight, and the CNC end mill leaves a very clean, crisp raw edge that contrasts with the painted face.



	Color Blocking

	
Color and finish also don’t necessarily need to be applied to an entire piece of furniture. With the help of masking or stencils, you can apply color blocking, stripes, or patterns onto a furniture piece after fabrication and assembly, as shown in Figure 9-1.






Most products indicate the amount of surface coverage right on a package, making it easy to figure out how much finish you need when working with flat parts. Simply calculate the surface area of both sides of all 2D parts and select the correct amount of product.



















Partial Prototyping: Using a Test Piece


The Cat in Bag ii Table (and the projects we’ll work on after it) involves much more material and cut time than the Rotional Stools. Although the measuring and scaling process is intended to produce flush-fitting joinery, what happens if you’ve incorrectly recorded material thickness or accidentally scaled by the wrong factor? Testing the joinery fit with a small, partial prototype, or test piece (introduced in “Test Pieces”), is an important step that will help prevent cutting an entire table with incorrect settings—avoiding frustration and material waste.


The Cat in Bag ii test piece, shown in Figure 9-2, simulates the critical joints where the tabletop and interlocking legs intersect. Since the test piece is much smaller in size than the table, you can easily cut several versions of them (if necessary), in order to establish the settings for a perfect fit.


Next, you’ll walk you through the process of using a test piece. You’ll scale the test piece CAD file (AtFAB_CiBii_TEST.skp), define CAM settings, cut the test piece from your material stock, and evaluate the parts for a proper fit.


After you have a test piece with joinery that fits perfectly, you’ll apply those exact CAD scaling and CAM settings to the table file (AtFAB_CiBii.skp) and confidently proceed with cutting the table from your material.



[image: dcnc 0902]
Figure 9-2. Test piece for Cat in Bag ii Table












Measure and Scale


Before beginning the digital/physical alignment process, review “How to Digitally Dial In Joinery Fit”. Because we’re still getting started and this is your first time using the test piece, we’ll go through the process in detail so it’s clearly explained for subsequent projects.



[image: dcnc 0903]
Figure 9-3. How to measure and scale file



















Measure Material


	
Once you have the sheet goods for your table, you’ll need to accurately measure the material’s thickness with calipers at several points (TA, TB, TC, TD), shown in Figure 9-3.



	
Record each thickness measurement as you take it, the largest measurement is TMAX—your actual material thickness.






















Scale Test Piece CAD file


Next, you’ll divide TMAX by TNOM to define your file scaling percentage or S. You’ll scale the Cat in Bag ii CAD files by S to match your material thickness, starting with the vectors in the Cat in Bag ii test piece file (AtFAB_CiBii_TEST.skp).


To visualize this relationship as an equation:


[image: upper S equals StartFraction Actual Material Thickness Over Nominal Material Thickness EndFraction]



Or:


[image: upper S equals StartFraction upper T Superscript MAX Baseline Over upper T Superscript NOM Baseline EndFraction]



Remember that for the nominal ¾″ material used in this project, TNOM is equal to 19mm (or 0.748031 inches).


Plugging TNOM into the metric equation looks like this:


[image: upper S equals StartFraction upper T Superscript MAX Baseline Over 19 mm EndFraction]



And here’s the Imperial equivalent:


[image: upper S equals StartFraction upper T Superscript MAX Baseline Over 0.748031 quotation-mark EndFraction]



	
Open the AtFAB_CiBii_TEST.skp CAD file in SketchUp.



	
With only toolpathing layers turned on, select all the vectors.



	
Scale all toolpathing vectors by S, so they match TMAX.



	
Save As SketchUp version 14.



	
Rename the file adding the amount scaled to the filename (e.g., AtFAB_CiBii_TEST.9867.SKP).






















Assign CAM Settings


Next, you’ll define CAM toolpath settings and sequences, following the steps outlined in “Job Setup”.



[image: dcnc 0904]
Figure 9-4. Single test piece on the cut sheet




	
Open VCarve and import the scaled test piece file (e.g., AtFAB_CiBii_TEST.9867.SKP). Be sure to place the test piece vectors at one end of your material stock (Figure 9-4), preserving as much open area on the sheet as possible. This will make setup easier when you’re ready to cut your table later.



	
Save the CAM file (e.g., AtFAB_CiBii.CRV).



	
Assign toolpaths to each part. Like the Rotational Stools, the Cat in Bag ii and this test piece have outside toolpaths that cut around the outside of the parts, and inside toolpaths that cut inside the tabletop-slots.







Omit programming the holes layer, unless you plan on using fasteners.




Remember that cutting on the correct side of the vector is crucial to ensuring that parts fit. An inside toolpath cuts on the inside of the tabletop slot and removes the correct amount of material so that tabs on each leg fit within the slot.


When assigning toolpaths to the test piece, consider the sequence of cutting slots or details situated within larger parts. Like the Rotational Stools, cutting the inside toolpaths prior to cutting out the outside profiles ensures that the slots maintain their proper alignment within the part. If you cut the tabletop first, you run the risk of the part vibrating out of position. Even the slightest shift in position will lead to misaligned slots that get cut during a later pass. The proper sequence ensures that slots and holes are properly aligned within every table part.


	
Run and analyze the toolpath simulation.



	
Save the test piece toolpath operations for output and proceed with cutting the parts.







Since the objective of the test piece is to match your CAD file to your actual material, be sure to cut your test piece from the same material sheet that you’ll be using for the Cat in Bag ii.



















Evaluate Your Test Piece


After cutting your test piece, it’s time to evaluate the fit. To analyze your test piece joinery, repeat the same basic process that you used to evalute the Rotational Stools in “Cut and Evaluate Fit”.


	
Remove all test piece parts from the cut sheet.



	
Put the test piece together.



	
Confirm that through connection fits with a slight amount of resistance.



	
Check that end-to-face connection is flush.



	
If parts don’t fit correctly, consult “Troubleshooting”.



	
Test hardware or dowels with fastener holes (optional, if you’re using fasteners).








[image: dcnc 0905]
Figure 9-5. Completed test piece with optional fasteners



















Prototyping Finishes


Use your test piece to test the finish and also to evaluate the fit with the finish.


	
Apply finishes according to the manufacturer’s instructions.



	
Once the finish has dried, assemble the test piece.







If the parts don’t fit, it’s because your finish adds too much resistance or thickness. To solve this problem, rethink your finish application technique. Or, if you can’t reduce the finish thickness, you can make CAD and CAM adjustments to accommodate it.




	
Refer to “Troubleshooting” and make additional test pieces until you finally achieve an optimal fit with your finished parts.






















Record Settings and Adjustments


Once you have a successful test piece, make a note of all the settings, adjustments, and finishing techniques that combined to produce a perfect fit.


	
If you made additional CAD scaling adjustments, calculate the original percentage adjustment with any additional scaling adjustments.



	
Save only the VCarve file with the toolpath settings that produced the successful test piece (e.g., AtFAB_CiBii.CRV).



	
Outline the steps or techniques that yielded the nicest finish on your test piece parts. With this information, you’re ready to cut your table with the confidence that every piece will fit perfectly together.







As shown in Figure 9-6 the Cat in Bag ii Table layout can nest two tables onto a single sheet. If this is your first time using a test piece, however, we recommend cutting one table and using the remaining extra half sheet for cutting multiple test pieces.





[image: dcnc 0906]
Figure 9-6. Placing test piece on far end leaves clear area for cutting additional test pieces and table parts


























Apply Test Piece Settings to the Full-Scale File


Now that you’ve cut a functional test piece, it’s time to put those settings to work on the table files.


	
Return to SketchUp and open AtFAB_CiBii.skp.



	
Scale the CiBii toolpath layers in SketchUp to match the successful test piece.



	
Follow the steps in “Scale Test Piece CAD file” and save the scaled CAD file for import into VCarve.



	
In VCarve, reopen the saved test piece file (e.g., AtFAB_CiBii.CRV).



	
Delete the test piece parts from the work zone.


Since toolpathed vectors aren’t needed after cutting a successful test piece, you can delete test piece vectors from the VCarve work zone. If you want to keep the test piece vectors, keep them out of the way by either placing the vectors on a separate layer or saving a copy of the file.









When you deleted the test piece vectors, the inside, outside, and (optional) hole toolpaths that you already defined/adjusted remain in the file. You can now apply the toolpaths and cut sequence that produced a perfectly fitting test piece to the vectors of the CiBii file, once you import them.


	
Import the scaled CiBii CAD file, ensuring that the table parts are placed on the free, uncut zone of your material stock. Refer to CAM setup steps in “Job Setup”, as needed.



	
Assign the defined inside, outside, and optional hole toolpaths to vectors.







You can assign old toolpaths to newly imported vectors by clicking into the toolpaths menu and selecting the appropriate toolpath type from the Toolpath List.




	
Order toolpaths into correct cut sequence: inside profiles first, outside profiles second.







If you’ve chosen to keep the optional holes, cut them first. Remember that they need to be cut with a 1⁄8″ tool, so you’ll need to run that  toolpath alone and then change to a ¼″ tool to cut the profiles.




	
Save toolpath operations for output to your CNC machine.















Cut and Finish


	
Fabricate the parts by sending the toolpaths to the machine.



	
As you cut your Cat in Bag ii Table parts, clean and store them as they come off the machine. It’s especially critical to handle parts carefully, so they don’t get damaged during fabrication.



	
Brush sawdust from each part with a non-abrasive brush, ensuring that you remove dust from sniglets (and holes). File or lightly sand part edges as necessary.



	
Store your parts carefully, either laid out flat on a blanket or stacked with protective paper, fabric, or foam sheets between parts. Clean and prepare parts according to finish manufacturer instructions.



	
Apply the finish to each part, based on your earlier evaluations of the test piece.



	
Store the parts in a protected area and make sure the finish has dried or cured completely.








[image: dcnc 0907]
Figure 9-7. Cat in Bag ii Table parts, ready for assembly


























Assembly


The Cat in Bag ii Table assembly diagram is shown in Figure 9-8. Prior to assembly, cover your work surface with a moving quilt, or something similar, to protect both the table and work surface.



[image: dcnc 0908]
Figure 9-8. Assemble the Cat in Bag Table upside down




	
Place the tabletop facedown on the protected work surface.



	
Slot the four legs into each other, holding them together by hand.



	
Place the leg assembly tabs into the tabletop slots.



	
Pull up a seat, grab a cold one (and a coaster), and enjoy!







If you’re using fasteners, refer to “How to Drill” for tips on drilling and securing hardware. Start drilling around the legs first and follow up by drilling the tabletop onto the rotational frame.














Part III. 2D & 3D Modifications



The 5-30 Minute Chair and 90-Minute Lounge Chair projects introduce intermediate fabrication techniques, and methods for customizing furniture files within your CAD program. Both projects walk you through how to modify an existing design, by either tailoring two-dimensional parts or resizing the three-dimensional model. Both projects also show you essential steps for working with and fabricating modified designs.





Chapter 10. 5-30 Minute Chair




The 5-30 Minute Chair is the original volumetric design that kicked off the AtFAB furniture collection—and it’s become our most popular file download. Since its creation several years ago, a global community of makers on six continents has accepted our invitation to interpret, customize—and sometimes radically transform—this basic composition. We offer it it up to you in the hope that you’ll continue to evolve it, shaping it into your own unique seating design and sharing it with others.



[image: dcnc 10in01]







	Project Themes

	


	
2D/3D CAD Modifications



	
Scale Prototyping



	
Adding Feet







	Design Files

	


	
3D: AtFAB_CHR.skp



	
Test: AtFAB_CHR_TEST.skp



	
Cut: AtFAB_CHR.dxf







	Sheet Goods

	


	
One sheet of 4′×8′×¾″ (1200×2400×19) for a chair and tests







	Tools and Hardware

	


	
Fasteners (30 in total)



	
Drill and bits



	
Profiles: ¼″ end-mill



	
Holes: 1⁄8″ end-mill



	
See Appendix B




















About the Design


In Chapter 2, we thoroughly explained the origins of the AtFAB 5-30 Minute Chair and the thinking behind its design. The Chair combines edge-to-edge joinery, symmetrical parts, and tapered legs to yield an incredibly strong and sturdy side chair.

















Before You Begin


For this project, you can choose to make the design as it comes, fabricating a pair of chairs from a single sheet of plywood. Or you can learn how to make 2D and 3D CAD modifications, to tailor your chair’s details or dimensions. This chapter teaches you how to think through making 2D customizations to individual parts, as well as more significant 3D transformations that widen the chair into a bench. But, before you begin making design decisions, it’s important to develop a program.










Develop a Program


A program (first introduced in “Define a Project Program”) is a list of requirements or accommodations that a design must address. It’s rather obvious that a chair’s primary program is to provide seating. However, a broader and more detailed understanding of its anticipated use will steer your decisions about materials, finishes, and modifications. Making consistent choices results in a more thoughtfully and thoroughly considered object.


When you begin a project, consider a wider array of requirements to generate a detailed program. Start by thinking through where and how you’ll use your chair. Do you need a single chair, a bench, a pair of chairs, or a chair with special details? Think about where it will be used. Will it go into a formal or casual environment? Will it get a lot of use? Might it get moved around? In addition to functional accommodations, a program should also include quantitative requirements like a budget or critical dimensions. If you plan on modifying your chair into a bench, measure the space you’re going to put it in, as well as any adjacent furniture items, like a table.


This well-defined program not only enables you to produce something that suits its future function and surroundings, but it also helps you make smart decisions along the way. Even the most simple project can overwhelm you with decisions about what materials to use or how to customize a design. A program helps you narrow your choices to support a consistent end result.



[image: dcnc 1001]
Figure 10-1. Chair layouts, with and without test pieces



















Select Materials


Refer to your program to help you evaluate material options from both a functional and an aesthetic standpoint. A clear idea of formality, durability, and budget makes it much easier to make decisions about material type and quality, finishing techniques, and fastening methods. Refer back to “Selecting Materials” if you need a refresher on how to evaluate materials. For additional information on selecting and sourcing materials and fasteners, consult Appendix B. “Finishes for CNC Projects”, which outlines how to select and apply finishes.


A single 5-30 Minute Chair requires only half of a 4′ × 8′ sheet of plywood. If you’re cutting one chair, you’ll have plenty of room for test pieces. If you are cutting two chairs from a single sheet, you will need to purchase surplus material for test pieces. If you are customizing dimensions, you’ll need to calculate your material quantities, after you finalize your 2D parts’ layout. Most bench sizes will fit on a sheet and a half of material, leaving room for cutting test pieces.
























Design Decisions: 2D and 3D Modifications


If you’d like to fabricate a single or pair of side chairs as they are, skip ahead to “Measure and Scale” and proceed through the project steps. If you are already familiar with your CAD software and interested in modifying the 5-30 Minute Chair design decide what alterations will best tailor your chair to suit. This project introduces two ways of making alterations to the chair project files in CAD.










2D Design Transformations



[image: dcnc 1002]
Figure 10-2. Queen Anne Chair by Tree on a Hill Workshop




The simplest way to alter a design is to adjust the 2D toolpathing profiles to change the shape of individual parts. For instance, if you expect to move a chair around frequently, cutting a handle-sized slot into the chair back will make it easier to carry. You can also draw a pattern or monogram on one or several chair parts, or even make more radical alterations by altogether changing the shape of individual parts.


Greg Flanagan, founder of Tree on a Hill Workshop, modified the AtFAB 5-30 Minute Chair in a Queen Anne style. The chair’s flourishes (see Figure 10-2) came from modifying the part profiles between the joinery connections. Finished in brighly colored analyne dye, Greg’s Queen Anne chair was exhibited at the 2014 San Mateo Maker Faire, winning a coveted Editor’s Choice award.


Working entirely in 2D, Greg modified each of the original vectors in the cut file, adding graceful and intricate curvilinear details to every part. Greg factored his end-mill diameter into the vector shapes, so the resulting cuts would match every flourish in his CAD drawing. While he took great liberties with the shape of each part, he preserved the chair’s original proportions and joinery connections.


Working exclusively on 2D modifications within the 2D and leaving the functional features intact frees you up to experiment with aesthetic details. To get a closer look, you can find a link to Greg’s file on the book’s website, or try your own modifications on the toolpathing profiles in AtFAB_CHR.skp.

















3D Design Transformations


Working strictly in 2D is best when your changes involve modifying only individual parts. But, if you want to make substantial design changes that affect multiple parts or impact joinery, you get much more control by working in the 3D model. Working in 3D allows you to precisely stretch the parts of a chair into a bench, with dimensions that match a wall or dining table. You’ll be able to see the proportions of your adjustments, ensure that all parts are modified consistently, and preserve the joinery connections.

















Working with Scale Prototypes


When making 2D or 3D CAD modifications, a scale prototype helps you evaluate your changes prior to delving into fabrication. Review “Scale Prototypes” for details on how to use scale prototypes as analytical tools and for quality control.


If you’re making 2D modifications, you can thoroughly examine the composition of each part relative to the whole chair. For more substantial 3D modifications, covered in Chapter 11, creating a prototype helps you to analyze the aesthetic and functional impacts of your new proportions. When elongating the chair into a bench, you can check that the width of the seat doesn’t cause flexing.



[image: queen anne prototype stool sized]
Figure 10-3. Scale prototype of the Greg’s Queen Anne Chair paired with Anna’s first stab at a Lazy Queen Anne Stool




Once you’ve determined that detail modifications work aesthetically and that new proportions maintain structural integrity, you are ready to prepare for fabrication of the project at full scale.



[image: dcnc 1006]
Figure 10-4. Laser-cut plexiglass chair prototypes



















Exercise: Transform the Chair into a Bench


This exercise walks you through conceptually elongating the AtFAB chair 3D model into a bench, using the SketchUp workflow outlined in Chapter 3. You’ll model in 3D while simultaneously seeing your modifications in the 2D part layout, or vice versa.


Reference Chapter 3 for a refresher on working with components, laying out parts within the sheet boundary, assigning layers, and making 2D toolpathing profiles.





[image: dcnc 1004]
Figure 10-5. When widening the chairs’s overall width, keep the seat slot width to half of the new overall width




Based on your earlier measurements and program definition, define your desired bench width (W).


	
Download and open AtFAB_CHR.skp.



	
Turn on the 3D modeling layer 000_AtFAB Chair, the flatten layer 000_AtFAB Chair cut, and the underlay layer 000_AtFAB Chair under.



	
Define the desired bench width (W).


Move one of the side parts, so the distance from outer face to outer face matches (W). Ensure that you keep this part aligned with the other side part.



	
Widen the rear leg part, aligning the joinery on the sides with the joinery of the side part.


Widen the front leg part, keeping the tab on the top edge in the center of the part.



	
Widen the seat, aligning slot the in the seat to the front leg tab.



	
Widen the seat back, bringing the joinery into alignment with the side part.



	
Analyze the overall proportions of the bench, and adjust as needed.



	
Center the seat slot and front leg tab, keeping the dimensions of the center tab to less than (W/2).



	
Once you are satisfied with your modifications, rearrange the 2D layout of parts and prepare the profiles for toolpathing (referring to steps in Chapter 3).



	
Turn off all the layers except the toolpathing layers.



	
Save your file, giving the filename a suffix to reference your modifications (e.g., AtFAB_CHR-bench-mod.skp).







Although the 3D modification exercise ends here, your bench file is ready for import into VCarve, where you can prepare the toolpaths for fabrication. You can proceed with the next steps and make a bench, or stick with the original chair file, AtFAB_CHR.skp.
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Figure 10-6. How to transform a chair into a bench


























Measure and Scale



[image: dcnc 1007]
Figure 10-7. Measure the material and the scale file




Once your design modifications are complete and validated with a scale prototype, or you are working with the original chair file, you are ready to prepare for fabrication.


	
Once you’ve procured your sheet material, review “How to Digitally Dial In Joinery Fit”.



	
Thoroughly measure your sheets, recording TA, TB, TC, TD, as illustrated in Figure 10-7.



	
Calculate TMAX, your actual material thickness.



	
Divide TMAX by TNOM to calculate your file scaling percentage (S).







For detailed information on measuring and scaling, refer to “Measure Your Materials” and “Scale Your CAD File”.




In the next steps, you will scale the test piece CAD file by S, create the toolpaths, cut the files, and evaluate how well the parts fit together.

















Create the Partial Prototpye


With your material measurments confirmed, and your scaling percentage calculated, you’re ready to create a partial prototype (test piece) to confirm that your full-scale chair will fit together properly.


	
Visit the book’s website to download the 5-30 Minute Chair test piece (AtFAB_CHR_TEST.skp).







The chair test piece simulates the connections, where the front part tabs into the seat, and the back and seat slot into the side part. Regardless of any modifications that you’ve made to the CAD file, this test piece should still simulate critical fit conditions. A successful test piece helps you confirm that your CAD and CAM settings will work with your material.


	
Consult “Prototyping” and “Test Pieces” about how to work with test pieces and consult “Partial Prototyping: Using a Test Piece”, which covers how to prepare, cut, and evaluate a test piece.
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Figure 10-8. Test piece in context












Prepare File


	
Open the file in SketchUp and scale all of the 2D parts by S. Select Save As, adding the percentage to the filename (e.g. AtFAB_CHR_TEST_9842.skp).






















Prepare Toolpaths


	
Following the steps in “Job Setup”, import the scaled test piece file into VCarve. Locate its parts on a clear area, where they won’t interfere with the chair parts you cut later, similar to the layout shown in Figure 10-9.
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Figure 10-9. Test piece on the cut sheet




	
Define three toolpathing layers:



	
Outside toolpaths cut around the outside of all chair parts.



	
An inside toolpath cuts the slot in the chair seat.



	
The holes toolpath for fastener holes uses a smaller end-mill. Assign the outside and holes to the test piece.











While the test piece does not use an inside toolpath, it helps to define it now so that you can apply it to the actual chair parts later.




When programing the cutting sequence, cut the fastener holes prior to cutting the outside profiles (Figure 10-1). This order ensures that details like the fastener holes will stay aligned within the parts as they are cut. Since the fastener holes require an end-mill change, it also makes sense to position them first in the cut sequence so that you only need to change a tool once.

















Cut, Assemble, and Evaluate


	
Save the toolpath operations for fabrication and cut out the parts.



	
Assemble the test piece using Figure 10-8 as a guide.



	
Evaluate the fit. If your test piece joinery is too loose or too tight or doesn’t match the fit described in “Cut and Evaluate Fit”, consult “Troubleshooting” for additional techniques and steps for achieving an optimal fit.



	
Continue cutting test pieces until you are satisfied with the joinery. Make a note of the scaling adjustment, and save the final VCarve file (e.g., AtFAB_CHR.crv) that yielded the successful test piece.







If you’re planning to paint or add a finish to your chair, finish all the test piece parts to test the effects of your finish on the fit of the joinery.


























Adjust and Cut Chair


After you’ve cut a test piece with a good fit, you’re ready to proceed with cutting your Chair.


	
Return to SketchUp and either open your modified file or download and open the 5-30 Minute Chair file (AtFAB_CHR.skp).



	
Scale the 2D parts by the exact scaling adjustments of your successful test piece.



	
Open the test piece VCarve file, delete the test piece parts, and import the Chair file.



	
Assign the toolpaths to the appropriate vectors. Simulate your toolpathing, check the cutting sequence, and evaluate the resulting parts.



	
Export toolpath operations for machining. Proceed with cutting the chair parts with your CNC router.








[image: d4cnc 03 fin parts assembly]
Figure 10-10. Assemble the chair on its side




In addition to the outside and holes toolpaths, you will now apply the inside toolpath to the slot in the seat. Ensure that the inside toolpath comes second in the cut sequence.




	
Dust the cut parts as they come off the machine and file or lightly sand the edges as necessary. Store your parts carefully.



	
If finishing your chair, ensure that the finish has thoroughly cured prior to staging it for assembly.






















Assemble



[image: dcnc 1013]
Figure 10-11. Attaching feet and fasteners




Assembling the chair is relatively intuitive, and the sequence of assembly can happen in a variety of ways.


Prior to assembly, consult “How to Drill” (for tips on how to fasten and drill) and gather all of your tools (drill, blue tape, screwdriver) and hardware. Lay all the parts out, so they are within easy reach. Protect your work surface, as well as all parts, during this process.


It’s easiest to start assembling a chair on its side (Figure 10-10), on a large workbench, or on the floor. When predrilling holes (see “How to Drill”), rotate the chair to ensure that you have enough leverage to keep the drill square. You can manage the process alone, although it always helps to have assistance.


	
Piece the entire chair together, using blue painter’s tape to secure the parts. Ensure that all the parts are square.



	
Working around the chair, predrill the holes for fasteners. Start with the legs and work upward toward the seat back.



	
Screw in the fasteners. Start by securing the legs to each other first and then work up toward the seat and back.



	
Turn the chair upside down to predrill and fasten all four feet (Figure 10-11).



	
Turn your chair upright.



	
Take a seat, and enjoy!

















Chapter 11. 90-Minute Lounge Chair




The 90-Minute Lounge Chair was named for its ability to comfortably accommodate sitting for long durations. For an unupholstered, uncontoured chair made of flat parts, the lounge is deceptively comfortable. Its seat and back are positioned and proportioned to balance your body in a relaxed posture. This project introduces new machining and assembly techniques. We’ll walk you through the process of milling a pair of pockets into each of the chair’s sides, making the matching hardware keys that lock parts into place, and fabricating a jig that you’ll use during the assembly process.




	Project Themes

	


	
Pocket Cuts



	
Fabricating Hardware Keys



	
Making and Using an Assembly Jig



	
Simple 3D Transformations







	Design Files

	


	
3D: AtFAB_LNG.skp



	
Test: AtFAB_LNG_TEST.skp



	
Jig: AtFAB_LNG_JIG.skp



	
Cut: AtFAB_LNG.dxf







	Sheet Materials

	


	
Two Sheets of 4′×8′×¾″ (1200x2400x19) for one chair, tests, and jig







	Tools & Hardware

	


	
Fasteners (36 in total)



	
Drill and bits:



	
Profiles: ¼″ end mill



	
Holes: 1⁄8″ end mill



	
See Appendix B
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About the Design


The key features of the 90-Minute Lounge Chair include numerous end-to-face joints that manifest as slots and tabs (see “End-to-Face”). It utilizes both structural and decorative marquetry throughout its nine interlocking symmetrical parts.


Like the 5-30 Minute Chair, you can make the Lounge Chair as originally designed—or you can modify its flattened 2D parts in CAD, or even work in 3D to elongate the chair into a love seat.


This project introduces new machining techniques: we’ll walk you through the process of milling a pair of pockets into each of the chair’s sides—and making the matching hardware keys that lock parts into place. You’ll also learn how to make a jig to use in the assembly process.

















Before You Begin


Before starting the project, give some thought to where and how your 90-Minute Lounge Chair will be used. Refer to “Develop a Program” for tips on how to develop a thorough program for your Lounge Chair. Will your chair sit alongside a lamp and side table in a corner? Might it be one of a pair? Will it sit in the middle of a room, seen from all sides? Will it be used outdoors? Might the chair work better stretched to fit two or three? What are the dimensions of the space or things around it?


Use your program to steer your decisions about the quality of materials, the finishes and fastening methods to use, and the desired alterations to the original cut files.










Select Materials


Look to your program as you select your chair’s materials and thoroughly consider the chair’s materiality relative to modifications, details, and proportions. Refer to Appendix B on how to select and source materials and fasteners, as well as “Finishes for CNC Projects”, if you plan to finish your chair.


The Lounge Chair parts are laid onto two 4′×8′ sheets, in order to align grain direction on the seat and seatback, and to orient the parts so that the grain wraps around the front, back, and sides of the chair. This layout leaves ample surplus space on each sheet to cut test pieces or the chair’s assembly jig (explained in “Using the Jig”).


When you have extra material on a sheet, sometimes it makes sense to cut parts for a small project, like the Rotational Stools in Chapter 7.


























Design Decisions: 2D and 3D Modifications


For information on how to customize your design in CAD, refer to “Design Decisions: 2D and 3D Modifications”. As a three-dimensional, volumetric furniture piece, the 90-Minute Lounge Chair is a complete project on its own. As with the 5-30 Minute Chair, you can further tailor the lounge to suit, by either modifying the flat parts or transforming the 3D model in the CAD file.










2D Modifications



[image: dcnc 1101]
Figure 11-1. Dot Pattern laid out onto the seat back of custom Lounge Chairs built for MakerBot Industries HQ




The Lounge Chair seat and seat back offer large surface areas for cutting, etching, or pocketing 2D embellishments or patterns. Figure 11-1 shows a version of the Lounge Chair, customized for Makerbot Industries. A pattern of circles, drawn directly onto the 2D parts in the CAD file, stretch across the seat and seat back. Toolpathed and milled as pockets (see “Create Pocket Toolpaths”), the circles received colorful, 3D printed marquetry, made by Makerbot’s Botfarm.


To make 2D modifications, simply open AtFAB_LNG.skp and draw directly on the appropriate toolpathing layer. Refer to Chapter 3 for preparing the modified CAD file for toolpathing in your CAM program. Save the file.


Make a Scale Prototype

Since the 90-Minute Lounge Chair is three-dimensionally complex, a prototype helps you see the overall composition of added patterns and details in ways that you may have not visualized on the CAD screen. It also gives you a chance to empirically evaluate the structural integrity of more substantial modifications, like elongating the seat. Refer to “Scale Prototypes” on preparing scale prototypes.


Since it’s nearly impossible to laser-cut pockets to a specific depth, skip cutting the keys.





[image: dcnc 1102]
Figure 11-2. Laser-cut Lounge prototype





















Exercise: 3D Transformations


The 90-Minute Lounge works well in many different widths, performing admirably as a two or even three seater. Elongating the lounge follows the same steps outlined in “3D Design Transformations”.


	
Working in AtFAB_LNG.skp, widen the Seat, Seat Back, Arms, Front Leg, and Back Leg components by (W), keeping the Feet and Side components untouched.



	
As shown in Figure 11-3, keep the slots and tabs in the Seat and Seat Back centered, and ensure that their length is no more than half of the overall seat width (W/2).



	
Once you have made the desired modifications, follow the steps outlined in Chapter 3 on organizing the CAD file with parts organized in 2D and 3D.



	
Rearrange all the flat part components onto cut sheets, so that they are oriented to take advantage of the grain direction.



	
Prepare the 2D profiles, ensuring that they are assigned to the appropriate toolpathing layers.



	
Turn off all layers except toolpathing layers. Save your file, giving the filename a suffix to reference your modifications (e.g., AtFAB_LNG-loveseat.skp).








[image: dcnc 1103]
Figure 11-3. Widen the Lounge Chair Model in SketchUp


























Measure & Scale


	
Review “Measure Your Materials” and “Scale Your CAD File” for details on how to measure all of your sheets, as illustrated in Figure 11-4.



	
Record TA, TB, TC, TD, and calculate TMAX, your actual material thickness.



	
Divide TMAX by TNOM to calculate your file scaling percentage (S).



	
Visit the book’s website to download the 90-Minute Lounge test piece (AtFAB_LNG_TEST.skp) and the jig (AtFAB_LNG_JIG.skp).



	
Download the 90-Minute Lounge file (AtFAB_LNG.skp) or use your modified file. Open the lounge file in your CAD program.








[image: dcnc 1104]
Figure 11-4. Measure your material and scale the CAD file




The AtFAB_LNG_JIG.skp file contains parts for a jig, which is extremely useful during assembly. Although it’s not essential, using the jig will save you lots of time and dramatically decrease the complexity and assembly time of putting together the Lounge Chair. You can nest jig parts into the cut file or cut them from a scrap of material.



















Partial Prototpye


Once you have procured and measured your material, and after you have calculated your scaling percentage, S, you’re ready to check your fit with the test piece.


The 90-Minute Lounge Chair test piece parts in AtFAB_LNG_TEST.skp simulate the chair’s joinery, as well as the fit of the hardware key and pocket. A test piece that comes out successfully confirms that both CAD scaling and CAM settings will work for the actual Lounge Chair.


	
Review “Test Pieces” on the concept and purpose behind full-scale prototypes and test pieces. “Partial Prototyping: Using a Test Piece” walks you through how to prepare, cut, and evaluate the test piece.








Figure 11-5. Locate test piece on the cut sheet
[image: Alt Text]


Figure 11-6. Lounge Chair 2D parts in the default AtFAB_LNG.skp; the pocket toolpathing vectors are shown in orange
[image: Alt Text]





	
Open the test piece file in SketchUp and scale all of the 2D parts by S.



	
Select Save As, adding the amount of S to the filename (e.g., AtFAB_LNG_TEST_9842.skp).















Prepare Toolpaths


	
Following the steps in “Job Setup”, import the scaled test piece file into VCarve Pro and locate it on a clear area of one of the sheets (Figure 11-5).







	
Assign toolpaths to each of its three profile toolpathing layers, outside, inside, and holes, shown in Figure 11-6.



	
Outside toolpaths (blue vectors) cut around the outside of all chair parts.



	
An inside toolpath (green vectors) cuts the slot in the chair seat.



	
The holes (red vectors) toolpath for fastener holes uses a smaller end mill.







	
Set the cutting sequence so that the CNC cuts fastener holes and inside cuts prior to cutting outside profiles (Figure 10-1), in order to keep details aligned within the parts. Since fastener holes require an end-mill change, position them first in the cut sequence, so you only need to change a tool once.






















About the Pockets


In addition to defining toolpaths for outside cuts, inside cuts, and holes, the 90-Minute Lounge test piece uses toolpaths for pocket cuts, shown as orange vectors in the cut file, shown in Figure 11-6. Pockets create the two recessed areas found in each of the Lounge Chair’s side parts.



[image: dcnc 1107]
Figure 11-7. Machined Lounge Chair inlay keys




Each pocket accepts a matching inlay key that locks the seat and seat back into each side of the chair (Figure 11-7). The depth of these pockets should match the height of the keys. When skillfully executed, the keys make for an elegant, flush inlay detail on each side of the chair.


To achieve a flush fit, it’s critical to coordinate your material thickness with the depth of all pockets. Both the pocket cut depth and the milling depth for the inlay keys must be half of TMAX (in other words, TMAX/2), to get a flush alignment.

















Create Pocket Toolpaths


After programming the outside, inside, and hole toolpaths, return to the main VCarve window.


	Layers Menu

	
Turn off all layers, except the Pocket layer.






	Toolpath Operations

	
Select the Pocket Toolpath icon, shown in Figure 11-8, to open the pocketing settings menu. Toolpaths menu → Pocket Toolpath. The Pocket Toolpath menu will open.






	Cutting Depths

	
Keep the Start Depth (D) at 0 and set the cut depth (C) to half of TMAX (in our example, this is 0.375”), shown in Figure 11-9.






	Show Advanced Toolpath Options

	
Checking this box reveals the Use Vector Selection Order box. Check this box.






	Tool

	
The pockets use the same ¼″ diameter end mill as the inside and outside profile cuts, so you can leave these settings unchanged.






	Use Larger Area Clearance Tool

	
Sometimes it’s beneficial to use a larger diameter tool to clear most of the material away quickly and then clean up or cut fine details with a smaller tool. Keep this option unchecked; for our purposes, ¼″ diameter bit is fine.
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Figure 11-8. Select Pocket Toolpath from the Toolpath Operations menu





[image: dcnc 1109]
Figure 11-9. Set Cut Depth




	Clear Pocket

	
Use defaults provided by VCarve:



	
Clear Pocket→Offset



	
Cut Direction→Conventional










	Ramp Plunge Moves

	
You don’t have to add ramp moves, but if you’d like to make cleaner pocket cuts and put less stress on your tooling, as discussed in “Ramp Moves and Tabs”, check the Ramp Plunge Moves box. Keep the default value of 1.0 inches in the Pocket Allowance box.


	
Save the toolpath name 000 Pocket 1.



	
Check all of your settings and select Calculate.











You should now have four toolpaths in your toolpath list, 000 Pocket 1, 000 holes, 000 profile inside, and 000 profile outside, as shown in Figure 11-10.

















Simulate


	
Move the holes  toolpath to the first position in the list. The holes use a smaller diameter tool than the pockets and profile cuts.



	
Move the pocket toolpath to the second position. You’ll want to cut the pockets before making any through cuts that weaken the material structure and cause vibration. Profile inside is third on the list and profile outside should be last.








[image: dcnc 1110]
Figure 11-10. Set Toolpath Sequence to cut holes first




	
As with the other toolpaths, review the animation and visuals of the vectors, spindle path, as well as the actual pockets made by the ¼″ end mill. Ensure that the kerf removed matches the end-mill size, that the tool creates a pocket that is half the material thickness, and that the pocket shapes match those in the original cut file.






















Cut Sequence for Complex Parts


Choreographing the toolpath sequence preserves the alignment of smaller holes, slots, or details, which are situated within larger parts (see “Job Setup”). For similar reasons, pocket cutting should also be handled on an early pass, so pocketed details remain aligned within the larger part.


Sequencing also comes into play when you’re making complex three-dimensional parts, like the Lounge Chair keys and their side pockets. Following an exact sequence of cutting pockets prior to inside profiles ensures that the end mill the removes material in the right order. Reverse the sequence of these toolpaths, and the three-dimensional milled shape might vary.


The Lounge Chair’s pocketing toolpath removes four circular pockets from each of the two side parts, and it forms four circular/donut pockets to make the chair’s keys. Once the first pocketing pass is made, the machine’s subsequent passes mill holes, inside cuts, and finally profile cuts.

















Pocket Cutting: Top Down or Bottom Up?


When you went through the Job Setup process in VCarve, you set your Material Z to match TMAX, and had an option to select the Z Zero, or your z-axis origin, to either the surface of the material or the surface of the machine bed.


While it’s standard practice to enter the top surface of the material, there are occasions for aligning the Z Zero to the deck.


When your design calls for a specific pocket depth, but your TMAX varies by 5%–10%, you’ll get different results depending upon whether you zero to your deck, or you zero to the top of your material. By zeroing to the deck you are relying on a fixed point; by zeroing to the top of your material, you are zeroing to a variable. While this might not matter on all jobs, the smaller the pieces you are milling, the more significant the risk.


If you’re using ¾″ material and you zero to the deck, you’ll be sure to have 3⁄8” of material remaining from the bottom of your pocket to the top of the deck, no matter what. If you zero to the top of the material, your pocket will be 3⁄8” from the point to which you zeroed your end mill, meaning that your pocket depth will vary across the sheet by the same amount of fluctuation that exists in the sheet.



[image: dcnc 1113]
Figure 11-11. Zeroing the z-axis to the top (left) and bottom (right)


























Assemble and Evaluate the Test Piece


Dust off the test piece parts and pay special attention to cleaning debris from the pocket and the keys. If you are finishing your chair, finish the test piece parts according to the manufacturer’s instructions.



[image: dcnc 1111]
Figure 11-12. Test piece in context












Evaluate Fit


	
Using Figure 11-13 as a guide, assemble the test piece parts, fitting the keys into the pockets. If your joinery doesn’t match the fit described in “Cut and Evaluate Fit”, the key diameter will likely be too big or too small compared to the pocket.



	
Consult “Troubleshooting” for additional techniques and steps for achieving the optimal fit.
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Figure 11-13. Assemble test piece



















Evaluate Cut Depth


	
Evaluate the cut depth settings by comparing the flushness of the key and the surrounding face material.







If the key is perfectly aligned, then your pocket depth setting was correct. If the key sticks out too far or not enough, the pocket depth needs to be adjusted.


	
Using your calipers, measure the material thickness of the key and the pocket.



	
Compare with the adjacent, overall material thickness (TMAX).



	
Increase or decrease the cut depth to accommodate the difference, and consult “Pocket Cutting: Top Down or Bottom Up?” for detailed troubleshooting.





























Adjust and Cut Chair Files


With a well-fitting test piece in hand, you’re ready to cut your 90-Minute Lounge Chair, knowing that all parts will go perfectly together.


	
Return to SketchUp and open the modified or unmodified Lounge Chair file (AtFAB_LNG.skp, Figure 11-6). Scale the 2D parts by the exact scaling adjustments of your successful test piece.



	
Open the test piece VCarve file, delete all of the test piece parts, and import the scaled Lounge Chair file.



	
Assign toolpaths to all vectors and pocketed areas on both sheets.



	
Thoroughly simulate and check your work on both sheets.



	
Export the toolpaths for each sheet, into separate files for machining. Proceed with cutting the Lounge Chair parts from both sheets of material.



	
As you remove chair parts off the machine, store them carefully to avoid scratches or minor damage. Clean off the machine dust from each part with a nonabrasive brush and file or lightly sand part edges as necessary.



	
Lay the parts out flat on a blanket or stacked with protective layers between. If you made the jig (explained in “Using the Jig”), set the four jig parts aside.



	
Finish each Lounge Chair part based on your earlier evaluations of finishing the test piece. Store all parts in a protected area and make sure that the finish has dried completely.







Figure 11-14. Lounge Chair parts
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Assemble


Assembling the 90-Minute Lounge Chair requires a jig, a friend, and a bit of patience.










Using the Jig


Makers of all kinds make and use jigs to help with different kinds of tasks during the fabrication process. For the Lounge Chair, we made a jig to assist with the process of putting cut parts together.


While it’s technically possible to do it on your own, the jig and an extra set of hands helps to keep multiple parts oriented and aligned simultaneously, which makes assembly go much more smoothly. The jig parts, provided in AtFAB_LNG_JIG.skp, may either be cut alongside your lounge chair or separately from scrap material.
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Figure 11-15. Assembled jig




	
Place a moving quilt, or other cover, to protect both your Lounge Chair parts and work surface.



	
Put the jig together as shown, aligning it along one end of your work surface.



	
Familiarize yourself with all of the parts, arranging them so that each part is identifiable and within easy reach. Note the front face of each piece, if your material is sided. Keep blue tape, hardware, and a drill close by.







The 90 Minute-Lounge Chair parts are assembled with the chair upside down.
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Figure 11-16. Steps to assemble Lounge Chair parts




	
Place the Seat of the 90-Minute Lounge Chair onto the jig, with the top of the Seat facing downward, and its rear tab projecting just past the edge of the work surface. Hold the Seat Back so it’s upside down, and hang it off of the Seat. Bring the rear tab of the Seat through the lower slot of the Seat Back. The Seat Back is now hanging from the seat.



	
Holding the Arm part, with the finish side facing toward the work surface, slip the U-shaped Arm part over the Seat Back and toward the Seat, rocking and shifting it into place. As the Arm moves past the Seat, keep working the Arm part into place until the tab at the back of the Arm part fits through the second slot in the Seat Back.



	
Hold the Front part with the finish side facing the front of the chair and the legs oriented upward. Shift and nudge the part so that its tab fits into the front slot of the Seat. The Arm part can be rotated so that its front tabs fit into the Front.



	
Select a Side part, turn it upside down with pockets facing outward, and place the top tab inside the arm. Rotate the Side into place, aligning its slots with the tabs on the Seat and Seat Back, and lock all parts into one another. Similar to the previous step, the parts need to be gently shifted and adjusted to ease each Side into place. Follow the same process with the second Side.



	
Rotate the Back into place, by placing its tab into the Arm’s slot and locking it into the sides. Put the two feet into position. Snap the hardware keys into their pocketed holes. Use blue painter’s tape to secure any parts that aren’t firmly locked into place.



	
Consult “How to Drill” for proper drilling and fastening techniques. Starting at the rear of the Lounge Chair, methodically work around the entire chair to predrill holes that are accessible. Insert fasteners and turn the chair upright. Predrill and insert fasteners into the remaining holes.
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Figure 11-17. Completed Lounge Chair





















Part IV. Parametric Transformations




The One to Several Table and Open Storage Cabinet projects build upon your knowledge of digital craftsmanship, while introducing you to the incredible capabilities of parametric design. With an interactive, parametric app that accompanies each project, you’ll see how it’s possible to tailor a cut file to match any desired dimension and to precisely fit your sheet material.





Chapter 12. Parametric Design



Parametric tools enable you to easily modify specific parts and attributes of a digital model. When you combine digital fabrication with the parametric capabilities of advanced CAD software, you have the exhilarating power to produce customized designs with relative ease. If you need a table with a specific length and height, you can parametrically adjust a digital model to match the exact dimensions you desire. If you want a storage unit with an overall size to match a space in your shop, and shelves to fit your favorite tools, you can make it all happen with several parametric adjustments to a digital file. With parametric software and digital fabrication, it takes nearly as much effort to produce a custom version of an object as it does a standard version. By putting these tools to use, we are liberated from repetition, common sizes, and limited choices.








What are Parameters?


To explain parametric design, it helps to draw some parallels to parametric equations in mathematics. A parametric equation is a set of explicit functions that contain constants and variables. Similarly, a parametric design is a set of functions that interrelate particular physical attributes. Fixed values within the design are constants, while a range of values, or parameters, are the variables. Within a parametrically defined table, for instance, a (mathematical) function affiliates a supporting leg at each of the four corners of a tabletop, while allowing the table a variable length, width, and height. Parametrically transforming this table changes its overall dimensions, without affecting the fundamental characteristics of four legs that support a tabletop.


If you elongated either the 5-30 Minute Chair or the 90-Minute Lounge Chair within the CAD file in Part III, you were manually performing a parametric operation. You adjusted the variable width, within a function that preserved the relationship between the sides, legs, feet, fasteners, and joinery.


Some CAD software programs offer parametric tools, which enable you to transform particular physical attributes of an object. Though parametric modeling software enables you to assign modifiable attributes to your model, the software does not do all of the work for you. You still need to do the intensive thinking to interrelate elements within a design, and to determine what is constant and what is variable. It’s not as easy as many people think; it’s a lot of extra work to design parametrically, but the implications of this effort can be powerful. With a single parametric digital model, you can produce a range of versions, like a series of similar tables or chairs with varying dimensions or attributes.

















AtFAB’s Parameters


Chapter 2 explained how AtFAB’s collection of furniture pieces share a common language of joinery, assemblies, and structures based on the S/Z joint. As each AtFAB piece was developed, it was designed with parametric customization in mind. Thus, a finite collection of furniture is actually a range of infinite versions. 


A parametric definition is a specific operation that transforms parts or adjusts attributes of a digital model. By developing such operations in the process of designing, a designer can make an object and its operations inextricable.


For AtFAB, we designed parametric definitions to yield a range of outcomes that are appreciably different and relevant. For all pieces, and in the apps that accompany this chapter, we provide operations for adjusting material thickness, sniglet diameter, and fastener diameter, as well as for transforming a piece in either shape, module, or dimension.
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Figure 12-1. Prototypes of CIBi and CIBii versions




Collectively, these parametric definitions give each furniture piece a significant level of adaptability for different materials, tools, and individual preferences. For distributed manufacturing, explained in Chapter 1, the implications of this versatility are vast. Makers anywhere can download a file, tailoring the design to fit local materials, available CNC tools, and specific uses or needs.










Tool Diameter


You’ve already seen that each project cut file works with a common, ¼″ end-mill diameter, and that every sniglet on each part accommodates this standard diameter.


However, what if you have access to a laser cutter or water jet, with a beam diameter that’s much finer than an end mill? Or perhaps you’re working on a scale prototype that needs a smaller tool, or maybe you’d simply like to use a different diameter end mill. A parameter that controls tool diameter and changes the sniglet size to accommodate alternatives to the standard makes it easy to modify files for different processes or scales, giving designers and fabricators the flexibility to tailor a cut file for the machine that’s available.
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Figure 12-2. Tool diameter parameter






















Material Thickness


After making any of the projects in this book, you have spent considerable effort scaling the profiles in your CAD file (in “Scale Your CAD File”) to match your material thickness TMAX. A parameter that controls material thickness spares you that effort, by adjusting the size of every slot and tab to accomodate TMAX. Unlike scaling, this method precisely maintains your overall part dimensions (explained in “Scaling, Offsetting, and Parameters”). As with the tool diameter parameter, this capability gives makers and fabricators the flexibility to customize a cut file to work with any material that’s locally available.
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Figure 12-3. Material thickness parameter






















Shape


The Cat in Bag ii Table is part of a series of three tables that are designed to be modified in shape. Like its cousins the Cat in Bag i and Cat in Bag iii, the end of its table legs can be pushed and pulled in and out from the rotational frame at the center of the table. This changing shape doesn’t necessarily transform the inherent function of the table, but it can tailor the table to the configuration of its surroundings.
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Figure 12-4. Shape parameter






















Module


Modular transformation affects the dimensions and the quantity of a defined cell. This definition is employed most simply by the Open Storage Unit, to subdivide outer dimension into a specific module of shelves and dividers. For the Cellular Screen, the cell size and quantity can be defined to yield multiple screen options. The modular definition allows a larger dimension to be subdivided into cells, or a larger object to result from the aggregation of cells with a specific dimension.
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Figure 12-5. Module parameter






















Dimensions


Dimensional transformation is the most common parameter throughout all AtFAB objects, and often makes the most obvious impact. The dimensional definition customizes the length, width, and/or height of furniture objects. Dimensional transformations are applied in different ways to different kinds of pieces. To simplify the 5-30 and 90-Minute Chairs, we kept transformation only in width. In the case of the One to Several Table, length and width require a greater range of variability than height that only serves seated or standing uses.
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Figure 12-6. Dimension parameter






















Details


AtFAB cut files are set up with fastener holes that accommodate a standard fastener size. A parametric definition enables you to globally adjust this diameter to suit a range of fastener diameters. Parametric definitions for other details vary among AtFAB pieces to complement or add function to the design. In the One to Several Table, the parametric tool offers an optional grommet hole for wire management.
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Figure 12-7. Details parameter





























Designing Parameters


Things get quite interesting when you define parameters that turn a single design into multiple, and possibly infinite, versions of itself. Well-designed definitions are the best way to adapt one design into a range of successful furniture outcomes that offer desirable, perceptible differences and which suit a variety of contexts.


Finding parameters of a design starts by identifying fixed relationships between elements as well as external constraints. Does the design have basic ergonomic rules that need to be followed? Will specific material and machine limits govern the size of the largest part? Does the design have particular connections or structural assemblies that need to be maintained? Is maximizing material yield or minimizing cutting time during production an essential requirement?


Sometimes relationships and constraints can be obvious. The need to preserve a comfortable ergonomic angle between the 90-Minute Lounge Chair’s seat and back is an example of a fixed relationship. No matter how long the Lounge Chair gets, it can’t function without that angle. The four legs that hold up the Cat in Bag ii tabletop is another example of a fixed relationship. Even if the spacing between these four legs varies, their interlock and relationship to the table’s four corners is a constant.


Another illustration of constraints is how the maximum length of a tabletop is limited by how much it can span before deflecting. Similarly, its minimum length is determined by the point at which it becomes functionally useless as a table. The range between that maximum and minimum length is a variable, offering multiple structurally viable and useful versions of a table.


Less obvious parametric opportunities demand a deeper analysis to find the complex interdependencies between elements of a design. Should particular proportions be preserved in the design? Do connections require a particular amount of spacing between them? Does a part require additional support if its span grows beyond a set limit?


Developing sets of parametric definitions for each AtFAB piece involved answering such questions. For instance, the One to Several Table can span a longer distance, simply by adding an extra member or deepening its structure. The Five to Thirty Minute Chair doesn’t need to transform in every direction, but it’s quite useful when it’s incrementally widened into a bench that comfortably seats two or three people. Simple adjustments to depth and shelf spacing radically tranform the Open Storage from media center to display cabinet to tool storage.

















Parametric Case Study: the Cat in Bag ii Table


The Cat in Bag ii is a coffee table that began as a study to produce an elemental, parametrically transformable shape. Named for a metaphorical cat in a metaphorical bag, its four tabletop corners mimic the movement of four kitty paws independently pushing an envelope in four different directions.
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Figure 12-8. Parametric equation for the Cat In Bag ii Tabletop




A parametric operation can push each of the table’s four corners (paws) toward or away from the center, stretching the tabletop perimeter (bag) in different directions. Depending on which corners you stretch, and how far you stretch them, you might extend, elongate, shrink, and shape the tabletop to complement any furniture arrangement around it.


The table’s rotational structure is shaped by the tabletop’s corners. Whenever you stretch a corner toward or away from the center, the table leg and frame moves with it, always maintaining a set distance from the rounded corner.
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Figure 12-9. Material thickness and height parameters for the Cat in Bag ii, and taller Cat in Bag iii, Table












Functions, Variables, and Limits


To understand the table in parametric terms, it helps to break it down as an equation of functions, constants, variables, and limits. The Cat in Bag ii Table has only two part types: the legs and the tabletop. However, numerous table versions emerge from these two simple parts.


	Functions

	
The Cat in Bag ii’s four identical legs lock into the tabletop with three tabs. Two of these tabs form a three-way connection with the other legs at the center of the tabletop. The third tab forms a through connection near each of the tabletop’s rounded corners. Parametrically speaking, each interrelated tabletop and leg assembly is defined by the exact same function. It has the same joinery, corner radius, and linear direction of push and pull.



	Constants

	
The only differentiating feature is that each leg is oriented in a unique direction: north, south, east, west. The north, south, east, west orientation of each leg is an example of a constant.



	Variables

	
The distance between each of the three tabs is an example of a variable. Figure 12-8 shows how overall table length and width is the sum of these variable distances. With a range between 10–25cm, X and Y define the distance between the interlocking tabs at the center. N, S, E, and W have a range of 25–75 cm, defining the distance from interlocking center to the outer tab. The overall tabletop length is the sum of N+Y+S, and overall width is the sum of W+X+E.



	Limits

	
Limits are an important consideration relative to variables. The Cat in Bag ii Table can only grow so big before it will become structurally unsound or won’t fit on a CNC router bed. At the other end of the range, tabs that are too close together might compromise a joinery connection. Limits on the high and low end are critical to ensuring that parametric transformations produce outcomes that are functional.




























Parametric Processing Applets


Parametric software programs like Rhino’s Grasshopper, Autodesk’s Fusion, and others are indispensable for parametrically developing designs. However, these advanced CAD programs are beyond the scope of this book. To demonstrate parametric thinking, and how operations work in conjunction with a design, we used Processing to build individual parametric applets for customizing several AtFAB pieces. Originally built as a proof of concept, each app balances freedom of choice and critical constraints to yield outcomes with structural integrity, harmonious proportions, ergonomic function, and material fit.
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Figure 12-10. AtFAB applet toolbar




Explore the parametric operations in the two projects in this section, in order to understand the effects of limits, ranges, and interrelationships within a design.


With sliders, you can dimensionally transform the One to Several Table in length, width, and height. When the tabletop extends beyond a specific dimension, a parametric operation inserts an additional beam so that the table maintains its structural integrity. You can similarly transform the Open Storage width and height, and try a more complex set of operations that insert any number of internal shelves and dividers. With an additional control, you can set shelf spacing equally or by a coefficient that produces graduated compartments.


Each project offers detailed descriptions of the functions and uses of each parametric applet.










Installing and Using the Apps


	Download and install Processing

	
Download version 3.3 from the Processing website.



	Download the Processing sketch

	
The parametric apps are included with the project file on the book’s website. Download and decompress the file. Within the folder labeled AtFAB_TBL_app or AtFAB_STG_app, open the Processing file by selecting a .pde file. Select the Play button to launch the app.



	Open the sketch in Processing

	
Move the sliders and select/deselect toggles to make your desired changes. See “Using the One to Several Table App” or “Using the Open Storage app” about specific controls and options for each app.



	Export

	
When you are satisfied with your customizations, export to a DXF file by clicking the Save button. Name your file in the pop-up. The app saves this DXF file directly in the Processing sketch folder. The DXF file can be opened with SketchUp and many other CAD programs.






	Open a new file in SketchUp

	
Select units that match the units chosen for your file export, either millimeters or inches.


Select Import → DXF file to import the file.






The vectors import into SketchUp grouped into a single component and organized onto separate toolpathing layers. Follow steps in Chapter 3 to organize the file by making components, assigning toolpaths to appropriate layers, and preparing the CAD file for import into VCarve.



















Chapter 13. One to Several Table




The One to Several Table is a large, multi-sheet project that puts your expanding knowledge of digital technique to full use. When skillfully executed, the tabletop’s composition of end-to-face-to-edge and three-way connections showcases your digital mastery of fabricating precision joinery. You can choose to either fabricate a table from a digital file, or go further by customizing your table with an interactive app. This project will walk you through the steps of making a cut file tailored exactly to your desired size, your sheet material, fasteners, and even your CNC tool. In the process of making your own version of a table, you’ll see firsthand the incredible possibilities of parametric design.




	Project Themes

	


	
Parametric Transformation



	
Adding Design Details



	
Grain Direction







	Design Files

	


	
3D: AtFAB_TBL.skp



	
Test: AtFAB_TBL_TEST.skp



	
Cut: AtFAB_TBL.dxf







	Parametric App

	


	
AtFAB_TBL_app.zip







	Sheet Goods

	


	
Two sheets of 4′×8′×¾″ (1200×2400×19) for one table, possibly more for a customized version







	Tools & Hardware

	


	
Fasteners (36 in total)



	
Drill and bits



	
Profiles: ¼″ end mill



	
Holes: 1⁄8″ end mill



	
See Appendix B
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About the Design


The One to Several Table was named after the parametric transformations that change it to accommodate one, few, several, or many individuals around it. With partial torsion box construction, this extremely strong, stable, lightweight table works well in a variety of applications. Its rotationally symmetrical, canted legs give it lateral stability and a dynamic stance, while the interlocking joinery on its tabletop adds extra rigidity. When you add transformability to the many material and finish options, the One to Several Table is quite a versatile piece.

















Before You Begin


The One to Several Table works nicely as a desk, a work bench, or a dining table. When combined with the infinite possibilities of customization, your table project demands quite a few decisions. It helps to narrow down a program early, so you can make coordinated decisions about dimensions, materials, and finishes. Having a clear program to drive your choices ensures that you’ll end up with a useful table that will be enjoyed for years to come.










Establish a Program and Dimensions


“Develop a Program” presents a full array of considerations in developing a program for your project.


To help with your customization decisions, research key factors to define the dimensions of your table. Thoroughly measure the space where the table will be situated. Also measure chairs and other furniture or equipment that you plan to use with it (or on it).


If placing your table against a particular wall, take special care to measure the wall, as well as outlets, projections, and windows. After considering all of the issues and taking measurements, determine the length and width of your table.


If your table will be a standing work surface tailored for a specific individual, like Anna Kaziunas France’s CNC Maker Bench, see Figure 13-1, measure the distance between the individual’s elbow and the floor to determine the table height.



















Select Materials


Let the program that you just defined inform your choice of materials, finishes, and fasteners. You might choose a refined material if making a dining table or desk. Conversely, you might go with a rougher, durable material and hard-wearing coating if customizing the table into a workbench. Refer to Appendix B for selecting and sourcing appropriate materials and fasteners, as well as “Finishes for CNC Projects” for guidelines on adding a finish.


To make a table directly from AtFAB_TBL.skp, you’ll need two sheets of 4'×8’ ¾″ plywood. The layout leaves extra room for test pieces. If you plan to customize your table with the parametric app, you may need a third sheet. You can estimate, or proceed with laying out custom parts to precisely calculate your actual material requirements.


The table in the CAD file AtFAB_TBL.skp makes a nicely proportioned desk or small dining table. If you prefer to make this version, skip ahead to “Measure & Scale” and follow the steps to measure, scale, prepare toolpaths, fabricate, and assemble. Proceed to the next step to make a customized version of the One to Several Table.


Figure 13-1. Anna Kaziunas France’s standing height CNC work bench made with the AtFab One to Several Table parametric app for the Make: Books Providence, RI office, published in Make Magazine vol 38
[image: Alt Text]


























Parametric Transformation


Compared to the 2D and 3D modifications to both chair projects, the One to Several Table parametric app offers a much higher degree of customization. The app allows you to produce a file with dimensions that precisly match your program and to adjust every part to fit your exact material thickness (TMAX). The app has optional features, enabling you to set hole diameter to match fasteners and to adjust sniglets to match any alternative tool diameters.
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Figure 13-2. One to Several Table app












Parametric Design


The One to Several Table’s parametric operations were designed to offer tangible, functional differences from one version to the next. To understand the One to Several Table’s parametric design, it helps to examine it through the lens of parametric equations. We can break down the table as a collection of constants and variables interrelated by functions.


As you adjust its length or width, the table’s four legs, feet, and joinery maintain a constant relationship to the top. Only the distances between the joints and assemblies change. A more complex operation, defined by an if/then statement, adds or substracts bays to the table’s torsion frame. If the table width increases beyond a certain dimension, then the app adds an additional cross member to provide extra structural support. While the number of cross members may change, all of the joinery details are constant. And though the distance between cross members increases or decreases, they are always spaced equally.


The table length and width are what we might consider variables, or parameters. The length and width parameters are defined by a range within a maximum and minimum dimension. The maximum limit matches the largest reasonable structural span, and the minimum limit accommodates the minimum functional space between leg assemblies. In conjunction with the dimensional operations, a variety of separate, overlapping operations control table height, material thickness, fasteners, and other details. Together, this set of functions allows you to adapt the One to Several Table in a useful and meaningful way.
























Using the One to Several Table App


You can best understand the table’s parametric design by simply using the parametric app. As you change the dimensions, material thickness, and toggle the other features, you will be able to see for yourself how interdependencies, limits, and parameters work.
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Figure 13-3. Dashboard of the One to Several Table app




	
Have your program and relevant information on hand, including preferred table dimensions, your fastener diameter, and alternative tool specifications.



	
Purchase your materials and review “Measure Your Materials” on how to find TMAX.



	
Follow the steps in “Installing and Using the Apps” to download and install Processing.



	
Download AtFAB_TBL_app.zip, un-compressing the zip file.







	Open the sketch in Processing

	
Inside the app folder AtFAB_TBL_app, select AtFAB_TBL_app.pde to open the Processing sketch file. Select the Play arrow to launch the app.



	Select Units

	
Select millimeters or inches. The file will be saved with these units.



	Set length and width

	
Adjust the table length and width dimensions to match the measurements determined by your program.



	Set height

	
This setting has two options. The lower height is standard desk/table height. The taller option is standard standing height. Select the option that best matches your program.



	Proportions

	


	
Free is the default option that allows the length and width to remain independent.



	
Select locked, if you would like to preserve a particular ratio between the length and width measurements.



	
Select modular if you would like to set a golden ratio of 1.618 between the length and width.


















Set Overall Conditions


The parametric app has a set of controls, called  conditions. These operations work alongside the dimensional transformations to affect all the table parts.


	Set Material Thickness

	
This important control allows you to generate a file with parts that match the maximum thickness of your material. Move the material thickness slider to match TMAX.


The app allows you to produce cut files that precisely match sheet material thicknesses, while skipping the scaling step in “Scale Your CAD File”. The  setting also makes it possible to produce a cut file, using a wide range of material thickness.






Refer to Appendix B for options and tips on sourcing materials. However, if you’re considering materials other than ¾″ plywood, ensure that your material choice has a strength to weight ratio that can handle the span of your table.
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Figure 13-4. Match app settings to material (TMAX)




	Set fastener diameter

	
This control changes the hole diameter to match a particular fastener diameter. If you’re using standard fasteners, keep this at the default setting.



	Set sniglet diameter

	
This control adjusts the size of every sniglet to your CNC tool, like a laser cutter, water jet, or smaller diameter end mill. Keep this at the default setting, unless you plan to use a different machine or end mill.



	Select grommet

	
If the table will accommodate computers or equipment, you can select the grommet hole option for keeping wires neatly organized. When selected, the app adds a hole at an end-to-face-to-edge joint, on three sides of the table. Leave this option unchecked, if you don’t need to manage wiring.



	Export

	
When you are satisfied with your customizations, export to a DXF file by clicking the Save button. Name your file in the pop-up. The app saves this DXF file directly in the Processing sketch folder.





















Prepare CAD File


	Open a new file in SketchUp

	
Select units that match the units chosen for your file export, either millimeters or inches. Select Import → DXF file to import the file.



	Organize File

	
The vectors import into SketchUp grouped as a single component and organized onto separate toolpathing layers. Follow the steps in Chapter 3 to organize the file by making parts into separate components, checking that toolpaths are on appropriate layers, and preparing the CAD file for import into VCarve.



	Layout Parts

	
Draw cut sheet boundaries to match your sheet material dimensions. Arrange parts onto the cut sheet, considering grain direction as you orient each part within the cut sheet boundary.



	Prepare for CAM Import

	
When you’re satisfied with the sheet layout, group all parts into a single component to preserve the layout when it imports into VCarve. Down-save the file as SketchUp 2014.







[image: dcnc 1305]
Figure 13-5. Table parts laid out onto two cut sheets




Evaluate Your Design Proportions with a Scale Prototype

After you create your CAD file, a scaled, laser-cut version of your parametrically modified table allows you to evaluate the proportions of your table from an aesthetic standpoint and to analyze its structural performance. Refer to “Scale Prototypes” for an overview on using prototypes and including steps on preparing a prototype file.



[image: dcnc 1304]
Figure 13-6. Laser-cut acrylic scale prototypes of parametrically transformed tables




























Measure & Scale


If you’re working with the default file, AtFAB_TBL.skp, refer to “Measure Your Materials”


	
Thoroughly measure both sheets, record TA, TB, TC, TD, and calculate TMAX, your actual material thickness.



	
Divide TMAX by TNOM to calculate your file scaling percentage (S). (For details, refer to “Scale Your CAD File”.)







The next steps will walk you through the process of testing S with your actual material, using the One to Several Table test piece.



[image: dcnc 1304 5]
Figure 13-7. How to measure and scale file



















Create the Partial Prototpye


	
Download the One to Several Table test piece (AtFAB_TBL_TEST.skp).







The parts in this file simulate the table’s critical joinery conditions, particularly the three-way connection that joins the tabletop to the structural frame. This joinery detail demands a very precise fit between the parts. “Test Pieces” explains the concept and purpose behind full-scale prototypes and test pieces and “Partial Prototyping: Using a Test Piece” walks you through the particulars of preparing, cutting, and evaluating the test piece.


Whether you are using the default One to Several Table file or one that you produced with the parametric app, it’s essential to use the test piece to confirm that your joinery fits the material. The test piece will simulate critical joinery in the default and any parametrically customized files.





[image: dcnc 1306]
Figure 13-8. Test piece in context












Prepare File


Since the One to Several Table’s test piece was modeled for ¾″ (19mm) thick material, you will first need to scale the part profiles by S so they match TMAX.


	
Open the test piece file (AtFAB_TBL_TEST.skp) in Sketchup, and scale all parts by S, so slots match TMAX.



	
Select Save as a SketchUp Release 14 file, adding S to the filename (e.g., AtFAB_TBL_TEST_9842.skp).






















Prepare Toolpaths


	
Following the steps in “Job Setup”, import the scaled test piece file into VCarve. Locate the test piece on a clear area on one of your sheets.



	
Assign toolpaths to each of its three toolpathing layers. Outside toolpaths cut around the outside of all table parts. An inside toolpath cuts the crosshair shape in the tabletop. The holes toolpath for fastener holes uses a smaller end-mill diameter.



	
Program the cut sequence so fastener holes and the crosshair shape are cut prior to the outside profiles, so they stay aligned within the parts. Since the fastener holes require an end-mill change, position the holes toolpath first in the cut sequence, so you only need a single tool change.



	
Save the toolpath operations for fabrication.






















Cut, Assemble, and Evaluate


	
Cut out all test piece parts, assemble the test piece, and evaluate the fit.







If you want to add a coating or finish to your table, ensure that you apply the finish on the test piece parts and evaluate their fit.


If your joinery doesn’t match the fit described in “Cut and Evaluate Fit”, consult “Troubleshooting” for additional techniques and steps for perfecting joinery fit.


	
Continue making CAD and CAM adjustments and cutting test pieces until you are satisfied with the joinery. Make a note of the total scaling adjustment and save the final VCarve file (e.g., AtFAB_TBL.crv) that yielded the successful test piece.







If you need to make fit adjustments with a parametrically customized file, there are two ways to correct for fit. You can either follow the instructions in “Troubleshooting”. Alternatively, you can return to the app to produce a new file with a material thickness setting that better matches the actual material.





Figure 13-9. Locate test piece toolpaths onto the clear area of the cut sheet
[image: Alt Text]



Figure 13-10. Test piece assembled
[image: Alt Text]




























Adjust and Cut Table


Once you have assembled a finished test piece that fits perfectly, you’re ready to run your final project.


	
Return to SketchUp and open the default One to Several Table file (AtFAB_TBL.skp).



	
Scale the 2D parts by the exact scaling adjustments of your successful test piece.



	
Select Save As and ensure that you select the option to save the file for SketchUp Release 14.



	
Add S to the filename (e.g., AtFAB_TBL_9842.skp).



	
Go back to VCarve, and open the VCarve file that you used to cut your successful test piece.



	
Delete the test piece parts in this file and import the scaled One to Several Table file.



	
Going layer by layer, assign toolpaths to the appropriate vectors on each sheet.



	
Simulate and check your work, and export the toolpath operations for machining.



	
Proceed with cutting the table parts with your CNC router, one sheet at a time.







With a large project, it’s helpful to prepare adequate space for storing parts as they come off the machine.




	
Dust off each part with a nonabrasive brush and file or lightly sand part edges as necessary. Store your parts carefully, either laid out flat on a blanket or stacked with protective paper, cloth, or foam sheets between parts.







If you are applying a finish to your table, finish parts according to the manufacturer’s instructions and/or your earlier evaluations of the test piece.



[image: dcnc 1309]
Figure 13-11. Parts of the One to Several Table



















Assemble Table


	
Gather all of your tools (drill, blue painter’s tape, screwdriver) and hardware.







We have found it easiest to assemble the table upside down on a large workbench or on the floor. Use a moving quilt or cover to protect the working surface and table parts during this process.




	
Start by laying the tabletop with the top facedown.



	
Place the cross-beams into the tabletop, fitting the tabs into the tabletop slots.



	
Going around the tabletop, add the leg parts, using blue painter’s tape to secure the parts to each other.








[image: dcnc 1310]
Figure 13-12. Assembly diagram




If you’re working with plywood that has a finished side, ensure that it’s facing outward.




	
Place feet onto the legs.



	
Working around the table, predrill all holes into the legs and feet for fasteners. Refer to “How to Drill” and Figure 10-11.



	
Screw in fasteners and remove blue painter’s tape.



	
While supporting the tabletop, turn the table upright.



	
Predrill remaining holes in the tabletop and screw in the fasteners.








[image: dcnc 1311]
Figure 13-13. Completed One to Several Table














Chapter 14. Open Storage Cabinet




The Open Storage Cabinet project combines all of the fabrication, digital technique, and parametric transformation concepts presented in earlier projects. Like the One to Several Table, you can choose to fabricate a ready-made Open Storage version from a digital file, or walk through the steps of tailoring a cut file in an interactive Processing app. The Open Storage Cabinet project also shows you how to work with two materials and how to fabricate pocketed joinery. Taking on these new challenges will round out your understanding of design for CNC and take your digital craftsmanship to the next level.




	Project Themes

	


	
Parametric Transformation



	
Multi-Material Coordination



	
Pocketing Joinery







	Design Files

	


	
3D: AtFAB_STG.skp



	
Test: AtFAB_STG_TEST.skp



	
Cut: AtFAB_STG.dxf







	Parametric App

	


	
AtFAB_STG_app.zip







	Sheet Goods

	


	
Two 4′×8′ (1200x2400) sheets of ¾″ (19mm) for the outer cabinet



	
One 4′×8′ (1200x2400) sheet of ½″ (12mm) for interior shelves







	Tools & Hardware

	


	
Fasteners (24 in total)



	
Drill and bits



	
Profiles: ¼″ end mill



	
Holes: 1⁄8″ end mill



	
See Appendix B













[image: dcnc 14in01]













About the Design


The Open Storage Cabinet is a strong shelving unit capable of holding heavy objects and handling a long span without deflecting or sagging. It gets its strength from interlocking shelves and dividers that tab into pockets, milled into the symmetrical outer cabinet. This frame forms a strong, rigid structure called a Vierendeel truss. The cabinet’s interlocking shelves and dividers, made from ½″ (12mm) material, tab into pockets on the cabinet interior, made from standard ¾″ (19mm) plywood. AtFAB_STG.skp offers a version with graduated compartments, in a versatile size and golden ratio proportion that works as nicely in a workshop as it does a living room. With the parametric app, you can make your own version of the cabinet with dimensions and shelf configurations tailored to your needs.

















Before You Begin


Like the One to Several Table in Chapter 13, the Open Storage Cabinet has many functional uses. It can house tools and equipment in your workshop or books, collections, and electronics in your living room. Before you begin, define your program, so you can make clear decisions about dimensions and shelf spacing, as well as materials and finishes. Tap into your creativity, as you alter the design and select finishes for a particular use. Since the Open Storage Cabinet requires more decisions than other projects, consider your choices in an integrated way. Relate “everything to everything,” so you can produce a cohesive design.










Establish a Program and Dimensions


“Develop a Program” in Chapter 10 presents a full array of considerations in developing a program for your project.


If you plan to customize the project, take some time to map out other design criteria. Will your Open Storage fit into a specific space? Will it sit against a wall or divide two spaces as a partition? Should it be tall or short? Will its shelves store a particular collection of items, or must shelves be sized for flexibility? Will your Open Storage Cabinet accommodate electronics with wires?


When you have defined a general program, detemine where your storage cabinet will be situated. Thoroughly measure the space, making sure to note electrical outlets and other elements that might get in the way.


Also take an inventory of items you plan to store and display. Note the exact dimensions of specific items that you anticipate: the depth of file boxes, height of a robot toy collection, overall dimension of power tools, etc.


From this research, define the length, width, and depth of your Open Storage Cabinet, as well as the required compartment size. Make a note of these dimensions to use later.

















Select Materials


Let the program help you with your decisions about materials, finishes, and fasteners. A refined plywood and finish might be desirable for displaying a coveted collection in your living space. A utilitarian, durable material with a hard or resilient coating may be preferred if your storage cabinet will endure more wear and tear from storing tools in your workshop. Refer to Appendix B for selecting and sourcing appropriate materials and fasteners, and “Finishes for CNC Projects” for guidelines on adding a finish.


To make AtFAB_STG.skp, you need two sheets of 4'x8’ ¾″ plywood for the outer cabinet and one sheet of 4'x8'x ½″ for the shelves and dividers. This layout leaves extra room on both sheet types for cutting test piece parts. If customizing with the parametric app, you may need additional sheets. It’s always possible to make a rough estimate of materials at this point. However, to precisely calculate your actual material requirements, go through the process of customizing the file with the app and laying out parts.
























Measure Two Materials


Once you’ve procured and measured your material, review “Measure Your Materials” for an overview on selecting and measuring sheet materials. Since the Open Storage Cabinet uses two different material thicknesses, you’ll need to measure both materials and follow a few additional steps to coordinate them.


	
Thoroughly measure every sheet, record your measurements, and find the greatest thickness of both material types. TCNOM for the outer cabinet is ¾″ (19mm), while TDNOM used for the shelves and dividers is ½″ (12mm), illustrated in Figure 14-1.
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Figure 14-1. Measure both materials and find TCMAX and TDMAX












Find TCMAX


	
With calipers, measure the cabinet material thickness (TC) on each side of each cabinet sheet (TCA, TCB, TCC and TCD).



	
Record all points, and identify the greatest thickness measured in the cabinet material (TCMAX).






















Find TDMAX


	
Measure the divider material thickness (TD) on each side of each cabinet sheet (TDA, TDB, TDC and TDD).



	
Record all points and identify the greatest thickness measured in the divider material (TDMAX).







If you prefer to make AtFAB_STG.skp from the file, skip ahead to “Calculate the Scaling Multiplier” and follow the steps for scaling the CAD file, preparing toolpaths, prototyping, and fabrication. Proceed to the next step, for customizing your Open Storage Cabinet with the parametric app.
























Parametric Transformation


The Open Storage Cabinet parametric app, shown in Figure 14-2, offers a much higher degree of customization than 2D or 3D modifications. Similar to the One to Several Table app, the Storage Cabinet app offers definitions for dimensions, two material thicknesses, fastener size, and a sniglet diameter to match your tool.



[image: dcnc 1402]
Figure 14-2. Processing applet




The app also has additional features to accommodate its added complexity. Besides being able to adjust the outer cabinet to the exact height, width, and depth dimensions, it allows you to choose a specific number of shelves and dividers, and whether they are in graduated or regular compartments. It also has a toggle to make a cabinet back with a single or multiple pieces.


As designers, we felt that the Open Storage Cabinet’s many options might prove overwhelming to makers using this app. To narrow down the inifinite array of choices, we added two compositional overrides into the app. One override locks the overall Cabinet proportion to maintain a golden ratio. Another subdivides the shelves into graduated compartments. These settings are complementary to one another, and when used together, they result in what we consider to be a very nicely proportioned, well-composed storage cabinet.










Using the Open Storage app


Test the Open Storage Cabinet’s parametric design with the parametric app. As you change the dimensions, material thicknesses, and toggle the other features, you will be able to see for yourself how interdependencies, limits, and parameters work. Have your program and relevant information on hand, including preferred table dimensions, your fastener diameter, and alternative tool specifications.



[image: dcnc 1403]
Figure 14-3. Detail of the app dashboard




	
Purchase your materials and review “Measure Your Materials” on how to find TMAX.



	
Follow the steps in “Installing and Using the Apps” to download and install Processing and its related libraries.



	
Download AtFAB_STG_app.zip, un-compressing the Zip file.







	Open the sketch in Processing

	
Inside the app folder, select AtFAB_STG_app.pde to open the Processing sketch file. Select the Play arrow to launch the app.






	Set width and height

	
Adjust the cabinet width and height dimensions to match the measurements determined by your program.



	Set depth

	
This setting has less of a range. Adjust the depth to match your desired measurements.



	Shelves

	
Select the number of horizontal shelves and vertical dividers. Below the slider, choose equal spacing or graduated spacing.



	Proportions

	
Free is the default option that allows length and width to remain independent. Select locked, if you would like to preserve a particular ratio between the length and width measurements. Select modular, if you would like to set a golden ratio of 1.618 between length and height.





















Set Overall Conditions


This parametric app offers a set of controls, called  conditions. These operations work independently, but concurrently, with the dimensional transformations to affect all of the cabinet parts.


	Material Thickness

	
This control allows you to select two material thicknesses based on your actual material stock. Refer to “Measure Two Materials” for steps on how to measure and find TCMAX and TDMAX. Move the longer slider to match TCMAX and the other to match TDMAX.


The app allows you to produce cut files that precisely match both sheet material thicknesses, so you can skip the manual process of finding S and scaling the cut file.






Refer to Appendix B for options and tips on sourcing materials. If you’re considering materials other than ½″ and ¾″ plywood, ensure that your choice can support the weight of items you will be storing in your Open Storage Cabinet.





[image: dcnc 1404]
Figure 14-4. Match app settings to material (TCMAX and TDMAX) and end-mill diameter




	Set fastener diameter

	
This control changes the hole diameter to match a particular fastener diameter. If you’re using standard fasteners, keep this at the default setting.



	Set sniglet diameter

	
This control adjusts the size of every sniglet to match your CNC tool, like a laser cutter, water jet, or smaller diameter end mill. Keep this at the default setting, unless you plan to use a different machine or end mill.



	Options

	
This control allows you to select an option for the back of the storage cabinet. One piece keeps this part as a single piece. Two piece splits the part into two, with a vertical seam down the middle. Bikini  horizontally splits the back into two, leaving a gap in the middle.


Use the two piece and bikini options when the back of the storage cabinet exceeds the size of your sheet material. The bikini offers an added advantage of using less material and partially opening up the back of the storage cabinet.



	Export

	
When satisfied with your customizations, export to a DXF file by clicking the Save button. Name your file in the pop-up. The app saves this DXF file directly in the Processing sketch folder.




























Prepare CAD File


	Open a new file in Sketchup

	
Select units that match the units chosen for your file export, either millimeters or inches. Select Import → DXF file to import the file.



	Organize File

	
The vectors import into Sketchup grouped as a single component and organized onto separate toolpathing layers.


	
The units in your CAD file should match both your CAM software and CNC machine. If you need to change settings after importing the file, SketchUp will automatically adjust to the correct imperial dimensions.



	
If needed, Select Window → Model Info → Units → Architectural or Decimal.



	
Follow steps in Chapter 3 to organize the file by making parts into separate components, checking that toolpaths are on appropriate layers and preparing the CAD file for import into VCarve.



















Layout Parts


	
Draw multiple 4′ × 8′ cut sheet boundaries to match your sheet material dimensions. Arrange parts onto the cut sheets, taking care to locate parts on the correct sheet. Place shelves and dividers on the 12mm sheet and cabinet parts on 19mm sheets.



	
Consider grain direction as you orient each part within the cut sheet boundary. Ensure that you recalculate your material requirements to provide enough surplus material for cutting tests from both materials (see Test Fit section).







Be especially careful not to flip or mirror parts (see “Cut Pockets on the Correct Side”).



















Prepare for CAM Import


When you’re satisfied with the sheet layout, group all parts into a single component to preserve the layout when it imports into VCarve. Save the file as SketchUp 2014.


Scale Prototyping

Make a scaled, laser-cut version of a parametrically modified Open Storage Cabinet to analyze its proportions and also to prepare for assembly. If you’re routing your scale prototype, you won’t need to make any file changes. However, since it’s close to impossible to laser-cut pockets, cut through the material and allow shelf/divider tabs to rest in these slots.


Refer to “Scale Prototypes” for an overview on using prototypes and for steps on preparing a prototype file.
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Figure 14-5. Laser-cut scale prototype of Open Cabinet




























Calculate the Scaling Multiplier


The parametric app allows you to set the material thickness slider to match your exact TCMAX and TDMAX, allowing you to skip this step of scaling the CAD file and go straight into using the test piece to dial in your fit. If you’re working with the default Open Storage Cabinet file (AtFAB_STG.skp), instead of a custom file made with the app, you’ll still need to scale your file to match your material.


Review “Scale Your CAD File” on how scaling percentages (S) work, in general. Working with two material thicknesses, which each have varying differentials from the nominal dimension, requires a few simple calculations in order to effectively scale the default CAD file.


In these next steps, you’ll calculate SC and SD, and then determine a single, common scale multipier that coordiantes the two materials. This process is illustrated in Figure 14-6.
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Figure 14-6. Scaling multiple materials: find S and then scale the entire file by S




	Find SC

	
Divide TCMAX by TCNOM.



	Find SD

	
Divide TDMAX by TDNOM.



	Determine S

	
Compare SC and SD. Choose the greatest of the two. Discard the other. Use this value as your scaling multiple, S.














Scale Toolpaths


	
Scale all toolpathing profiles by S.







The steps that follow show how to test S using the test piece, prior to scaling the Open Storage Cabinet CAD file.
























Create a Partial Prototpye


	
Download the Open Storage test piece (AtFAB_STG_TEST.skp). Have your calculations for S, TCMAX, and TDMAX handy.







The parts in the test piece CAD file, illustrated in Figure 14-6, simulate the critical joinery conditions, particularly the pocketing and fit between two kinds of material. “Test Pieces” explains the concept and purpose behind full-scale prototypes and test pieces, and “Partial Prototyping: Using a Test Piece” walks you through the particulars of preparing, cutting, and evaluating the test piece.


Whether you are using the default or parametrically customized Open Cabinet file, use the test piece to confirm that your joinery fits both materials. The test piece simulates critical joinery of all versions, regardless of dimensions.
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Figure 14-7. Test piece in context












Prepare File


Since the Open Cabinet test piece was modeled with nominal material thicknesses (TCNOM and TDNOM), you will first need to scale all 2D part profiles by S to match your actual material (TCMAX and TDMAX).


	
Open the test piece file (AtFAB_STG_TEST.skp) in SketchUp, and scale all parts by S.



	
Select Save As, choosing SketchUp release 14 and adding the S percentage to the filename (e.g., AtFAB_STG_TEST_9842.skp).






















Prepare Toolpaths


	
Following the steps in Chapter 7, import the scaled Open Storage Cabinet test piece into VCarve.



	
First, you’ll assign toolpaths to three standard toolpathing layers:



	
The outside toolpaths cut around the outside of the cabinet parts.



	
An inside toolpath cuts the T-shaped slot in both cabinet sides.



	
The holes toolpath uses a smaller end mill to cut fastener holes.











In VCarve, you’ll also assign two other toolpaths, one for the pockets and the other for the thinner divider material.


	
Create the pocket toolpath in the test piece, which simulates the pockets that will be milled into the side, back, top, and bottom parts of the Open Cabinet. Follow the steps for “Create Pocket Toolpaths”, using a depth of TCMAX/2.







The pocket toolpath settings are shown in Table 14-1.


Table 14-1. Pocket Settings


	Tool Diameter

	0.25 inch (¼″) end mill




	Passes

	2




	Cut Depth

	0.375”




	Direction

	Conventional




	Toolpath Name

	000 Outside Profiles







	
Second, assign an outside-divider toolpath for the thinner sheet that simulates the shelves and dividers. Set cut depth to match TDMAX (e.g., ½″ (12)), keeping all other settings the same as the outside toolpath.







The profile toolpath settings are shown in Table 14-2.


Table 14-2. Outside Profile Settings for Dividers


	Tool Diameter

	0.25 inch (¼″) end mill




	Passes

	2




	Cut Depth

	0.51”




	Machine Vectors

	Outside/Right




	Direction

	Conventional




	Toolpath Name

	000 Outside Profiles Dividers







	
When programing the cutting sequence, cut fastener holes, pockets, and inside profiles prior to cutting outside profiles. This order ensures that small details stay aligned within the parts as they are cut and minimizes the number of required tool changes.



	
Position the outside-divider toolpath last in the order. This place in the sequence allows you to avoid the tool change, while switching from the cabinet sheet material to the thinner divider material.
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Figure 14-8. Locate Test Piece parts on surplus area



















Cut, Assemble, and Evaluate


	
Save the toolpath operations for fabrication and cut out the test piece parts from both sheets. If you want to add a coating or finish to your Open Storage Cabinet, test out the finish on the test piece and evaluate fit.
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Figure 14-9. Open Storage Cabinet test piece assembled




	
Assemble the test piece, as illustrated in Figure 14-9.



	
Evaluate the fit based on the description in “Cut and Evaluate Fit”. To test the depth of your pockets, the entire tab on the shelf/divider part should be concealed by the pockets.







If your test piece joinery doesn’t match the fit described in “Cut and Evaluate Fit”, consult “Troubleshooting” for additional techniques and steps for achieving an optimal fit. Continue cutting test pieces until you are satisfied with the joinery.


	
Make a note of the scaling adjustment, and save the final VCarve file (e.g., AtFAB_STG.crv) that yielded the successful test piece.







If you’re working with a parametrically customized file and run into any issues, you can either follow the instructions in “Troubleshooting” to scale the 2D profiles in SketchUp, or return to the app to produce a new file that better matches your material thicknesses.


























Adjust Cabinet Files and Prepare for Cutting


Once you’ve cut a test piece with a proper fit, you’re ready to proceed with cutting your Open Storage Cabinet.


	
Return to SketchUp and open the Open Storage Cabinet file (AtFAB_STG.skp).



	
Scale the 2D parts by the exact scaling adjustments of your successful test piece.



	
Select Save As and ensure that you select the option to save the file for SketchUp Release 14. Add S to the filename (e.g., AtFAB_STG_9842.skp).



	
Go back to VCarve and open the VCarve file used to cut your successful test piece. Delete the test piece vectors in this file and import the scaled Open Storage Cabinet file.



	
Going layer by layer, assign toolpaths to the appropriate vectors on each sheet. Be sure to keep track of your cabinet material and divider material.



	
Simulate and check your work for each sheet and export the toolpath operations for machining.















Cut Pockets on the Correct Side


Before you begin cutting, it’s important to think about which side of the material should face upward. “Selecting Materials” explains how plywoods, regardless of grade, have a good side (or finish face) with higher quality veneer and a bad side (or back face) with a lower grade of veneer. “Flattening and Layout” explains how asymmetrical parts with pockets need careful handling during layout and cutting.


Most AtFAB furniture pieces were designed so they don’t require this extra attention. The majority of designs have symmetrical parts that may be flipped and assembled with either face positioned outward.


The Open Storage Cabinet—with sides, top, bottom, and back that have pockets on one side—is an exception to this system. These pocketed, asymmetrical parts will only fit into place facing one way.


When laying out parts and placing sheets on the CNC bed, pay attention to which side of the plywood is pocketed during fabrication. Taking care will ensure that the best face ends up on the most prominent sides of your Open Storage Cabinet.


The location and use of your Open Storage Cabinet will determine the direction of the “finish” and “back” faces. If your Open Storage Cabinet will be against a wall, you might prefer to keep the “finish” side on the Cabinet interior. Before cutting the sheet with the outer cabinet parts, place the good side face-up on the CNC bed.


If you’re using the Open Storage Cabinet as a freestanding partition, locate the “finish” side on the cabinet’s outside faces. Place the good side facedown on the CNC bed, so that pocket cuts for the cabinet interior are milled into the bad side.
























Cut Cabinet


	
Proceed with cutting your parts. Starting with the outer cabinet parts, work sheet by sheet and take care to orient the appropriate material face-upward on the CNC bed. With a large project, it’s helpful to have a dedicated place for storing parts as they come off the machine.
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Figure 14-10. Open Storage Cabinet parts




	
Using a nonabrasive brush, dust off each part, and file or lightly sand part edges as necessary. Store your parts carefully, either laid out flat on a blanket or stacked with protective paper, fabric, or foam sheets between parts. We typically separate the thinner shelves and dividers from the heavier outer cabinet parts.







If you are applying a finish to your Open Storage Cabinet,  follow the same material and coating manufacturer, instructions (as well as what you learned in your earlier evaluations of the test pieces) that you used in finishing your test piece.

















Assemble


We usually find it easiest to assemble the Open Storage with the back facedown on a large workbench or on the floor as shown in Figure 14-11. Use a moving quilt or protective cover to protect the working surface, as well as all parts during this process.
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Figure 14-11. Assembly diagram




	
Gather all of your tools (drill, blue painter’s tape, screwdriver) and hardware.



	
Start by placing the back onto the protected work surface, with pocketed cuts facing upward.



	
Separately, fit the shelves and dividers together.



	
Slot the shelves and dividers into the pocketed grooves of the back.



	
Separately, tab the cross beam into the bottom part.



	
Fit this bottom assembly into the back and lock the vertical dividers into the bottom’s pocketed grooves.



	
Place the sides, top, and front into place.



	
Place all four feet onto the legs.



	
Use blue painter’s tape to secure the parts to each other.



	
Working around the Cabinet, predrill all accessible holes on the front, top, and sides. Refer to “How to Drill”.



	
Screw in fasteners by hand.



	
Predrill and screw in fasteners on the feet. Refer to Figure 10-11.



	
With assistance, pivot the Open Storage Cabinet to turn it upright.



	
Finish predrilling and screwing in fasteners on the back.



	
Remove the blue painter’s tape.
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Figure 14-12. Open Storage Cabinet finished and upright














Part V. Moving Parts and Large Structures



Going beyond fundamentals, these next projects build upon your foundation of digital craftsmanship and challenge you with increased complexity. A simple set of sliding door panels on the Poke Credenza introduces techniques for fabricating moving parts, while the Cellular Screen presents methods for handling especially large or complex structures. The themes and concepts of both projects round out your fabrication skills and understanding of digital workflows, empowering you to be part of the next industrial revolution.





Chapter 15. Poke Credenza




The Poke Credenza employs your knowledge of 2D modification, pocketing, and multi-materials in a single project. The Poke is a small shelving unit that is enclosed by a set of three sliding door panels. Making furniture with moving parts utilizes all of the digital skills you’ve acquired so far, and really puts your fabrication technique to the test. Designing the doors themselves will challenge your creativity with material experimentation, and give you a chance to develop 2D patterns that work specifically with a CNC tool. The end result is a useful piece of furniture that demonstrates both your digital craft and ingenuity.




	Project Themes

	


	
Moving Parts



	
Multi-material Thicknesses



	
Applying Patterns







	Design Files

	


	
3D: AtFAB_PKC.skp



	
Test: AtFAB_PKC_TEST.skp



	
Cut: AtFAB_PKC.dxf







	Sheet Goods

	


	
Two 4'×8’ sheets of ¾″ (19mm) for the outer credenza and tests



	
One 1'×4’ sheet of ¼″ (6mm)







	Tools & Hardware

	


	
Fasteners (24 in total)



	
Drill and bits



	
Profile: ¼″ end mill



	
Holes: 1⁄8″ end mill



	
See Appendix B
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About the Design


We designed this Credenza for OpenDesk, who were commissioned by a London startup, called Poke, to outfit its workspace with a collection of CNC furniture designs. The credenza is an enclosed shelving unit that works equally well in an office, workshop, or living space. You can place it against a wall or let it serve as a freestanding divider between two spaces. The outer cabinet of the Credenza uses ¾″ (19mm) material, while the sliding front doors use much lighter, thinner 1/4″ (6mm) material. These small, free-floating panels slide along pocketed grooves. They are a superb opportunity to experiment with materials, finishing techniques, and CNC-milled patterns.

















Before You Begin


Before beginning your project, review “Develop a Program” and consider how your Credenza will be used and where it will go. What kinds of things will it store? What kinds of materials, finishing, and fasteners are the most appropriate for its context? A cabinet made of refined veneer plywood and pegs might be desirable for a home or office. A Credenza that stores tools in a workshop may be better suited in a more utilitarian material and heavy-duty fasteners.


Consider whether the three door panels will match the outer cabinet finish, or might they offer a contrast in color, pattern, or materiality? Might they be transparent? Also, think about whether your Credenza will hold electronics that have wires. Will you need frequent access to the contents within it?










Materials


Based on your program criteria for aesthetics, durability, and budget, select your material type, quality, finishing, and fasteners. Refer to Appendix B for selecting and sourcing, as well as “Finishes for CNC Projects” for an overview on finishes. A Poke Credenza requires a sheet and a half of ¾″ (19mm) plywood, leaving enough surplus space for a test piece, as well as a small furniture project (like the Rotational Stools, 5-30 Minute Chair, or Cat in Bag ii Table).


The three sliding door panels require a modest amount of material, and can be coordinated—or contrasted—with the outer cabinet. These panels provide an opportunity to test different kinds of materials, a new finish technique, a colorful, glossy palette of epoxy paints or you can use them as a canvas for CNC-fabricated patterns. The doors are also a nice size for using up salvaged materials or surplus from earlier projects.

















Patterns and Modifications


Once you’ve defined the materiality and a general program for your customized Poke Credenza, you’re ready to start experimenting with patterns on the three sliding doors.


	
Visit the book’s website to download the Poke Credenza test piece (AtFAB_PKC_TEST.skp) and model file (AtFAB_PKC.skp). Open the 3D model file in your CAD program.



	
On the toolpath layers in AtFAB_PKC.skp, you’ll find doors with handles and a simple grid of perforations. This is your entry point for further explorations that fully showcase a CNC tool, digital technique, and material. Modify or draw new 2D patterns directly on the toolpathing layers. Refer to Chapter 3 on modifying components and preparing files for importing into CAM.






















What to Draw?


Your choice of patterns for the door panels, whether aesthetic or functional, is nearly infinite. Inspiration can be found everywhere from household objects, to architecture, to industrial equipment, to nature.


You might start by using the door pattern in AtFAB_PKC.skp as a jumping-off point for your own. It’s relatively simple to adapt this pattern in your CAD software, to develop your own clean, geometric, repetitive field of vectors to be etched or cut into the door panels.


Patterns, however, can go beyond the decorative to serve functional uses. For instance, a carefully located pattern of perforations allows sound or signals from concealed devices to pass right through the door. Draw these patterns in your CAD program, composing them as detailed flourishes on the doors rather than an overall pattern.


If you are seeking something looser than a geometric pattern, consider tracing an elaborate, organic filigree from a raster image in your CAD program. Or consider composing stenciled type onto a door panel, writing out a quote, labeling the doors, or oversizing the type to make it a decorative supergraphic.



[image: dcnc 1501]
Figure 15-1. Cutting a pattern and handles into the Credenza door panels


























Measure and Scale


Once you have your plywood and door material, review “Measure Your Materials”.


	
Measure your outer cabinet material sheets on four sides. Record TA, TB, TC, TD and calculate TMAX, your actual material thickness.



	
See “Scale Your CAD File” on how to divide TMAX by TNOM to define your file scaling percentage, S.








[image: dcnc 1502]
Figure 15-2. How to measure and scale



















Create the Partial Prototpye


After you have measured your material and calculated the scaling percentage, you’re ready to test the fit of the Poke Credenza’s joinery and doors with the test piece, AtFAB_PKC_TEST.skp.


Refer to “Test Pieces” on making, evaluating, and troubleshooting tests prior to fabrication of the Credenza. The Poke Credenza test piece integrates the cabinet material and the door material, allowing you to check joinery, test door patterns, and determine whether your slot dimension and depth allow doors to slide smoothly.










Prepare File


	
Open the test piece file (AtFAB_PKC_TEST.skp). Add any 2D patterns or details to the doors that you would like to test. Define additional layers as necessary, placing these details on the appropriate layers.



	
Scale all test piece parts—doors and cabinet—by the scaling percentage (S).






















Adjust Slots


The slot-adjusting process is illustrated in Figure 15-4.


	
Measure your door panel material, recording TDA, TDB, TDC, TDD.



	
Calculate TDMAX, your actual material thickness.



	
In the scaled CAD file, measure the width of the slots (X) that accommodates the sliding door panels. For the door panels to slide freely and stay upright, the pocket width (X) should be 5%–10% wider than TDMAX.







Slot Width = X


5% * TDMAX < X < 10% * TDMAX


	
If the slot is greater or less than your calculation, manually adjust the pocket width (X) on both top and bottom parts in the CAD file to give the necessary tolerance. As you adjust the width of the pockets, preserve the vertical alignment between the pockets in both top and bottom parts.



	
After adding embellishments, scaling the file, and adjusting the door slots, you are ready to save your file. Select Save As on the pulldown menu, save your file in SketchUp release 14, and add S to the filename (e.g., AtFAB_PKC_TEST_9842.skp).
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Figure 15-3. The Poke Credenza test piece in context
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Figure 15-4. Adjust slot width for sliding doors



















Prepare Toolpaths


All of the Credenza toolpaths are shown in Figure 15-5.


	
Following the steps in “Job Setup”, import the scaled test piece file into VCarve. Locate the test piece cabinet and door parts, each on a clear area of their respective sheets.



	
First, define toolpaths for the outer cabinet of the credenza.



	
Outside toolpaths cut around the outside of parts.



	
Define an inside toolpath to cut the slot in the cabinet sides. (This will be applied later, when you cut the actual credenza.)



	
Define the holes toolpath to make inside cuts for the fastener holes, using a smaller end mill.







	
Add a pocket toolpath to cut the sliding door slots on the top and bottom parts. Use the smaller diameter end mill and set the pocket cut depth to TMAX/2.
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Figure 15-5. Toolpaths in the cut file



















Prepare Toolpaths for Sliding Doors


	
For the doors, define toolpaths for outside-doors and inside-doors. If pocketing or carving your own patterns, prepare those additional toolpaths.



	
Assign the smaller diameter end mill to the inside-door and outside-door toolpaths. Define additional toolpaths, if exploring other kinds of end mills or toolpath settings.






















Cut Sequence


Refer to “Toolpath Order” and “Create Pocket Toolpaths” on cutting pockets and keeping details intact by cutting fastener holes, inside cuts, and pockets, prior to cutting outside profiles.


	
As you program the cutting sequence, think about coordinating your end-mill changes with material changes to make the process more efficient. For the credenza and its test piece, you can use the same end mill that cuts fastener holes and pocketed slots for cutting the door panels from thinner material.



	
Start by cutting the doors first, using the smaller end mill for the thinner material.



	
Follow by changing to the next sheet, cutting fastener holes and pockets first.



	
Finally, change the end mills to cut the outer profiles last. Also remember that cutting inside cuts, pockets, and holes prior to cutting the overall shape will keep details aligned within the parts.







With so many overlapping conditions and steps, it really helps to rely on VCarve’s animation and simulation tools. These tools help you thoroughly evaluate the cutting sequence and check your work prior to saving the toolpath operations for fabrication.



[image: dcnc 1506]
Figure 15-6. Credenza parts and test piece laid out on cut sheets




To ensure that paints or coatings don’t affect the fit, finish both cabinet and door parts with the same methods you plan to use for the project. For the door panels, this allows you to ensure that materials and finishes are compatible for smooth sliding.



















Cut, Assemble, and Evaluate


	
Save the toolpath operations for fabrication, cut out the parts, assemble the test piece, and evaluate the fit.



	
Clean sawdust and residue out of all grooves.



	
Assemble the test piece, including the sliding doors.



	
As parts come off the machine, dust them off and file or lightly sand the edges as necessary. Store your parts carefully.







If finishing, follow manufacturer instructions, and ensure that the finish has thoroughly cured prior to staging for assembly.


	
To evaluate the fit of sliding doors, assemble the test piece, as illustrated by Figure 15-7, and slide the doors back and forth in the slots.



	
Increase slot width, if doors either don’t fit or if they do fit, but resistance prevents them from sliding smoothly. Decrease slot width if they rattle against the slot.



	
If your test piece joinery doesn’t match the fit described in “Cut and Evaluate Fit”, consult “Troubleshooting” for additional techniques and steps for achieving an optimal fit.







	
Continue cutting test pieces until you are satisfied with the joinery. Make a note of the scaling adjustment, S, and save the final VCarve file (e.g. AtFAB_PKC.crv) that yielded the successful test piece.








[image: dcnc 1507]
Figure 15-7. How to assemble the Poke Credenza test piece


























Adjust and Cut Credenza


Once you’ve cut a test piece with a good fit, you’re ready to proceed with cutting your credenza.


	
Return to SketchUp and open the Poke Credenza file (AtFAB_PKC.skp).



	
Scale the 2D parts by the exact scaling adjustments of your successful test piece.



	
Select Save As on the pull-down menu, save your file in SketchUp release 14, and add S to the filename (e.g., AtFAB_PKC_9842.skp).



	
Open the test piece VCarve file, delete the test piece parts, and import the scaled Poke Credenza file.



	
Assign toolpaths to the vectors, simulate and check your work, and export them for machining.















Cut on the Correct Side


Because manufacturers produce plywood with a front and back, it’s important to know which side you are pocketing. For instructions on how to cut pockets on the correct side, refer back to “Cut Pockets on the Correct Side”. Show off your material’s finish face on the credenza exterior, while keeping the back face concealed within the interior.
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Figure 15-8. Credenza parts




The top and bottom cabinet parts, which contain pocketed grooves for the sliding doors, add some complexity to your job planning. These parts are asymmetrical and will only fit into place one way, so it’s critical to mill the grooves into the back face of the material.


	
Before cutting, place sheet material onto the CNC bed with the finish facedown, so the tool can mill pocket cuts for the doors into the back face.



	
Cut your credenza parts in the correct sequence.



	
As you take parts off of the machine, clean off the machine dust from each part with a nonabrasive brush, and file or lightly sand the part edges as necessary. Thoroughly remove sawdust or other residue from the pocketed grooves, as this will prevent doors from sliding smoothly.



	
Store credenza parts carefully, either laid out flat on a blanket or stacked with paper, fabric, or foam layers between parts. Keep the thinner and more fragile door parts separated from the much larger and heavier cabinet parts.



	
Follow the material and coating manufacturer’s instructions (or what you learned in your earlier evaluations of the test pieces) as you finish your test piece. Let all parts dry/cure completely before staging for assembly.







Figure 15-9. Credenza parts configured for assembly
[image: Alt Text]


























Assemble


It’s easiest to assemble the credenza with the back face up on a large workbench or on the floor. Prior to assembly, consult “How to Drill” for fastening and drilling techniques and gather all of your tools (drill, blue painter’s tape, screwdriver) and hardware. Assembly can mostly be handled by one person, though it always helps to have help when setting it upright.


	
Lay all parts out, keeping them within easy reach. Use a moving quilt or covering to protect the working surface, as well as all parts during this process.



	
Place the back onto the protected work surface, with “finish” facedown. Place the interior shelf, the lower cross beam, and the bottom.



	
Place the top part, keeping it somewhat loose, and place the three doors into the grooves of the top and bottom part.



	
Press all of the parts into place and check the sliding doors to ensure that the  panels are situated in the right grooves and their movement is smooth.



	
If the door panels don’t move smoothly, it often helps to wax the door edges, or gently smooth out the slot with a file or sandpaper.



	
Add the right and left side. Place the front part. Secure any loose-fitting parts with blue painter’s tape or clamps.



	
Place the four feet and secure them with blue painter’s tape.



	
Predrill all holes in the right and left side of the credenza. Then follow with the top, front, and feet.



	
Screw in fasteners and remove the blue painter’s tape.



	
With help, pivot the credenza to turn it upright onto its feet.



	
Predrill the holes in the back and fasten the remaining fasteners.



	
Slide the doors into place.
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Figure 15-10. Credenza finished and upright














Chapter 16. Cellular Screen




The Cellular Screen started as a design investigation into making CNC-fabricated structures bigger than the size of a standard CNC bed and plywood. The result of this study was this volumetric, lightweight modular partition, with an interlocking frame and infill panels. Carefully arranged to provide visual privacy, the offset panels bounce reflected light through the screen’s cells. When lit from behind by either the sun or bright, indoor light, the Cellular Screen front will actually glow!




	Project Themes

	


	
Compound Structures



	
Managing Large Projects: Part Tracking and Assembly Coordination



	
Advanced Prototyping







	Design Files

	


	
3D: AtFAB_SCR.skp



	
Test: AtFAB_SCR_TEST.skp



	
Cut: AtFAB_SCR.dxf







	Sheet Goods

	


	
Seven sheets of 4′×8′×½″ (1200×2400×12) for one screen and tests







	Tools & Hardware

	


	
Fasteners (210 in total)



	
Drill and bits



	
Profile: ¼″ end mill



	
Holes: 1⁄8″ end mill



	
Removable adhesive labels (optional)



	
See Appendix B
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About the Design


Utilizing seven sheets of material, the Cellular Screen is by far the largest project in this book. Despite its size, the screen employs the same basic digital techniques introduced in earlier projects. When multiplied, the screen’s repetetive joinery forms a substantial compound structure far larger than the dimensions of a standard plywood sheet. This chapter introduces organizational methods and workflows, which are essential for producing large projects and complex pieces.

















Before You Begin a Large Project


As a project, the Cellular Screen gives you a chance to fully internalize the steps of your CNC workflow and perfect your basic digital technique. By taking a single cell, then multiplying it to form a complex and substantial structure, this project demands advanced planning, good organization, and methodical coordination throughout the process.


Smart organizational systems for measuring materials, preparing your CAD file, defining toolpaths, cutting, finishing, and finally assembling will help you manage the steps with efficiency, consistency, and even pleasure. Whether it’s measuring physical sheet material or programming toolpaths in the CAM file, it helps to work methodically by performing tasks in a consistent order across all seven sheets.










Materials


The Cellular Screen’s function is to partition space, and as a free-standing object, it requires little coordination with other furniture and objects. As a large structure, the Screen can have a significant impact on its surroundings.


Before selecting an actual material, think about the material properties and effects you’re after. Review “Selecting Materials” and “Finishes for CNC Projects”, with an eye on how materials will enhance or altogether transform the features of your Cellular Screen. Materials have the ability to amplify the screen’s light-reflecting properties or feature its modular structure. Materials determine whether it makes a big visual impact on its environment or serves as a dignified, quiet piece in the background.


Consider the effects of natural materials versus applied color, whether light values are preferable to dark, or how a high-gloss finish contrasts to one that is rough. Will all parts have the same material and finish, giving the Screen a monolithic appearance? Or might you differentiate the frame from the front and back infill with color, finish, or material? Don’t overlook small details like hardware. The screen’s numerous exposed fasteners also provide an opportunity to add subtle or significant details, while facilitating disassembly for storage or transport.


Self-tapping screws, which don’t require pre-drilling, are an excellent choice for this project that uses ½″ thick material and 210 fasteners.




The Cellular Screen requires seven sheets of ½″ plywood, but there is plenty of surplus material for test pieces. Look for seven sheets that have uniform faces and minimal variation in thickness (TMAX). On larger projects, it’s sensible to purchase an extra sheet of material, as the chance of unanticipated errors seems to increase with job size.


Figure 16-1. Screen Parts laid onto seven cut sheets
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Manage Parts


Having a system to identify individual parts greatly simplifies the process of making a large project. Labeling parts in the digital file and physically marking them as they come off the machine helps you keep track as you move through the digital workflow and into fabrication, finishing, and assembly. Labeling allows you to handle parts methodically and consistently, and it also keeps you from overlooking or losing a part. Beyond just keeping track, marking the screen’s numerous similar parts also streamlines the process of putting it together.


When you open AtFAB_SCR.skp, you’ll find seven sheets laid out with part numbers located on each part. You can manually mark the cut parts with these numbers by applying removable adhesive labels, just before the parts are removed from the CNC machine bed. Alternatively, you can draw discrete part numbers in CAD and program a toolpath to etch a number directly into each part.
























Measure & Scale


	
Once you have your 1/2″ thick sheet material in the shop, review “Measure Your Materials”. Thoroughly measure each of the seven sheets to get TA, TB, TC, TD, as illustrated in Figure 16-2.



	
Record these measurements for each sheet and calculate TMAX, your actual material thickness. While measuring 28 times seems absolutely tedious, the extra effort allows you to find any dimensional variation that might cause trouble for your joinery later on.



	
Once you’ve identified TMAX, refer to “Scale Your CAD File” on how to divide TMAX by TNOM to define your file-scaling percentage (S). The TNOM for the Cellular Screen is ½″ (12mm).
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Figure 16-2. How to measure and scale the Cellular Screen file












Scale CAD file & Test Piece


	
Open AtFAB_SCR.skp → Scale all 2D profiles on the toolpathing layers by S.



	
Open AtFAB_SCR_TEST.skp → Scale the test piece profiles by S (see “Partial Prototyping: Using a Test Piece”).







Prototyping Case Study

In the design process, prototypes can be indispensable, especially  when designing and fabricating a large or complex project with many unknown factors.


We had such a project a few years ago when we were invited by WeMake for a Maker Residency in Milan, Italy. We designed an Open Source Wunderkammer, a large CNC-fabricated partition to display dozens of 3D-printed wonders, downloaded from the internet. The project was large, requiring eight sheets of plywood, and a lot of cutting time. We relied on both scale prototypes and partial, full-scale prototypes at different stages in its development.


At home in our studio, we designed and digitally modeled the project, and in advance of our arrival in Italy, we fabricated a scale prototoype out of aircraft plywood with our desktop CNC router. This physical version  helped us evaluate the design, check parts, and make small adjustments to our digital model. We brought the scale prototype along with us to Italy, where it became quite helpful in communicating the design and planning the fabrication and assembly process with our hosts and collaborators.


Right before final fabrication at WeMake, we worked with our hosts to fabricate a corner of the Wunderkammer at full scale. It was an elaborate test piece cut using the actual material. We selected a corner of the piece that was the most complex intersection of the frame and infill. Going through the toolpathing, fabrication, and construction gave us the chance to evaluate the material, machine settings, and assembly process. Knowing that the most complex portion of the design worked, we had confidence that the entire job would go smoothly.
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Figure 16-3. Working with both a scale prototype and partial full-scale prototype at WeMake in Milan (photo credit: Stefano Pedrelli)




























Partial Prototyping Large Projects


Cutting seven sheets requires a significant commitment of both CNC time and sheet material, so it’s well worth sorting out material, fabrication, and assembly details in advance. For a large project like the Cellular Screen, both scale and partial prototypes can prove useful at different stages in the process.


As outlined in “Scale Prototypes”, a scale prototype (test piece) helps you understand the screen design in detail. But more importantly, it also helps you plan a fabrication and assembly process that unfolds more efficiently. Laser-cutting a scale version of the Cellular Screen requires you to go through a mini-fabrication process, so you have a better idea of what to expect when you go full scale. A small prototype also serves as a very effective tool for communicating with others and practicing the steps of staging parts and handling a complex assembly sequence.


While the scale prototype gives you a holistic understanding of the design and process, the partial prototype helps you dial in your technique. The Cellular Screen test piece works like it did for the smaller projects; it allows you to test materials and finishes and find machine settings that yield a perfect joinery fit. However, getting the test piece right is essential when you have so many sheets of material at stake.

















Create the Partial Prototpye


	
Import the scaled test piece CAD file AtFAB_SCR_TEST.skp into VCarve. Following steps in “Job Setup”, assign outside toolpaths that cut around the outside of the screen parts, inside toolpaths that cut the slots into the face panels, and the holes toolpath for fasteners.



	
Assign a cut depth that matches the thinner ½″ (12mm) material. Follow the same cut sequence in “Toolpath Order”.








[image: dcnc 1604]
Figure 16-4. Test piece parts in context




	
Locate the test piece on one end of a cut sheet, shown in Figure 16-5. Since several sheets have surplus area, you’ll find adequate space for cutting multiple tests.



	
Cut the test piece parts, assemble (illustrated in Figure 16-6), and evaluate the joinery fit, following the guidelines in “Cut and Evaluate Fit”. See “Troubleshooting” to correct any deficiencies. Cut additional test pieces until you have produced one with flush joinery.



	
Once you have a test piece with a successful fit, make a note of the settings to transfer to your Cellular Screen file.








Figure 16-5. Locate test piece toolpaths onto the clear area of the cut sheet
[image: Alt Text]



Figure 16-6. How to assemble the Cellular Screen test piece
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Figure 16-7. Cellular Screen parts labeled and grouped
[image: Alt Text]



















Screen: Multi-Sheet Workflow


Once you have a produced a well-fitting test piece, you’re ready to cut all seven screen sheets with assurance that its parts will fit. If required, after troubleshooting, go back and make additional scaling adjustments to AtFAB_SCR.skp.


Open VCarve Pro and import the adjusted Cellular Screen CAD file, following the steps outlined in “Job Setup”. You’ll find the CAD file organized, so that all seven sheets import into your CAM program at once. On big projects, it can be easy to lose track of your work, which, in turn, slows you down and leads to errors. This is especially problematic in CAD and CAM files, where mistakes aren’t always easy to spot.


When working with many sheets, it helps to develop methods that let you work efficiently and minimize errors. Keeping all seven sheets in a single file is one example. It means you don’t have to keep track of separate CAD and CAM files for every sheet in your project. It also allows you to define toolpaths once, and then methodically go sheet by sheet to assign toolpaths to every part in the file.










Assign toolpaths to each sheet


	
Ungroup the entire file.



	
Select all vectors on one sheet.



	
Using the align tools, center the selected sheet on the work zone.



	
Define inside, outside, and hole toolpaths to match the successful test piece settings.



	
Assign these toolpaths to correct vectors on the selected sheet.



	
Simulate and check the cutting sequence.



	
Export Toolpath Operations.



	
Save file, adding an order number to the filename (e.g., AtFAB_SCR-1.sbp)



	
Move this sheet to the other side of the work zone.



	
Select the next sheet and repeat the steps, until you have exported seven files, and all sheets are moved to the other side of the VCarve work zone.







After defining the inside, outside, and hole toolpaths for the first sheet, you can assign these toolpaths to the appropriate vectors on the subsequent six sheets.




After creating toolpathing operation files for all seven sheets, you are ready to begin cutting your project.
























Cut Screen File and Stage Parts


	
Prior to cutting, prepare an area for staging parts. If you are labeling parts with adhesive labels, get the labels and a key ready. Following the numbered sequence of your toolpath operation files, cut parts from each sheet.



	
Using the part number in the CAD file as a reference, ensure that the parts are labeled before removing them from the CNC bed. Clean the sawdust from each part with a nonabrasive brush, removing dust from sniglets and fastener holes. With so many similar parts, organize parts as they come off the machine and take them to the staging area stacked with protective layers, like paper, cloth, or foam, between parts.



	
Group A with B, C with D, and E with F parts, keeping small, medium, and large faces together. For the frame parts, group AB, CD, and EF parts together, as shown in Figure 16-8.



	
Once all the parts are cut, keep them grouped. If adding a finish, do so in batches, working with part groups through the entire finishing process. Finish parts according to the manufacturer’s instructions and/or your earlier evaluations of the test piece. Store grouped parts in a protected area and make sure that the finish has dried or cured completely prior to final assembly.






















Assemble the Screen


	
With the numbered parts organized, as shown in Figure 16-8, you’re ready to assemble the screen panels. By using the diagram/key shown in Figure 16-9, and going panel by panel, the Cellular Screen is relatively straightforward to assemble.








[image: dcnc 1608]
Figure 16-8. Organize parts. For each panel, build the frame, add face parts to both sides, and fasten. Join three panels.




	
Working on the floor or on a workbench, place a moving quilt to protect both your screen parts and work surface. Gather all the parts, keeping them close by and organized in their respective groups. Set aside the large top part and all feet parts. Keep a rubber mallet and blocking handy, as well as blue painter’s tape, a drill, and all fasteners. Some help is essential when joining the three panels together.



	
Collect all A-parts, B-parts, and AB-Frame parts, shown in Figure 16-9.



	
Slot the AB-Frame parts together on the work surface and lock the A-Face parts into place on the frame. If necessary, use a rubber mallet and blocking to gently persuade the tight face parts into place.



	
Working from top to bottom, install all fasteners through the A-Face parts and into the frame. If not using self-tapping screws, consult “How to Drill”.



	
Flip the panel over and follow the same process with the B-parts on the opposite face, locking face parts into place and securing with fasteners.



	
Add the end AB face and one end foot; secure all the parts with fasteners.



	
Follow the same process with the CD and EF panels, using the key shown here.







Parts on the A/B and E/F panels are actually identical and just placed in a rotationally symmetrical orientation.
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Figure 16-9. Assemble the Cellular Screen panel by panel—AB, CD, and EF




	
With all three panels complete, join the panels to each other. Hold both the AB and CD panels upright (with the assistance of a friend) and walk the two panels together to form the corner.



	
Move the corresponding tabs and slots into one another. It helps to hinge the two panels into each other and work back and forth and from top to bottom a few times. Use the mallet to carefully persuade any stubborn corner parts together.



	
With AB and CD panels fully aligned and locked in, hold the panels tightly while drilling the fasteners into place. Follow the same steps to join the other end of the CD panel with the EF panel.



	
Once all three panels are joined, add the top part, as well as the two corner feet.



	
Fasten these remaining parts into place and look over the entire screen. Adjust fasteners that may be too tight or too loose, and add any fasteners you may have overlooked.
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Figure 16-10. Completed Cellular Screen














Part VI. Resources







Appendix A. Design Resources



While the joinery we employ in our designs and demonstrate in our projects is intentionally elemental, we would be remiss to not mention the many designers and makers, who are exploring other kinds of joinery in their CNC furniture designs. Though the details differ from AtFAB, the thinking is similar. These designers use a language of joinery as a starting point, aggregating it into a larger system of connections, assemblies, and ultimately furniture objects.


A nice example of this is the Box-o-rama series for Droog, a parametric cabinet designed by EventArchitectuur, which employs box joints that interlock with a pressure fit. Another design developed around joinery technique is the living hinge used by Alex Zehn in his Alex Chair. For a living hinge, the CNC subtracts material in a way that enables a flat sheet of material to flex, and when applied in a specific manner, can follow contours or allow a single piece of material to fold onto itself. Spring tenon joints are another kind of joint, which takes advantage of the flexibility of plywood. Konstantin Achov used these connections in his Stack Series of furniture, in which the furniture parts snap together without hardware. Andy Kem’s Break Plane Series also exploits the flexibility of plywood at a larger scale than the joint. In his designs, he locates two-way joints in a manner that places flat plywood parts into tension and introduces a subtle curvature into each furniture form.


These are just a few examples of how designers and makers alike can design a larger system and language for furniture that starts with the connections between parts. We’re aways excited to see fresh ideas about CNC joinery, and the expanding array of designs by makers and designers who are experimenting with joinery, furniture design, and CNC fabrication.








Design Repositories



	
Opendesk



	
Inventables



	
Ronen Kadushin



	
Jens Dyvik’s Layer Chair



	
Thingiverse



	
Vectric’s Free CNC Projects



	
ShopBot’s Ready-to-go Projects



	
Shelter 2.0






For further explorations in joinery, we also recommend exploring Jochen Gros’s 50 Digital Wood Joints, which has been a popular reference for CNC fabricators, designers, and woodworkers. At first, the sheer number of joint types seems overwhelming. However, closer study reveals that although these joints are complex and painstakingly fabricated, they still fall into the basic categories described “Eight Basic CNC Joint Conditions”.


In the CNC Panel Joinery Notebook, Sean Michael Ragan provides another resource on complex joinery that expands upon Gros’s compilation and introduces a broader array of CNC joint types. To learn more about design topics introduced in these chapters, we recommend these books as a starting point.

















Recommended Reading on Design










Design Thinking



	
Less Is More by Dieter Rams



	
How to See: Visual Adventures in a World God Never Made by George Nelson



	
Design Thinking: Understanding How Designers Think and Work by Nigel Cross



	
The Art of Innovation by Tom Kelly



	
Thoughtless Acts by Jane Fulton Suri





















Open Design



	
Open Design Now by Bas Van Able, Lucas Evers, Roel Klaassen, and Peter Troxler



	
FabLab: Revolution Field Manual by Massimo Menichinelli (Editor)





















Parametric Design



	
Elements of Parametric Design by Robert Woodbury



	
Getting Started with Processing by Casey Reas and Ben Fry





















Human Factors and Ergonomics



	
The Measure of Man and Woman: Human Factors in Design, by Alvin R. Tilley, Henry Dreyfuss Associates



	
Human Dimension & Interior Space: A Source Book of Design Reference Standards by Julius Panero and Martin Zelnik























Appendix B. Sourcing Materials



The first step in planning a CNC project is to find the right materials in your area. Get familiar with local suppliers and make visits to see the range of materials they carry. You can find sheet materials at big box home improvement centers, as well as local architectural material suppliers and lumber yards. Local yards often have a wider selection of sheet materials and offer expertise from an especially knowledgeable staff. Most will deliver the goods that you select and pay for in store.








Tips


	Consider green materials

	
As you source plywoods, consider materials that are easier on the environment, you, and your shop. Plywoods and engineered products that come from sustainably managed forests and use clean, low VOC adhesives will usually be labeled accordingly (FSC Certified, for instance). If you are concerned with the embedded energy that comes from transporting heavy lumber products over great distances, look for regionally manufactured products. If cost is an issue, consider the lifecycle of the material itself and how your project will perform over the long term. Spending a bit more for a durable, quality sheet product will ultimately yield the most value in a long-lasting piece of furniture.



	Examine multiple sheets

	
When shopping for plywood, examine multiple sheets to find a sheet with a nice grain, minimal camber, and relatively consistent thickness for your project. If you’re working on a project that uses multiple sheets, try to find some consistency across all sheets.



	Always purchase surplus

	
Always purchase surplus material for testing and for recutting parts. For your first project, it’s sensible to purchase a second sheet of plywood, or cut a small project and reserve the other half sheet for testing. Surplus material is also useful for creating partial prototypes or in the event that a part is damaged during the cutting, finishing, or assembly process. Having extra material on hand ensures that you can easily cut a replacement part for one that was damaged by human or machine.





















Materials We Like


With some research, planning, and practical design decision making, your CNC furniture project should be something that will be used and enjoyed for a very long time. This is a small, but well-researched list of products that balance sustainability, machining performance, and beautiful results:










Plywood and Other Sheet Materials



	
Columbia Forest Products PureBond plywoods



	
Araucoply sanded panels



	
Radiata pine plywood



	
ApplePly prefinished and unfinished plywoods



	
Koskisen Baltic birch plywood



	
Valchromat colored MDF



	
Plyboo edge grain bamboo plywood



	
Gill Corporation Gillfab 5030 Aluminum/Balsa Panels





















Coatings & Finishes



	
Woodriver natural tung oil



	
Skidmore’s liquid beeswax Woodfinish and Sealer



	
The Real Milk Paint Company for milk paint



	
Benjamin Moore Regal Select Waterborne Interior Paint low VOC, hardwearing paint



	
Benjamin Moore Benwood Stays Clear acrylic polyurethane





















Hardware resources



	
Stafast decorative screws (we prefer the small, flush-mounted SCS0540HD)



	
Dowels from craft or home improvement stores



	
McMaster-Carr has precut dowels as well as an array of hardware






Grain Pattern

Chapter 3 explains the importance of grain direction and composing parts on a cut sheet to take advantage of its linear characteristics. Wood grain also comes in a variety of patterns and characteristics that can be featured in your project. Tight, linear veneer grain might emphasize long, linear qualities of a storage piece. A pronounced, organic figure that is less directional might complement a tabletop. Similar to grain direction, handling grain pattern has no particular rules, but rather offers an opportunity.


























Sheet Materials Beyond Plywood


You can make the furniture projects throughout this book using almost any sheet material. You’re really only limited by what your CNC machine can cut, and a few other factors. Materials with dimensional consistency and a high strength-to-weight ratio are particularly well suited for fabricating large-scale furniture projects with a CNC.


You can find greater consistency in dimensionally stable materials like plastics, composite, or metal as well as engineered wood products like OSB or MDF. However, measuring and inspecting any of these materials prior to purchasing ensures that you know exactly what you’re using for a project. The following is a short list of sheet materials that work for fabricating CNC furniture:










Engineered Wood Sheeting (MDF & OSB)


Materials like medium-density fiberboard (MDF) and oriented strand board (OSB) are monolithic, manufactured sheet goods, which offer excellent dimensional consistency. They are sustainably manufactured from industrial wood waste, very easily sourced, and usually quite inexpensive. OSB has plywood’s great strength to weight ratio and machining qualities. MDF, on the other hand, is incredibly heavy for its strength and can prove quite messy when machining.

















High-Density Polyethylene (HDPE)


High-density polyethylene (HDPE) is a plastic sheet material with integral color and a solid core. It is waterproof, UV stable, and quite durable, making it suitable for outdoor furniture. It is impact resistant, strong, and easily machined. It is also quite heavy, making it more suitable for smaller projects that don’t require long spans. HDPE is also quite expensive and usually must be special ordered.

















Composites


There are a vast array of composite panel products developed for aerospace, transportation, maritime, and other industries. Such panels are either made of solid, integral reinforced resins, or else comprised of two outer skins sandwiching a solid or cellular core material. They are usually expensive and often hard to source in small quantities. However, they are worth mentioning because many are designed with a very high strength-to-weight ratio and are intended for machining, which makes them an interesting and well-suited choice for CNC furniture projects.

















Acrylic


Cell cast acrylic comes in a variety of colors and finishes, and is sold under the brand names Plexiglas, Perspex, or Acrylite. Its cost and strength to weight ratio make it ill-suited for full-scale furniture. However, it’s mentioned here as an ideal accessory or scale-prototyping material, which can be either CNC routed or laser cut. Avoid the extruded acrylics, as well as polycarbonates, which are intended for thermoforming rather than machining.



















Appendix C. Machining Resources









Bibliography and Recommended Reading on Routing



	
Router Bit Basics for CNC compiled by Steve Glassel. A Compilation of the Wisdom and Knowledge of ShopBot Forum Members. Ver. 3.5, May 2012.







	
Onsrud Cutter LP’s CNC Production Routing Guide. Onsrud Cutter LP, date unknown. 
http://www.onsrud.com/files/pdf/LMT-Onsrud-CNC-Prod-Routing-Guide.pdf







	
Onsrud Cutter Inc’s CNC Production Routing Guide by Tom Cornwell, Tom Erikson, Ross Gobble, Rich Lee, and Mark O’Brien. Compiled, edited, and illustrated by Ross Gobble. Onsrud Cutter Inc, 1996. 
http://www.onsrud.com/files/pdf/LMT-Onsrud-CNC-Prod-Routing-Guide.pdf



	
Onsrud Production Cutting Tools Catalogs



	
Onsrud Production Cutting Tools Catalog (metric)



	
Onsrud Cutter Chipload Data



	
ShopBot Feeds and Speeds Charts 



	
ShopBot Chipload Per Inch Chart 



	
Calibrating Feeds and Speeds with Carbide Microtools





















Tool Vendors



	
Onsrud



	
Centurion Tools LLC



	
ShopBot



	
Inventables



	
Datron



	
Kodiak Cutting Tools





















Tool Recommendations





	Tool Typea:

	Tool Part #:




	¼″ Two Flute Downcut

	Onsrud 57-287




	¼″ Two Flute Downshear

	Centurion Tools 14DS21.03




	¼″ Two Flute Straight V-flute

	Onsrud 56-082




	¼″ Two Flute Straight

	Centurion Tools 14SF21.03




	a All tools are solid carbide






I get straight bits mostly from Centurion Tools in the mountains of Virginia. They’re a small shop and I like doing business with them. All their straight bits are end cutting as well, so they can plunge safely and easily.



Bill Young



ShopBot Chipload Calculator

ShopBotters, you already have a feeds & speeds/chip load calculator built into the ShopBot control software. Go to Tools→Chip Load Calculator to open it.














Glossary



	Assemblies

	
Precise combination of joinery connections between parts designed to produce a desired structure, function, or shape.



	Chip Load

	
The amount of material removed by each flute tooth, as the end mill makes one revolution, while being pushed along a toolpath.



	Collet

	
Attachment to the spindle that holds the end mill in place, usually with a friction fit.



	Conventional (cutting)

	
The feed direction runs counterclockwise, while the spindle rotates clockwise.



	Climb (cutting)

	
The feed direction runs clockwise, while the spindle rotates clockwise.



	Contour cut

	
Removal of material within a specified region with variable depth topography. Is oriented independently of the material surface.



	Cut file

	
A 2D drawing of the pieces/parts that are laid out with respect to a sheet of material and separated into layers that anticipate toolpaths.



	Digital fabrication

	
The production of things, using digital tools. One-off or specialized.



	Distributed manufacturing

	
Network of affiliated CNC fabricators, who source design information globally and materials locally, and eliminate the transportation waste of a centralized factory.



	Dogbone

	
Detail that removes the radius left by a 90-degree interior toolpath cut by a round end mill.  A dogbone is a hole placed at a 90-degree corner that leaves a small 3/4 circle at interior corner intersections.



	DXF

	
CAD file format developed by Autodesk, for AutoCAD that is recognizable by many CAD and CAM programs. DXF stands for Drawing Interchange Format (or Drawing Exchange Format).



	End mill

	
The cutting tool, held by the spindle, for which the toolpath is generated.  End mills come in various sizes, materials, flute dispositions, and tip conditions for a wide array of cutting applications.



	Feeds

	
The velocity at which the tool moves laterally through material. Feed rate is measured in distance per time, or inches per minute, and abbreviated IPM.



	Flatten

	
The process of breaking down and laying out the parts of a 3D model into a flattened and 2D version.



	Gantry

	
Apparatus that affords the x/y movement above the stock, holds the spindle, and precisely locates it relative to the toolpath.



	Good side

	
The face veneers of premium, veneer plywood has sides that are graded differently. The finish side that is meant to be exposed has a better quality veneer with usually more uniformity and evenness in most cases. Conversely, the back side is intended to face the interior or back of a cabinet.



	Hold-down

	
Technique of securing material to the router bed, while remaining clear of gantry, spindle assembly, and dust extractor foot.



	Iteration

	
The ongoing cycle of testing and evaluating a design, and then making a next version that improves upon the last. Software, rapid prototyping, and digital fabrication facilitates an iterative process of designing, prototyping, and refining a design,
over and over.



	Mass customization

	
“Batch of one” production enabled by the agillity of digital fabrication and parametric software. Individually customized goods are achievable without a corresponding increase in cost or labor.



	Open source

	
Files, code, and designs that are shared with others to be freely used, changed, and subsequently shared as modified or unmodified. Advocates stipulate that to be open source information is licensed for both commercial and noncommercial use.



	Open design

	
Design of physical things (hardware) that are available for others to study, modify, distribute, and make. The design is usually made available in a format that enables others to make modifications. Like open source, open design advocates stipulate that to be truly open, information is licensed for both commercial and noncommercial use.



	Open making

	
Similar to open design, without the commercial stipulation. Open making involves the design of things that can be easily made and adapted by others. Open making aims to bring benefit to many, while enabling designers to still make a living by limiting commercial distribution.



	Orthogonal

	
Right angle or 90-degree. Interlocking two flat parts with an orthogonal connection produces a very strong, durable joint.



	Parametric

	
A design or modeling space in which extents and relationships are defined.



	Pocket cut

	
Removal of material within a specified region, to a specified depth, with a resultant pocket that has edges that are perpendicular to the material surface and a bottom that is parallel to the material surface.



	Prefinished

	
Material that has been finished in the factory, and typically doesn’t require finishing after fabrication.



	Profile cut

	
A perpendicular through cut made through the material, which follows a specified path.



	Programs

	
A program is a set of basic requirements, functions, or accommodations that a design must address. Seating and storage are examples of a design program.



	Ramping

	
Machining technique for easing an end mill into the material at a gradual angle. Usually made as spiral or smooth, ramping reduces heat buildup and vibration, which keeps parts in place while machining.



	Sniglet

	
AtFAB’s version of a dogbone, which removes the radius left by a 90-degree interior cut. The sniglet is fully integrated to the cut profile toolpath.



	Speeds

	
The rotational speed of the router spindle, measured in revolutions per minute (RPM).



	Spindle

	
The engine that generates the rotation of a cutting tool. In contrast to a spindle, some CNC routers have an actual router head that does the cutting.



	Stock

	
The material being milled, and its extents and properties that are defined in the toolpathing software.



	Structures

	
Assemblies that efficiently utilize flat material to resist vertical, gravity loads and sideways, lateral forces. AtFAB designs employ Shear, Torsion, Vierendeel, and Rotational structures to resist loads of forces.



	T-bone

	
Similar to the dogbone, a T-bone removes the radius left by a 90-degree interior toolpath with a 1/2 circle. While a dogbone is a 3/4 circle that is usually cut as a hole, a T-bone’s 1/2 circle may be drawn as integral to the profile-cutting toolpath.



	Tabs

	
An interruption in a profile cut that leaves an amount of material between the stock and the part to secure the part during routing. Tab parameters can be set when prescribing toolpaths in the toolpathing software.



	Third Industrial Revolution

	
Similar to the industrial revolutions that preceded it, the third industrial revolution brings a fundamental economic shift. As decentralized, networked digital manufacturing combines with new communication technologies, logistical ecologies, and renewable energy to bring change to society and culture.



	Three-axis

	
Movement along the x, y, and z axes, within a work zone.



	Toolpath

	
The feeds, speeds, passes, plunges, as well as coordinates of cutting, that are CAM software adds to your cut file’s vectors. CAM software typically communicates toolpath information to CNC routers with G-Code.



	Toolpathing software

	
A term for computer-aided manufacturing (CAM) software.



	Vector

	
Line with magnitude and direction. It’s the information from which the direction of the toolpath is derived.



	Workflow

	
Your entire process that works across a variety of collaborators, software, and machines from design through prototyping and fabrication, finishing, and assembly.
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